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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Some application pages have help icons ® to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Overview of Compensation

Overview of Compensation Setup

You can plan and allocate salary and compensation for individuals and your workforce. You can also communicate
compensation information to individuals.

To get started implementing compensation, you need to have the Application Implementation Consultant role. With
that role, you can opt into the Compensation Management offering in the Setup and Maintenance work area. You can
also enable the relevant functional areas for your business.

Base Pay

harket Grade Step
Data l Progression

L | compensation | le—
r—b— dﬁ

Management
Total Individual
Compensation e
Staterment Pe
Worlkforce
Compensation

Functional Area Description

Base Pay Collect and store salary information and pass it to payroll for processing. Also set up salary ranges
and metrics to help managers and HR specialists follow organizational policies when proposing and
approving salary changes. For example, a manager reviewing salary information for a promotion sees
that the salary is just below the midpoint of the person's grade rate. The person is a high performer, so
the manager decides to increase the salary change to be above the midpoint.

Grade Step Progression Automate people's progression through grade ladders according to eligibility criteria and rules that
reflect your progression policies. Also propose a new salary amount for the progression, or even
automatically update the salary amount. For example, automatically promote someone to the next
step of a progression grade ladder after 1 year when their performance rates 4 or higher.

Individual Compensation Design compensation plans that let managers and HR specialists allocate off-cycle compensation
to individuals, such as bonuses, tuition reimbursement, or allowances. Also design plans that let
individuals contribute to charities or savings plans. And, identify the compensation awards that
individuals can see in their compensation history.

Workforce Compensation Create compensation plans and cycles used for compensating a group of workers. Configure the type

of compensation allocated, the information displayed to managers, and whether to use budgeting.
Also configure eligibility criteria for the plan or component, and the approval hierarchy.
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Functional Area

Total Compensation Statements

Market Data

Related Topics
 Plan Your Implementation

Chapter 1
Overview of Compensation

Description

Design and deliver statements for individuals that can include traditional forms of pay, such as salary
and individual compensation awards. You can also include nontraditional forms of pay, such as fringe
benefits, cost of benefits, and paid time off.

Analyze compensation survey data, survey jobs, survey job structures, and other survey attributes.
Survey data can include key metrics, such as percentiles and deciles.

How Eligibility Works With Other Objects

You add eligibility criteria to an eligibility profile, and then associate the profile with an object that restricts eligibility.

The following figure shows the relationships between eligibility components.

Eligibility Criteria

[—b- Checklist Task
— One may
be iated
ES:J;'EE © Total Compensation
Eligibility Criteria — Statamant
- Personal One is
- Employment associated .
- Related Coverage l with >l :anahle RPat:fq.::r
- Other One or more ovaerage t rolie
may be
User-Defined associaled | gjiginility Benefits Object
Criteria with ™ Profile - Program
t - Plan Type
- Plan
- Option
Derived Factors Or
One or more WUFHF'FCE )
may be —4 | Compensation Object
associated - Flan
with - Plan Compaonent
Individual
Compensation Object
- Plan
- Plan Option

You can add different types of eligibility criteria to an eligibility profile. For many common criteria, such as gender or
employment status, you can select from a list of predefined criteria values. However, you must create user-defined
criteria and derived factors before you can add them to an eligibility profile.
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Eligibility Profile
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When you add an eligibility criterion to a profile, you define how to use it to determine eligibility. For example, when you
add gender as a criterion, you must specify a gender value (male or female) and whether to include or exclude persons

who match that value.

Associating the Profile with Objects

This table describes associating eligibility profiles with different kinds of objects and whether you can attach more than

one profile.

Object that Uses an Eligibility Profile

Variable rate or variable coverage profile

Checklist task

Total compensation statement

Benefits object

Compensation object

Performance documents

Check-in templates

Goal plans or goal mass assignments

Absence plan

Related Topics
- Eligibility Profiles
« User-Defined Criteria
« Derived Factors

ORACLE

Purpose

Establish the criteria required to qualify for that
rate or coverage

Control whether that task appears in an
allocated checklist

Apply additional eligibility criteria after
statement generation population parameters

Establish the eligibility criteria for specific
programs, plans, and options

Establish the eligibility for specific plans and
options

Establish the eligibility for performance
documents

Establish the eligibility to use check-in
templates for creating check-in documents

Establish eligibility for the goal

Determine the workers who are eligible to
record an absence that belongs to that plan

Whether You Can Attach More Than One
Profile?

No

No

No

Yes

Yes

Yes

Yes

Yes

Yes
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Eligibility Profiles

Create eligibility profiles to define criteria that determine whether a person qualifies for objects that you associate the
profile with. You can associate eligibility profiles with objects in various business processes.

The following are key aspects of working with eligibility profiles:

Planning and prerequisites

- Specifying the profile type, usage, and assignment usage

Defining eligibility criteria
Excluding from eligibility

- Assigning sequence numbers

« Adding multiple criteria

- Viewing the criteria hierarchy

Planning and Prerequisites

Before you create an eligibility profile, consider the following:

If an eligibility profile uses any of the following to establish eligibility, you must create them before you create
the eligibility profile:

o Derived factors

o User-defined formulas

o User-defined criteria

- Consider whether to combine criteria into one profile or create separate profiles depending on:

o Whether the object for which you're creating eligibility accepts only one eligibility profile or more than
one
o Performance considerations

Use names that identify the criteria being defined rather than the object with which the profile is associated,
because eligibility profiles are reusable.

Example: Use Age20-25+NonSmoker rather than Supplemental Life-Minimum Rate.

Specifying Profile Type, Usage, and Assignment Usage

This table describes the basic profile attributes that you specify when you create an eligibility profile:

Setting

Description

Profile Type Use only dependent profiles for Benefits plans or plan types when determining eligibility of

participants' spouses, family members, or other individuals who qualify as dependents.

All other profiles are participant profiles.

ORACLE
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Setting Description
Usage Determines the type of objects the participant profile can be associated with, such as benefits offerings
and rates, compensation plans, checklist tasks, goal plans or mass goal assignments, or performance
documents.

Selecting Global makes the profile available to multiple business process usages.

Assignment to Use Determines the assignment that the eligibility process evaluates for the person

- Select Specific assignment when the usage is Compensation or Performance.

- Select a value that includes benefit relationship when the usage is Benefits. You select this
value to restrict eligibility evaluation to active assignments that are associated with the benefits
relationship of the person on a given date. If you select other values, then you might need to
include eligibility criteria to exclude inactive assignments.

- Select one of the following values for all other usages, such as total compensation statements:

o Any assignment - enterprise
o Employee assignment only - enterprise

o Primary employee assignment only - enterprise

Defining Eligibility Criteria

Here's the list of eligibility criteria that you can use to configure benefit offerings:

Category Description

Personal - Gender
« Person Type
- Disabled
- Uses Tobacco
- Service Areas
»  Home Location
- Postal Code Ranges
- Leave of Absence
- Termination Reason
- Qualification
- Competency
- Marital Status

- Religion

Employment - Assignment Status
» Hourly or Salaried

- Assignment Category

ORACLE
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Category

Derived factors

Other

Related coverage

ORACLE

Description

Grade

Job

Position

Payroll

Salary Basis
Department

Legal Entities
Performance Rating
Quiartile in Range
Work Location
Range of Scheduled Hours
People Manager
Job Function

Job Family

Hire Date

Probation Period

Business Unit

Age

Length of Service
Compensation
Hours Worked

Full-Time Equivalent

Combined Age and Length of Service

Benefit Groups

Health Coverage Selected

Participation in Another Plan

Formula

User-Defined Criteria

Benefit Groups

Health Coverage Selected

Participation in Another Plan

Formula

User-Defined Criteria

Covered by Another Plan

Covered by Another Plan in Program
Covered by Another Plan Type in Program
Covered by Another Program

Chapter 1
Overview of Compensation
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Category Description

Dependent Eligible for Another Plan Type in Program
Eligible for Another Plan

Eligible for Another Plan Type in Program

Enrolled in Another Option in Plan

Enrolled in Another Plan

Enrolled in Another Plan in Program

Enrolled in Another Plan Type in Program

Enrolled in Another Program

Other Coverage

Labor Relations - Bargaining Unit
Labor Union Member
Union

Collective Agreement

Some criteria, such as gender, provide a fixed set of choices. The choices for other criteria, such as person type, are
based on values defined in tables. You can define multiple criteria for a given criteria type.

Excluding from Eligibility

For each eligibility criterion that you add to a profile, you can indicate whether persons who meet the criterion are
considered eligible or are excluded from eligibility. For example, an age factor can include persons between 20 and 25
years old or exclude persons over 65.

If you:

- Exclude certain age bands, then all age bands not explicitly excluded are automatically included.

- Include certain age bands, then all age bands not explicitly included are automatically excluded.

Assigning Sequence Numbers

You must assign a sequence number to each criterion. The sequence determines the order in which the criterion is
evaluated relative to other criteria of the same type.

Adding Multiple Criteria

If you define multiple values for the same criteria type, such as two postal code ranges, a person must satisfy at least
one of the criteria to be considered eligible. For example, a person who resides in either postal range is eligible.

If you include multiple criteria of different types, such as gender and age, a person must meet at least one criterion
defined for each criteria type.

Viewing the Criteria Hierarchy

Select the View Hierarchy tab to see a list of all criteria that you've saved for this profile. The list is arranged by criteria
type.

ORACLE
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Related Topics

Create a Participant Eligibility Profile
Examples of Eligibility Profiles
Derived Factors

User-Defined Criteria

Single or Multiple Eligibility Profiles

ORACLE
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2 Setup and Maintenance Tasks

Base Pay Setup and Maintenance Tasks

You can calculate, adjust, and maintain salary and hourly earnings for your people by completing these setup tasks in

the sequence listed.

Task Name

Elements

Grades

Grade Rates

Progression Grade Ladder

Compensation Zones

Salary Range Differentials

Configure Actions

ORACLE

Description

Create legislative data group (LDG) payroll
elements to use when you configure salary
bases. For example, create recurring standard
earnings to handle annual salaries and hourly
earnings.

Create grades that record people’s level of
compensation. And define one or more grades
that apply for jobs and positions. You use

the grade rates for grades to validate salary
proposals.

Create grade rates to hold the pay values
related to each grade. Grade rates linked to
salary bases typically serve as guidelines to
validate that proposed salary is appropriate for
that grade.

Optionally create progression grade ladders

to automatically move people from one grade,
or grade and step, to the next level in a grade
ladder. For example, you want to automatically
move new hires to the next step after their first
6 months on the job.

Optionally create compensation zone and
zone types to use in salary range differentials
that adjust base ranges by compensation or
wage regions. For example, you want to pay
everyone working on the East Coast of the US
at 1.1 times the standard grade rate. You want
to pay everyone working on the West Coast at
1.2 times. You pay Central people the standard
grade rate and everyone in the South at 0.8
times.

Optionally create salary range differentials to
adjust base salary ranges from the grade rate
associated with the salary basis. Differentials
vary, for example, to reflect the cost of living in

different locations or the relative ease of hiring.

You use these differentials when configuring
salary bases.

Optionally add actions to identify the cause
when creating or changing salary. For example,

Recommended Help

« Create a Payroll Element to Use with
Salary Bases

« Troubleshoot Salary-Related Issues

- Grades

« How Grades, Grade Rates, and Sets Work
with Legislative Data Groups

« Grade Rates

- How Grades, Grade Rates, and Sets Work
with Legislative Data Groups

« Grade Step Progression Setup and
Maintenance Tasks

- How You Validate Salary Changes with the
Grade Range

« Troubleshoot Salary-Related Issues

« Overview of Salary Range Differentials

« Configure Compensation Zone Types and
Zones

- Overview of Salary Range Differentials
« Configure Salary Range Differentials

« How You Validate Salary Changes with the
Grade Range

Action Framework
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Task Name

Action Reasons

Manage Common Lookups

Salary Basis

Manage Task Configurations for Human Capital
Management

Manage Profile Options

Sandboxes

ORACLE

Description

track that salary changed as part of a
promotion or transfer.

Optionally add reasons to associate with
actions, mostly for reporting and analysis. For
example, when a manager changes someone's
salary as part of a transfer, have them indicate
whether it's because of cost of living.

Optionally change or add components to the
CMP_SALARY_COMPONENTS and ORA_
CMP_SIMPLE_SALARY_COMPS lookup types
to better support your reporting policies for
salary allocations. You use the incremental or
simple salary components when configuring
salary bases that let HR specialists and
managers itemize new or adjusted salary. The
itemizations reflect the different reasons for
their allocations.

Create salary bases that get used when creating
salary and help with processing. For example,
salary basis settings get used to decide salary
amounts, currency, frequency, and metrics. And
the payroll element linked to the salary basis
holds the salary amount, which gets passed to
payroll for processing.

Optionally change default approval workflows
to support your salary change policies. For
example, automatically approve salary changes
proposed by HR specialists. Route approvals
based on country and amount. And specify the
levels of approval using grades.

Enable the applicable salary actions controlled
by profile options. For example, let people use
HCM Data Loader to load salary changes when
related salary is pending approval. Prevent
people who don't have access to the source
assignment salary from proposing salary
during global transfers. And copy future salary
changes during local and global transfers.
Also, if you're going to use autocomplete rules
with salary objects, you need to expose the
Autocomplete Rules feature.

Enable a sandbox to access the HCM
Experience Design Studio and Autocomplete
Rules for the Salary object. You can either
manually create and enable a sandbox or
automatically create it.

Chapter 2
Setup and Maintenance Tasks

Recommended Help

Action Framework

« Incremental Salary Component Lookups

« Simple Salary Component Lookups

« Overview of Base Pay Configuration
« How Many Salary Bases to Create

« Salary Basis Options for Determining
Salary Amount

« Considerations for Using Salary Bases with
Incremental Components versus Simple
Components

« How Default Approval Tasks for Salary and
Individual Compensation Work

« Troubleshoot Salary-Related Issues

«  CMP_COMPENSATION_RESPONSIVE_ENABLED

Profile Option

+ ORA_CMP_LGT_WHEN_MISSING_SALARY_DATASECL

Profile Option

«  BIP_ONLINE_NOTIFICATION_HCM_COMPENSATION

Profile Option
« Get Started with Autocomplete Rules
« Overview of Profile Options

- Create and Edit Profile Options

« How You Enable Access to Autocomplete
Rules

« Overview of Salary
« Delivered Rules for Salary
« General Considerations for Salary

« Prepare to Move Salary Rules to
Production Environments
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The tasks that people can do and the data that they can see depend on their roles, duties, and privileges. For
information about these factors, see these two guides:

« Securing HCM

« Security Reference for HCM

Individual Compensation Setup and Maintenance Tasks

You can let people award compensation outside of the regular compensation cycle and manage personal contributions.
To do this, complete these setup tasks in the sequence listed.

Task Name

Elements

Configure Actions

Eligibility Profiles

Document Types

Individual Compensation Plans

ORACLE

Description

Create legislative data group (LDG) payroll
elements to use when you configure individual
compensation plans. For example, create
recurring standard earnings to handle vehicle
or gym allowances. Create information
elements to handle stock grants and to store
nonmonetary information, such as durations or
points. Create recurring voluntary deductions
to handle savings plans and charitable
contributions. And create nonrecurring
voluntary deductions to handle onetime
charitable contributions.

Optionally add HR actions that specify access
to individual compensation plans. For example,
you can add the Transfer action to a moving
allowance plan to make the plan available when
people transfer someone using that action.

Optionally create eligibility profiles to define
criteria that decide whether a person qualifies
for the linked individual compensation plan
option. For example, identify appropriate
vehicle allowance options based on people's job
title and proximity to a specific office.

Optionally create document types to link

with options for individual compensation
plans. You can then request or require people
proposing allocations for the options attach
supporting documents. Approvers can use the
documents when deciding to approve or reject
the proposals. For example, set up a vehicle
allowance option to require a vehicle details
document.

Create the individual compensation plans

that let managers and HR specialists award
compensation outside of the regular
compensation cycle. For example, let managers
give spot bonuses or grant stock shares.

Recommended Help

« Create a Payroll Element to Use with
Individual Compensation Plans

« Action Framework

« Plan Access Restrictions in an Individual
Compensation Plan Configuration

« Plan Access Restrictions

- How Eligibility Works With Other Objects
- Eligibility Profiles

« Document Type Settings for Individual
Compensation

« Options in an Individual Compensation
Plan Configuration

«  Overview of Individual Compensation

« Plan Access Restrictions

1
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Task Name Description

Manage Task Configurations for Human Capital
Management

Optionally change default approval workflows
to support your individual compensation
allocation policies. For example, automatically
approve personal contributions. And route
individual compensation and administer
compensation allocations for approval.
Manage Profile Options Enable the applicable individual compensation
actions controlled by profile options. For
example, allow people to submit more personal
contributions while other contributions are

still pending approval. Enable only people

with relevant security privileges maintain
individual compensation in HR actions that
have the section. And prevent people from
submitting a Personal Contribution, an
Individual Compensation, or an Administer
Compensation action without making changes.
Map Third-Party Plans Create maps between plans and plan
components to transition third-party plans to
individual compensation plans.

Security Reference
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Recommended Help

« Spot Bonus and Stock Grant Plan
Configuration

« Car Allowance Plan Configuration

« Charity or Savings Contribution Plan
Configuration

« How Default Approval Tasks for Salary and
Individual Compensation Work

« How You Configure Different Approval
Flows for Individual Compensation
Allocations and Personal Contributions

«  BIP_ONLINE_NOTIFICATION_HCM_COMPENSATION
Profile Option

« CMP_DISABLE_PENDING_APPROVALS_CHECK_IN_M/
Profile Option

« ORA_CMP_BIP_IC_SHOW_INPUT_VALUES
Profile Option

« Overview of Profile Options

« Create and Edit Profile Options

- None

The tasks that people can do and the data that they can see depend on their roles, duties, and privileges. For

information about these factors, see these two guides:

» Securing HCM
« Security Reference for HCM

Grade Step Progression Setup and Maintenance Tasks

You can move people automatically from one grade, or grade and step, to the next level in a grade ladder using grade

step progression. To do this, complete these setup tasks in the sequence listed.

Task Name Description

Manage Common Lookups Optionally, create groups for progression grade
ladders using the ORA_CMP_GSP_GRADE_
LADDER_GRP lookup. You can associate
progression grade ladders with a group. Then
you can use the group of ladders instead of

a single ladder when processing grade step

progressions.

ORACLE

Recommended Help

«  Overview of Lookups

- Manage Grade Step Progression

12
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Task Name

Progression Grade Ladder

Configure Global Settings (if the Redwood
experience isn't enabled)

Grade Step Progression Settings (if the
Redwood experience is enabled)

Run Grade Step Progression

Synchronize Grade Step Rate

Security Reference

Description

Create progression grade ladders with the
grades, or grades and steps, that people should

progress through, and the rules for progression.

For example, you create a grade ladder for
manufacturing workers with the Job Assembly
Il grade. The grade has three steps. Progression
rules move people with that grade from 1step
to the next, every 6 months.

Review the default online and batch settings
for grade step progression, and change as
appropriate.

Schedule the Run Grade Step Progression
process to identify the assignments eligible to
progress to a new grade or step.

Run the Synchronize Grade Step Rate process
according to your policies, to change people's
salaries after the underlying rates for the
grades or steps change.

Chapter 2
Setup and Maintenance Tasks

Recommended Help

« Manage Grade Step Progression

« Create a Progression Grade Ladder for
Batch Processing

«  Overview of HCM Data Loader

« Guidelines for Using HCM Spreadsheet
Data Loader

« Guidelines for Loading Progression Grade
Ladders

« Guidelines for Loading Progression Grade
Rates

« Global Compensation Settings for
Defaulting Salary from Grade Ladder Rates

« Batch Settings for Grade Step Progression
Processing

« Batch Error Conditions for Assignment
Date in Grade Step Progression Processing

« Batch Error Conditions for Salary Date in
Grade Step Progression Processing

«  Overview of Grade Step Progression
Processing

« Run Grade Step Progression Process

« Overview of Grade Step Progression
Processing

« Synchronize Grade Step Rate Process

The tasks that people can do and the data that they can see depend on their roles, duties, and privileges. For
information about these factors, see these two guides:

« Securing HCM

- Security Reference for HCM

Workforce Compensation Setup and Maintenance Tasks

Complete these setup tasks to enable managers to award compensation within the regular compensation cycle.

ORACLE
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Workforce Compensation Setup and Maintenance Tasks

Task Name

Manage Workforce Compensation Lookups

Workforce Compensation Plans

Configure Compensation History

Configure Global Compensation Settings

Configure Compensation Batch Processes

Elements

Fast Formulas

Derived Factors

Manage Action Reasons

Profile Rating Models

ORACLE

Description

Review and maintain lookup values for budget
audit history, such as initial budget and budget
distributed by manager.

Create and maintain compensation plans and
associated budget details.

Specify the payroll elements and input values
that make up a worker's compensation history.

Configure properties, such as stock price and
watchlist availability, that apply to all group
compensation plans.

Configure processing parameters, such as the
maximum number of errors allowed, for each
batch process.

Review predefined earnings and deduction
elements and create new ones, using a
questionnaire that automatically generates
the related balances, formulas, and other
components.

Review predefined formulas and create new
ones to validate or calculate data for benefits,
human resources, absences, or payroll.

Create and update application-calculated
eligibility criteria that can change over time,
such as participant age or length of service.

Review predefined action reasons that track
changes to data, and create new ones.

Create and update models for rating the
performance, potential, and proficiency level of
workers.

Chapter 2
Setup and Maintenance Tasks

Recommended Help

Reason Lookups
Nonmonetary Unit of Measure Lookups

User-Defined Column Lookups

Overview of Workforce Compensation Plan
Configuration
Compensation History Categories

How You Set Up the Other Compensation
and Recurring Payments Summary Data
for Compensation History

General and Watchlist Global Settings for
Workforce Compensation Plans

Global Setting Options for Workforce
Compensation Plan Notifications

Start Workforce Compensation Cycle and
Synchronize Hierarchy Processes

Refresh Workforce Compensation Data
Process

Transfer Workforce Compensation Data to
HR Process

Back Out and Purge Workforce
Compensation Data Processes

Process Workforce Compensation Change
Statements Process

Define Elements, Balances, and Formulas

Define Elements, Balances, and Formulas

Overview of Using Formulas

Derived Factors

Action Framework

Rating Models
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Chapter 2

Setup and Maintenance Tasks

The tasks that people can do and the data that they can see depend on their roles, duties, and privileges. For

information about these factors, see these two guides:

« Securing HCM
- Security Reference for HCM

Related Topics
« Overview of Workforce Compensation

Total Compensation Statements Setup and Maintenance

Tasks

Complete these setup tasks to enable people to define and generate a total compensation statement.

Total Compensation Statements Setup and Maintenance Tasks

Task List Task Name

Define Total Compensation
Statements

Compensation ltems

Compensation Categories

Statement Definitions

Configure Global Settings

ORACLE

Description

Configure the design, content,
and delivery of a compensation
statement that includes
nontraditional forms of pay. For
example, you can include fringe
benefits, cost of benefits, and paid
time off, as well as base pay and
variable compensation.

Create the lowest level of detail
displayed in total compensation
statements originating from
sources such as payroll balances or
element entries.

Create and configure categories
to display similar types of
compensation information in
tabular format in compensation
statements.

Create and configure statement
definitions that determine the
structure and period of the
statement, the compensation
displayed, and the graphs and
information text that appear on the
statement.

Configure options, such as stock
price and watchlist availability, that
apply to all generated statements.

Recommended Help

Overview of Creating a Total
Compensation Statement

Compensation Items and
Sources

Compensation Category
Types

Compensation Categories and
Subcategories

Guidelines to Create Total
Compensation Statement
Definitions

Best Practices for Planning
Statement Definitions

Overview of Creating a Total
Compensation Statement

15
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Task List

Manage Payroll Objects

Security Reference

Task Name

Manage External Compensation
Data Lookups

Configure Compensation Batch
Parameters

Balance Definitions

Fast Formulas

Description

Manage lookup type used to
identify and categorize data from
a third-party application that you
import for use in a compensation
business process.

Configure processing parameters,
such as the maximum number
of errors allowed, for each batch
process.

Create and configure payroll
elements, such as earnings and
deductions, as well as payroll
balances and formulas used to
manage compensation.

Review the predefined balance
definitions and create ones as
needed, including specifying
assigned dimensions and feeds.

Review predefined formulas and
create new ones to validate or
calculate data for benefits, human
resources, absences, or payroll.

Chapter 2

Setup and Maintenance Tasks

Recommended Help

External Compensation Data

« Record Type Lookups for
External Compensation Data

Overview of Creating a Total
Compensation Statement

. Compensation Items and
Sources

Define Elements, Balances,
and Formulas

Define Elements, Balances,
and Formulas

The tasks that people can do and the data that they can see depend on their roles, duties, and privileges. For
information about these factors, see these two guides:

« Securing HCM

- Security Reference for HCM

ORACLE
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5 Profile Options for Compensation Pages,
Actions, and Approval Notifications

CMP_COMPENSATION_RESPONSIVE_ENABLED Profile
Option

To let everyone use the responsive compensation pages that adjust to the screen size of their devices, use this
option. It's enabled by default. For the enabled profile option to work, you also need to create and enable the
HCM_RESPONSIVE_PAGES_ENABLED profile option.

Related Topics
« Overview of Profile Options

- Create and Edit Profile Options

BIP_ONLINE_NOTIFICATION_HCM_COMPENSATION
Profile Option

To generate Bl approval notifications for all compensation actions, such as Change Salary and Individual Compensation,
create and enable this option. For the enabled profile option to work, you also need to create and enable the
BIP_ONLINE_NOTIFICATION_HCM profile option.

Related Topics
« Overview of Profile Options

- Create and Edit Profile Options

BIP_ONLINE_DISCLOSE_HISTORY_HCM_COMPENSATION
Profile Options

To have the approval notification Approvers section include a Show Details link instead of listing submission and
approval details, create and enable these options. You reduce the initial notification content while still letting people see
the details when appropriate.

- BIP_ONLINE_DISCLOSE_HISTORY_HCM_COMPENSATION_CHANGESALARYAPPROVALTASK applies to
notifications for the Change Salary and Administer Salary tasks.

17
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BIP_ONLINE_DISCLOSE_HISTORY_HCM_COMPENSATION_VARIABLEALLOCATIONTASK applies to
notifications for the Manage Personal Contributions, Individual Compensation, and Administer Individual
Compensation tasks.

For the preceding profiles to work after you enable them, you also need to create and enable these profile options:

BIP_ONLINE_DISCLOSE_HISTORY_HCM
BIP_ONLINE_DISCLOSE_HISTORY_HCM_COMPENSATION

When you enable or disable these profile options, you affect all notifications generated after that change.

Related Topics
« Overview of Profile Options

« Create and Edit Profile Options

BIP_ONLINE_HIDE_EDIT_HCM_COMPENSATION Profile
Options

To hide the Edit button on approval compensation notifications, create and enable these options.

BIP_ONLINE_HIDE_EDIT_HCM_COMPENSATION_CHANGESALARYAPPROVALTASK applies to notifications for
the Change Salary and Administer Salary tasks.

BIP_ONLINE_HIDE_EDIT_HCM_COMPENSATION_VARIABLEALLOCATIONTASK applies to notifications for the
Manage Personal Contributions, Individual Compensation, and Administer Individual Compensation tasks.

For the preceding profiles to work after you enable them, you also need to create and enable these profile options:
BIP_ONLINE_HIDE_EDIT_HCM
BIP_ONLINE_HIDE_EDIT_HCM_COMPENSATION

When you enable or disable these profile options, you affect all notifications generated after that change.

Related Topics
« Overview of Profile Options

» Create and Edit Profile Options

ORA_PER_EMPL_ENABLE_WRK_ASG_REST_LQV Profile
Option

Identify the appropriate assignment in compensation responsive pages by configuring other assignment attributes to
display in the Business Title switcher. To do this, use the REST LOV in the Business Title LOV by setting the profile value
to.

18
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Here's the general behavior of the REST Business Title LOV:

It appears on the My Compensation, Compensation Info page only when the selected person has more than
one assignment.

It lists assignments that are in any of these HR Statuses: Active, Suspended, Inactive.

It lists all assignment types except the Offer assignment.

It supports assignment-level security and lists only those assignments for the selected person that the signed
in person has access to.

The ORA_PER_EMPL_ENABLE_WRK_ASG_REST_LOV profile option setting isn't specific to the My Compensation and
Compensation Info pages. It applies to all HCM products that use the new Business Title LOV.

Related Topics
« Employment Profile Options
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4 Profile Options for Salary Actions

HR_DISABLE_PENDING_APPROVALS_CHECK_IN
_HCM_DATA_LOADER Profile Option

To load salary changes with HCM Data Loader when related salary is pending approval, enable this option.

The actions pending approvals can be from a standalone salary action, such as Change Salary. Or they can be when
salary is part of HR actions that include salary changes, such as Promote or Transfer.

Related Topics
« Overview of Profile Options

- Create and Edit Profile Options

ORA_CMP_LGT_WHEN_MISSING_SALARY_DATASECURITY
Profile Option

To prevent salary proposals during Global Transfer actions, when the proposers don’t have permission to access the
source assignment salary, enable this option. Or you can prevent copying salary from the source assignment, but still let
people propose it.

In either case, the option applies only when source and destination legal employer have the same legislative data group.

Profile Value Outcome

Copy and allow entry (default) Copy the salary from the source assignment and let people make changes.

Don't copy but allow entry Don't copy the salary from the source assignment, but let people propose a new salary.
Don’t copy nor allow entry Don't copy the salary from the source assighnment and don't let people propose a new salary.

When the global transfer can't copy salary from the source assignment to the destination assignment, people can
propose salary regardless of the profile configuration. When people have data security access on the source assignment
salary, the global transfer copies future salary for certain salary basis types. But when they don’t have access, the global
transfer doesn't copy future salary, even when people can propose the salary.

Related Topics
« Overview of Profile Options

- Create and Edit Profile Options
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ORA_CMP_NO_SALARY_CHANGE_WHEN_INACTIVE_CHG_A
Profile Option

To let people change salary in the Change Assignment action for an inactive assignment or an assignment that will
become inactive, disable this profile option. By default, this enabled profile option prevents people from changing salary
in these instances.

Related Topics
» Overview of Profile Options

- Create and Edit Profile Options

ORA_CMP_SAL_REUSE_ASGN_ACTION_OCCURRENCE
Profile Option

To make salary reuse the action occurrence identifier of the assignment whenever a matching action and reason exists
for the salary start date, enable this option.

We recommend that you enable this profile option only if you're using responsive pages and the enhanced Employment
Info page released in 22C. Enabling the profile option can affect the action occurrence identifier of the previous salary.
For example, you've salary on 2010, 2016, and 2021.

- When an HR specialist creates a salary for 2022, the processing tries to reuse the action occurrence identifier
for the 2022 salary and 2021 salary.

- When they change the 2021 salary, processing tries to reuse the action occurrence identifier for the 2021 salary.
- When they delete the 2021 salary, processing tries to reuse the action occurrence identifier for the 2016 salary.

Whenever someone creates or deletes a salary, processing accesses the previous salary to correct the end date. Thus
processing also tries to reuse the action occurrence identifier for that salary. Reuse of action occurrence happens
whenever people create or correct salary independently using tools, actions and pages, and processes:

- Tools examples:
o HCM Data Loader or HCM Spreadsheet Data Loader and Salary object
o Salaries REST API
o Download Salaries
Responsive action and page examples:

o Change Salary (Line Manager)
o Change Salary (Compensation Manager)
o Edit Salary from Compensation Info

o Salary History
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o Local and Global Transfer

o Combined Correction and Deletion Employment Details (introduced in 22C update)
Process examples:

o Run Salary Processes

o Run Grade Step Progression

o Synchronize Grade Step Rates

o Workforce Compensation Transfer (only when posting salary, without assignment changes)

o Mass Legal Employer Change

- Classic action and page example:
o Change Salary

When assignment has multiple changes on the same day with the same action and reason, we link the salary to the
most recent action occurrence. The action occurrence won't get reused while posting assignment and salary changes
from Workforce Compensation, because it posts salary changes before assignment changes.

Related Topics
« Overview of Profile Options

- Create and Edit Profile Options

ORA_CMP_SALARY_CHECKS_BEHAVIOR_IN_CHANGE_STAR
Profile Option

To specify how to handle salary validation failures when someone's hire date changes, use this option. The
application checks for salary-related issues and displays an error or warning message depending on the profile option
configuration.

When a validation fails and the profile option is set to Error, people can't submit their transaction. But, if the profile
option is set to Warning, they get a warning message and can submit their transaction if they ignore the warning.

These are the checks affected by this profile option:
Is a salary change proposal pending approval?
Does more than one salary exist for the assignment?
Is the salary basis no longer active?
Does the salary amount violate the salary range on the proposed hire date?

ORA_PER_CLE_COPY_FUT_ASG Profile Option

To copy future salary changes as part of the Local and Global Transfer flow, enable this option. For the copy to happen,
the source and destination employers need to have the same legislative data group.
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Related Topics
» Overview of Profile Options

« Create and Edit Profile Options

ORA_PER_EMP_RETAIN_CHANGES Profile Option

To keep salary changes made during various actions when the proposer returns to the when section and changes the
start date, enable this option.

Related Topics
« Overview of Profile Options

« Create and Edit Profile Options

ORA_PER_EMPL_DEFAULT_EFFECTIVE_DATE Profile
Option

Use this option to not default the when date in the responsive Change Salary flow. When you want to make sure that the
proposer enters a date, set the profile value for this option to N.

Related Topics
» Overview of Profile Options

- Create and Edit Profile Options
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5 Profile Options for Individual Compensation
Pages and Actions

CMP_DISABLE_PENDING_APPROVALS_CHECK_IN_MANAGE
Profile Option

To let individuals submit more personal contributions while other contributions are pending approval, enable this
option. Also configure access details for the individual compensation plan so that people can't update or stop
contributions using the Manage Personal Contributions action.

This profile option affects only individuals submitting personal contributions. Even when it's enabled, people using
these actions to submit new allocations still have to wait for pending approvals to be resolved:

- Individual Compensation

« Administer Compensation

Related Topics
« Overview of Profile Options

- Create and Edit Profile Options

CMP_IC_DATACHECK_IN_NONCMP_FLOWS Profile
Option

To ensure that only people with relevant data security privileges maintain individual compensation in HR actions that
have the section, enable this option. People without the necessary privileges who try to add individual compensation
get an error about insufficient privileges.

Related Topics
« Overview of Profile Options

- Create and Edit Profile Options

Prevent Submissions Without Changes Profile Options

To prevent people from submitting a Personal Contribution, an Individual Compensation, or an Administer
Compensation action without making changes, you need to enable these options. Or you can warn them instead that
they haven't made changes.
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Profile Description

ORA_CMP_PERSONAL_CONTRIBUTION_  Let individuals submit personal contributions without any changes.
BLANKSUBMIT

ORA_CMP_INDIVIDUAL_COMPENSATION_ Let people submit allocations without any changes when they use the Individual Compensation task.
BLANKSUBMIT

ORA_CMP_ADMINISTER_ Let people submit allocations without any changes when they use the Administer Compensation task.
COMPENSATION_BLANKSUBMIT

You can set the individual profile to one of these options:

- Error: Raise an error when an individual tries to submit without any changes.
- Warning: Raise a warning when an individual tries to submit without any changes.
- Allow: Let the individual submit without any changes.

Processing tracks changes made in the Individual Compensation section to show the warning or error. Approvers can
still edit and submit allocations without making changes, even when you enable any of these options.

Related Topics
« Overview of Profile Options

« Create and Edit Profile Options

ORA_CMP_BIP_IC_SHOW_INPUT_VALUES Profile Option

To include input values in the approval notifications for the Manage Personal Contribution, Individual Compensation,
and Administer Individual Compensation actions, enable this option. Then approvers can view all the proposed input
values and not just the primary input value.

The notification includes the lookup code meanings instead of codes, and the values stored in the input values
columns. It doesn't include the meaning or descriptions when the values use validations, such as Value Set and
Validation Source.

When you enable or disable this profile option, you affect all notifications generated after that change.

Related Topics
« Overview of Profile Options

« Create and Edit Profile Options
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ORA_CMP_LGT_WHEN_MISSING_IC_DATASECURITY
Profile Option

To prevent individual compensation proposals during Global Transfer actions when the proposers don’t have
permission to access the source assignment allocations, enable this option. Or prevent copying individual
compensation allocations from the source assignment, but still let people propose it.

In either case, the option applies only when source and destination legal employer have the same legislative data group.

Profile Value Outcome

Copy and allow entry (default) Copy the individual compensation allocations from the source assignment and let people make
changes.

Don't copy but allow entry Don't copy the individual compensation allocations from the source assignment, but let people

propose a new salary.

Don't copy nor allow entry Don't copy the individual compensation allocations from the source assignment and don't let people
propose a new salary.

When the global transfer can't copy individual compensation allocations to the destination assignment, people can
propose allocations regardless of the profile configuration.

Related Topics
« Overview of Profile Options

« Create and Edit Profile Options
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6 Responsive User Experience Setup

Search Logic Profile Options for Client List of Values

You can use the logic <codeph>CONTAINS</codeph> to create the client list of values. This returns results containing
the characters you enter.

Optionally, for individual list of values, you could change this logic to <codeph>STARTS WITH</codeph>, to return
results that start with the search characters you enter.

For example, when you search for a person with the name John Smith while using the logic conTa1ns, you can search by
'jo' or 'sm' or 'th'. When you use the logic starTs wiTh, your search must start with 'j'.

Use the logic starts wite when your list contains thousands of values (more than 15,000 records) to improve the search
performance. Or, if you don't partition your data by set ID.

Note: If you change the search logic for a client list of values, the logic changes in all pages where the list of values is
used.

Related Topics
» Search Logic Profile Options for Client List of Values in Global Human Resources

Use Transaction Design Studio to Configure Field
Displays

Use the Transaction Design Studio (TDS) to configure transactions and pages for responsive applications. TDS is
available within the HCM Experience Design Studio.

You can control the visibility of attributes that are displayed either as Delivered or Enabled, and the availability of fields
and sections of a transaction based on the user's role, person's business unit, or legal employer.

By default, the responsive pages display the often used attributes and hide the less often used attributes. Use Page
Composer to personalize the responsive pages and display the attributes and tabs delivered within the feature.

Here's how you start HCM Experience Design Studio:

1. Sign in to the application as Human Capital Management Application Administrator with Access HCM Page
Configurator (HRC_ACCESS_HCM_TRANSACTION_CONFIGURATOR_PRIV) privilege. This privilege provides
you access to TDS in HCM Experience Design Studio.

2. Enable a sandbox to compose data for configuring business objects. On the Home page, click the HCM
Experience Design Studio quick action under the My Client Groups tab.

3. Under Settings and Actions, click Edit Pages.
4. Select the site layer and click OK.
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Displayed and Hidden Responsive Compensation

Management Fields

Chapter 6

Responsive User Experience Setup

You can configure compensation management fields using Transaction Design Studio.

My Compensation

You can configure these attributes, which make up the My Compensation page.

Attribute

Current Salary
Additional Compensation
Personal Contribution

Prior Salary

Total Compensation Statements

Workforce Compensation

Shares

Recurring and One-Time Payments

Salary
Adjustment
Action

Action Reason
Start Date
Effective Period
End Date
Annual Salary
Annualized Full-Time Salary
Grade ladder
Grade Name
Grade Step

Salary Range

ORACLE

Displayed

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
No
Yes
No
No
Yes
No
Yes
No
No

No

Comments

Section
Section
Section
Section
Section
Section
Section
Section
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute
Salary section attribute

Salary section attribute
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Attribute Displayed Comments

Salary Range Midpoint No Salary section attribute

Range Position Yes Salary section attribute

Compa-Ratio No Salary section attribute

Quartile No Salary section attribute

Quintile No Salary section attribute

Next Salary Review Date No Salary section attribute

Adjustment Amount Yes Salary section attribute, displayed with the
salary basis type of components type

Adjustment Percentage Yes Salary section attribute, displayed with the
salary basis type of components type

Percentage Yes Salary section attribute, displayed with the
salary basis type of components type

Amount Yes Salary section attribute, displayed with the
salary basis type of components type

Annual Amount Yes Salary section attribute, displayed with the
salary basis type of components type

Annualized Full-Time Amount No Salary section attribute, displayed with the
salary basis type of components type

Salary Amount Yes Salary drill-down attribute

Estimated Stock Price No Stock

Estimated Value of Vested Shares No Stock

Estimated Value of Unvested Shares No Stock

Business Title No

Compensation Info
You can configure these attributes on the Compensation page.

Attribute Displayed Comments

Current Salary Yes Section

Show Future and Prior Salary. Yes Section

Additional Compensation Yes Section

Shares Yes Section

Recurring and One-Time Payments Yes Section

Salary Yes Salary section attribute
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Attribute Displayed Comments
Adjustment Yes Salary section attribute
Start Date Yes Salary section attribute
Effective Period No Salary section attribute
Action Yes Salary section attribute
Action Reason Yes Salary section attribute
Salary Basis Yes Salary section attribute
End Date No Salary section attribute
Annual Salary Yes Salary section attribute
Annualized Full-Time Salary No Salary section attribute
Grade ladder Yes Salary section attribute
Grade Name No Salary section attribute
Grade Step No Salary section attribute
Salary Range No Salary section attribute
Salary Range Midpoint No Salary section attribute
Range Position Yes Salary section attribute
Compa-Ratio No Salary section attribute
Quartile No Salary section attribute
Quintile No Salary section attribute
Next Salary Review Date No Salary section attribute
Adjustment Amount Yes Salary section attribute, displayed with the

salary basis type of components type

Adjustment Percentage Yes Salary section attribute, displayed with the
salary basis type of components type

Percentage Yes Salary section attribute, displayed with the
salary basis type of components type

Amount Yes Salary section attribute, displayed with the
salary basis type of components type

Annual Amount Yes Salary section attribute, displayed with the
salary basis type of components type

Annualized Full-Time Amount No Salary section attribute, displayed with the
salary basis type of components type

Currency Yes None
Estimated Stock Price No Stock
Estimated Value of Vested Shares No Stock
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Estimated Value of Unvested Shares
Currency

Business Title

Salary Attributes

Displayed

No
No

No

Chapter 6
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Comments

Stock
None

None

You can configure these salary attributes, which make up the salary sections on various compensation pages. They're
also part of various Offer and HR flows, such as Offer, Hire, Promote, and Transfer.

Attribute

Start Date
Action

Action Reason
End Date
Salary Basis
Salary Amount

Adjustment Amount

Adjustment Percentage

Annual Salary

Annualized Full-Time Salary
Next Salary Review Date
Grade Name

Salary Range

Salary Range Mid Point
Compa-Ratio

Range Position

Quartile

Quintile

ORACLE

Displayed

Yes
Yes
Yes
No
Yes
Yes

Yes

Yes

Yes
No
No
Yes
No
No
Yes
No
No

No

Comments

None
None
None
None
None
None

For salary components, the value appears in the
table.

This attribute doesn't appear in the new Offers
and New Hire flows delivered in 18C.

For salary components, the value appears in the
table.

This attribute doesn't appear in the new Offers
and New Hire flows delivered in 18C.

None

None

None

None

Analytic displays salary range when available.
None

None

None

None

None
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Currency

Shares Section

Displayed

No

Chapter 6
Responsive User Experience Setup

Comments

None

You can configure these stock shares attributes on the My Compensation and Compensation Info pages.

Attribute

Total Shares

Vested Shares

Unvested shares

Granted

Original Grant Price

Estimated Stock Price

Estimated Value of Vested Shares
Estimated Value of Unvested Shares

Unvested Value

Salary History

You can configure the attributes in the two regions on the Salary History pages.

Salary History section

Attribute

Start Date

Action

Action Reason

End Date

Salary Basis

Salary Amount
Adjustment Amount
Adjustment Percentage
Annual Salary

Next Salary Review Date

ORACLE

Displayed

Yes
Yes
Yes
Yes
Yes
No
No
No

Yes

Displayed

Yes
Yes
Yes
No

Yes
Yes
Yes
Yes
Yes

Yes

Comments

None
None
None
None
None
Hidden by default
Hidden by default
Hidden by default

None

Comments

None
None
None
None
None
None
None
None
None

None
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Attribute Displayed Comments
Placement in Salary Range Yes None
Quartile Yes None
Quintile No None
Compa-Ratio Yes None
Range Position No None
Salary Range No None
Salary Range Midpoint No None
Created By No None
Created On No None
Updated By No None
Updated On No None
Grade Ladder Yes Appears when on grade ladder
Grade name Yes None
Grade Step Yes Appears when on grade ladder, step
Comments and Attachments Yes Controls the display of the Comments and

Attachment section

Currency to Use No None

Salary Details section

Attribute Displayed Comments
Start Date Yes None
Action Yes None
Action Reason Yes None
End Date No None
Salary Basis Yes None
Salary Amount Yes None
Adjustment Amount Yes None
Adjustment Percentage Yes None
Annual Salary Yes None
Annualized Full-Time Salary Yes None
Next Salary Review Date Yes None
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Attribute Displayed Comments

Compa-Ratio Yes None

Quartile Yes None

Quintile Yes None

Range Position Yes None

Reason Yes None

Salary Range Yes None

Salary Range Midpoint Yes None

Compensation Zone Yes Appears while using compensation zone based

differential profile

Compensation Zone Type Yes Appears while using compensation zone based
differential profile

Working at Home Yes Appears while using compensation zone based
differential profile

Grade Ladder Yes Appears when on grade ladder
Grade name Yes None
Grade Step Yes Appears when on grade ladder, step
Currency to Use No None
Prior Salary Yes None

Related Topics

« Use Transaction Design Studio to Configure Field Displays

Displayed and Hidden Responsive Team Compensation
Fields

You can configure team compensation fields using Transaction Design Studio.

Assignment

You can configure these assignment attributes, which make up the Overview, Compensation, and Talent tabs of the My
Team pages.

Attribute Displayed Comments

Image Yes None
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Attribute Displayed Comments
Person Display Name Yes None
Business Title Yes Formerly known as Assignment Name. For

incumbents, this field isn't displayed by default.

Number of direct reports and total number of Yes None

reports

Text for non-primary assignments Yes None

Text for suspended assignments Yes None

Icon and text for dotted line/matrix Yes Includes text for relationship type. Line
relationships manager relationships don't display this field.
Text for worker type Yes Not displayed for individuals.
Person List Name No None

Preferred Name (or Known As) and Last Name = No None

Person Number No None

Assignment Number No None

Job Name No None

Job Code No None

Job Name and Job Code No None

Position Name No None

Position Code No None

Position Name and Position Code No None

Location Name No None

Location Code No None

Location Name and Location Code No None

Country Name No None

Country Code No None

Location Name and Country Code No None

Local Time and Location Name No None

Work E-mail Address No None

Work Phone Number No None

Assignment Type No None

Legal Employer No None

Legislation No None
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Attribute Displayed Comments
Legislation Code No None
Cost Center No None
Department Name No None
Grade Name No None
Grade Code No None
Service Years No None
Business Unit No None
Current Salary, Currency and Basis No None
Salary Range, Currency and Basis No None
Compa-Ratio No None
Development Goals No None
Performance Goals No None
Performance No None
Potential No None
Risk of Loss No None
Impact of Loss No None
Talent Score No None

Team Compensation

You can configure this team compensation attribute.

Attribute Displayed
Current to Use Yes
Position

You can configure these position attributes, which make up the Overview, Compensation, and Talent tabs of the My
Team pages.

Attribute Displayed Comments
Position Name Yes None
Position Code Yes None
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Attribute

Business Unit

Number of direct reports and total number of

reports

Headcount and FTE of incumbents
Headcount and FTE of open positions
Department Name

Location Name

Job Name

Entry Grade

Valid Grades

Grade Ladder

Position Headcount and FTE
Hiring Status

Type

Requisition

Displayed

Yes

Yes

Yes
Yes
No
No
No
No
No
No
No
No

No

Chapter 6
Responsive User Experience Setup

Comments

This field isn't displayed by default on mobile
devices.

None

None
None
None
None
None
None
None
None
None
None

None

You can configure these requisition attributes on the Overview tab of the My Team pages.

Attribute

Requisition Title
Requisition Number
Requisition Status
Recruiter

Number of Candidates
Days Since Opened
Location
Department

Work Location

Job Name

Job Family

Job Function

ORACLE

Displayed

Yes

Yes

Yes

Yes

No

No

No

No

No

No

No

No
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Attribute Displayed
Job Grade No
Requisition Template No
Internal Title No
Number to Hire No
Unlimited Hire No
Vacancy

You can configure these vacancy attributes on the Overview tab of the My Team pages.

Attribute Displayed
Vacancy Job Yes
Department Yes
Location Yes
Openings Yes
Requisition Number No
Position Name No
Remaining Openings No
Related Topics

» Use Transaction Design Studio to Configure Field Displays
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7 Approvals Overview

How Default Approval Tasks for Salary and Individual
Compensation Work

You can route salary changes, individual compensation allocations, and workforce compensation allocations to the
appropriate approvers using approval workflow tasks.

You can configure the approval rules to support your compensation policies using these tasks in the Define Approval
Management for Human Capital Management task list:

- Manage Task Configurations for Human Capital Management
- Manage Approval Groups

To find the task list, click Search on the Setup and Maintenance work area, Tasks panel tab.

Manage Task Configurations for Human Capital Management

Approval tasks are event-driven configurations containing rules that identify the approval routing and approvers for
business objects, such as salary changes and compensation allocations.

- On the task Configuration tab of the workflows, the Once per stage task aggregation ensures that the approval
process sends only one notification per approver.

- The Assignees tab provides a technical view of each task and is where you go to the task rules.

Here's what the default compensation approval tasks do:

Task Name Description

ChangeSalaryApprovalTask Runs when someone submits a salary change from the Salary section of compensation page, or using
the Change Salary task or quick action. This approval task doesn't run for changes identified by the
Run Grade Step Progression or Synchronize Grade Step Rates processes.

Sends actionable notifications to the manager of the person who's salary is changing, to approve or
reject the salary changes.

- If the manager rejects the change, the task is complete.

- If the manager approves the change, the task sends an actionable notification to their manager
to approve or reject the change. Regardless of the second manager's action, the task stops at this
level of the supervisor hierarchy.

SalaryHistsoryApprovalTask Runs when someone submits a salary change from the Salary History action, quick action, or task.

Sends actionable notifications to the approver, to approve or reject the salary changes.

VariableAllocationTask Runs when someone submits an individual compensation or personal contribution allocation.

Sends actionable notifications to the manager of the person getting the individual compensation
allocation or making the personal contribution, to approve or reject the allocation.
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Task Name Description

If the manager rejects the allocation, the task is complete.

If the manager approves the allocation, the task sends an actionable notification to their manager
to approve or reject the allocation. Regardless of the second manager's action, the task stops at
this level of the supervisor hierarchy.

None of these approval workflow tasks include threshold rules by default. You can configure thresholds according to
salary change percentage, salary change amount, current and new compa-ratio, grade, job, and so on. For example, you
can create a rule using this IF statement that routes salary approvals when the salary change exceeds 10 percent:

Task.payload.getSalaryApprovalValuesResponse.result/value.newChangePercent more than 10.00.

Manage Approval Groups

By default, the delivered actionable approval workflow tasks route time cards using the dynamically decided supervisor
hierarchy. You can identify specific approvers to route to instead using the Manage Approval Groups task.

ApprovalTimeRecordGroup attribute values vary by implementation. To figure out your value mapping, create your own
data model report in the Reports and Analytics work area using this query:

select * from FUSION.cmp col_ attr map where LOCATION like 'Approval' and ENTERPRISE ID = <ent_ id>;

Tip: You can define rules on the primary input value using the Worker's Other Compensation.Details.Amount
attribute.

Related Topics
» How You Define Approvals for Human Capital Management

« The Manager Hierarchy: How It's Maintained
 Guidelines for Managing Approval Rules

« Approver Types

« HCM Approval Rules

How You Configure Different Approval Flows for
Individual Compensation Allocations and Personal
Contributions

To configure different approval flows for individual compensation allocations and personal contributions, include the
module identifier for the action in your rules.

Action Module Identifier
Individual Compensation (Task.payload. transactionApprovalRequest.moduleIdentifier == "Change Variable
Allocation")
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Action Module Identifier
Manage Personal Contribution (Task.payload. transactionApprovalRequest.moduleIdentifier == "Make Personal
Contribution")
Administer Individual Compensation (Task.payload. transactionApprovalRequest.moduleIdentifier == "Administer

Variable Allocation")

Related Topics
« How Default Approval Tasks for Salary and Individual Compensation Work

» Route Approval for Individual Compensation or Personal Contribution Allocation by Action

How You Can Validate Salary and Responsive Individual
Compensation Approval Rule Changes

Test approval rule changes for responsive salary and individual compensation processes and actions without creating
and submitting any new transactions. This way, you can debug and incrementally build conditional logic for approval
rules, then instantaneously see the effects.

Use the HCM Approval Rules page and Transaction Console for these responsive processes and actions:

Salary Processes and Actions Individual Compensation Processes and Actions
Administer Individual Compensation - Administer Individual Compensation
Manage Individual Compensation - Manage Individual Compensation
Manage Personal Contributions - Manage Personal Contributions

This validation doesn't apply to classic individual compensation workflows because you can see the approval chain on
the transaction Review page.

You need to first commit any changes you make to the approval rules before you simulate the rules. You can search for

transactions by name, who created them, and created during a date range. To further refine your results, use the Status
field. The available statuses are Draft, In Progress, and Failed. Select from the list of filtered transactions and use those

values to simulate the approval rule results.

Tip: To test the approval flow configuration for new transactions, you need to disable bypass approvals. But you can
test the approval flow configuration for pending, draft, and failed transactions when bypass approvals is enabled.

I Note:

For more information, see these Oracle HCM Cloud Common Features Release 13 Transaction Console documents (ID
2430452.7) on My Oracle Support.

- The Basics of Approval Rules
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- The Basics of Transaction Console
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8 Example Approval Configurations

Autoapprove a Salary Change If the Requester Is an HR
Specialist

You control salary approvals with the ChangeSalaryApprovalTask workflow. Here's how you can configure the default
workflow to automatically approve salary changes if the requester has the HR Specialist role.

Scenario

Edit approval workflows using the Manage Task Configurations for Human Capital Management task in the Setup and
Maintenance work area. Complete this configuration of the THEN fields on the Assignees tab.

THEN Field Value
List Builder Supervisory
Response Type Required

This response type makes the notification actionable, instead of just informational.

Number of levels 1
Starting Participant HierarchyBuilder.getManager ("supervisory", Task.payload. transactionApprovalRequest.Requ
Top Participant HierarchyBuilder.getManager ("supervisory", Task.payload. transactionApprovalRequest.Requ
Auto Action Enabled True
Auto Action "APPROVE"
Rule Name AutoapproveHRSpecialist

Related Topics

« How Default Approval Tasks for Salary and Individual Compensation Work

Grade Determines the Levels of Approval for a Salary
Change

You control salary approvals with the ChangeSalaryApprovalTask workflow.
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Here's an idea of how you can configure the default workflow to set different levels of required approval. In this
example, the required levels depend on the grade. If the requester's grade is X, then require only one level of approval. If
the requester's grade is Y, then require two levels of approval.

Edit approval workflows using the Manage Task Configurations for Human Capital Management task in the Setup and
Maintenance work area. Complete these steps on the Assignees tab.

1. Create the rule where the requester's grade is X.
2. Create the rule where the requester's grade is Y.
a. Create this IF expression:

Task.payload.Requestor's Assignment.result.grade.toUpperCase() is "Y"

b. Complete the THEN fields, as shown here.

Then Field Value
List Builder Supervisory
Response Type Required

This response type makes the notification actionable, instead of just informational.

Number of levels 2
Starting Participant HierarchyBuilder.getManager ("supervisory",6 Task.payload. transactionApprovalRequ
Top Participant HierarchyBuilder.getManagerOfHierarchyPrincipal ("supervisory" ,HierarchyBuilder

("supervisory",Task.payload. transactionApprovalRequest.Requestor,-1,null,null

Auto Action Enabled False
Auto Action null
Rule Name 2LevelsforGradeY

3. Create the rule where the requester's grade is X.
a. Create this IF expression:

Task.payload.Requestor's Assignment.result.grade.toUpperCase() is "Y"

b. Complete the THEN fields, as shown here.

Then Field Value
List Builder Supervisory
Response Type Required

This response type makes the notification actionable, instead of just informational.

46
ORACLE



Oracle Fusion Cloud Human Resources Chapter 8

Implementing Compensation Example Approval Configurations
Then Field Value
Number of levels 1
Starting Participant HierarchyBuilder.getManager ("supervisory",6 Task.payload. transactionApprovalRequ
Top Participant HierarchyBuilder.getManager ("supervisory", Task.payload. transactionApprovalRequ
Auto Action Enabled False
Auto Action null
Rule Name lLevelforGradeX
Related Topics

» How Default Approval Tasks for Salary and Individual Compensation Work

Route Approval for a Salary Change According to
Country and Amount

You control salary approvals with the ChangeSalaryApprovalTask workflow.

Here's an idea of how you can configure the default workflow to route the approval depending on the country and
amount. In this example, the country is the US. If the amount is more than 10,000, the approval routes to X and Y and
then the area of responsibility. If the amount is less than 10,000, it routes to only the area of responsibility.

Edit approval workflows using the Manage Task Configurations for Human Capital Management task in the Setup and
Maintenance work area. Complete these steps on the Assignees tab.

1. Create the rule where the country is US and the amount is more than 10,000.
a. Create this IF expression:

Task.payload.Requestor's Assignment.result.legislationCode.toUpperCase() is "US"
andSalaryApproval.newChangeAmount.doubleValue () more than 10000

b. Complete the THEN fields for users X, as shown here.

THEN Field Value
List Builder Resource
Response Type Required

This response type makes the notification actionable, instead of just informational.
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THEN Field Value
Users X
Groups null
Application Role null
Rule Name USover1000usersX

c. Complete the THEN fields for users Y, as shown here.

THEN Field Value
List Builder Resource
Response Type Required

This response type makes the notification actionable, instead of just informational.

Users Y

Groups null

Application Role null

Rule Name USover1000usersY

d. Complete the THEN fields for users according to their area of responsibility, as shown here.

THEN Field Value
List Builder Resource
Response Type Required

This response type makes the notification actionable, instead of just informational.

Users GetRepresentative ("HR_REP",Task.payload.Worker's Current
Representative.result)
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THEN Field Value
Groups null
Application Role null
Rule Name USover1000usersAOR

2. Create the rule where the country is US and the amount is less than 10,000.
a. Create this IF expression:

Task.payload.Requestor's Assignment.result.legislationCode.toUpperCase() is "US"
andSalaryApproval .newChangeAmount.doubleValue () less than 10000

b. Complete the THEN fields, as shown here.

THEN Field Value
List Builder Resource
Response Type Required

This response type makes the notification actionable, instead of just informational.

Users GetRepresentative ("HR_REP",Task.payload.Worker's Current
Representative.result)

Groups null

Application Role null

Rule Name USunder1000usersAOR
Related Topics

« How Default Approval Tasks for Salary and Individual Compensation Work

Route Approval for Recurring Individual Allocation When
the Amount Changes by a Percentage

You control individual compensation approvals with the VariableAllocationTask workflow.

Here's how you can configure the default workflow to handle approvals for percentage changes to recurring awards
made using responsive compensation pages. You use an approval configuration like this because the responsive pages
split updates at submission. In this example, you configure these variable allocation rules to account for both recurring
and nonrecurring elements associated with the awards and contributions.

49
ORACLE



Oracle Fusion Cloud Human Resources
Implementing Compensation

Rule Name

RecurUnderl0%
OnetimeUnderl10%
OnetimelO%plus

RecurlO%plus

Chapter 8
Example Approval Configurations

Purpose

Route recurring awards and contributions with changes that are less than 10%.
Route onetime awards and contributions with changes that are less than 10%.
Route onetime awards and contributions with changes that are 10% or more.

Route recurring awards and contributions with changes that are 10% or more.

CAUTION: To make sure that any simultaneous updates happen correctly, confirm that the elements associated with
the individual compensation plans have Multiple entries not allowed selected.

Edit approval workflows using the Manage Task Configurations for Human Capital Management task in the Setup and

Maintenance work area. Complete these steps on the Assignees tab.

1. Enable advanced mode.

a.
b. Click the Show Advanced Settings icon, which is between the Expand icon and the rule name.

Expand the VariableAllocatiRules rule.

c. Select Advanced Mode.
2. Create the Recurunder10s rule.

a.

Create this IF expression:

Task is a Task
and
Lists is a Lists
and
Each {
ICD is a Worker's Other Compensation Details and
FirstAmouont = ICD.Amount.doubleValue() and
Frequency = ICD.Other Compensation Award Frequency and
FirstPlanId = ICD.planld and
FirstOptionId = ICD.Other Compensation Option Id and
Mflag = ICD.multipleEntriesAllowedFlag.toUpperCase ()
and
ICD2 is a Worker's Other Compensation Details and
SecondAmount = ICD2.Amount.doubleValue ()
ChangePercent = ((SecondAmount-FirstAmount/FirstAmount)*100
SecondPlanId = ICDl.planId
SecondOptionId = ICD2.0Other Compensation Option Id
(Frequency is "R" and
Mflag is "Y" and
SecondPlanlId is FirstPlanId and
SecondOptionId is FirstOptionId and
ChangePercent less than 10.00 and
ChangePercent more than 0)

}

b. Complete the THEN fields, as shown here.

THEN Field Value
List Builder Resource
Response Time Required

ORACLE
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THEN Field

Users

Groups
Application Role
Rule Name

Dimension Id

Value

This response type makes the notification actionable, instead of just informational.

X

null

null

"RecurUnder10%"

null

Chapter 8
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3. Create the onetimeUnder10% rule.
a. Create this IF expression:

Task is a Task
and
Lists is a Lists
and
Each {
ICD is a Worker's Other Compensation Details and
ICD.Other Compensation Change in Value Percentage less than 10.00
}

b. Complete the THEN fields, as shown here.

THEN Field Value

List Builder Resource

Response Time Required

Users X

Groups null

Application Role null

Rule Name "OnetimeUnder10%"
Dimension Id null

4. Create the onetime10%plus rule.
a. Create this IF expression:

Tasks is a Task
and
Lists is a Lists
and
Each {
ICD is a Worker's Other Compensation Details and
ICD.Other Compensation Change in Value Percentage.doubleValue() same or more than 10.00

}
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b. Complete the THEN fields, as shown here.

THEN Field Value
List Builder Resource
Response Time Required

This response type makes the notification actionable, instead of just informational.

Users X

Groups null

Application Role null

Rule Name "OnetimelO%plus"
Dimension Id null

5. Create the recur10%pilus rule.
a. Create this IF expression:

Task is a Task
and
Lists is a Lists
and
Each {
ICD is a Worker's Other Compensation Details and
FirstAmount = ICD.Amount.doubleValue() and
Frequency = ICD.Other Compensation Award Frequency and
FirstPlanId = ICD.planId and
FirstOptionId = ICD.Other Compensation Option Id and
Mflag = ICD.multipleEntriesAllowedFlag.toUpperCase ()
and
ICD2 is a Worker's Other Compensation Details and
SecondAmount = ICD2.Amount.doubleValue ()
ChangePercent = ((SecondAmount-FirstAmount)/FirstAmount)*100
SecondPlanId = ICD2.planId
SecondOptionId = ICD2.0Other Compensation Option Id
(ChangePercent same or more than 10.00 and
Frequency is "R" and
Mflag is "Y" and
SecondPlanId is FirstPlanId and
SecondOptionId is FirstOptionId and
ChangePercent more than 0)

}
b. Complete the THEN fields, as shown here.

THEN Field Value
List Builder Resource
Response Time Required
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THEN Field Value
Users X
Groups null
Application Role null
Rule Name "Recurl0%plus"
Dimension Id null
Related Topics

« How Default Approval Tasks for Salary and Individual Compensation Work

Autoapprove Personal Contributions

You control salary approvals with the VariableAllocationTask workflow. Here's how you can configure the default
workflow to automatically approve personal contributions.

Edit approval workflows using the Manage Task Configurations for Human Capital Management task in the Setup and
Maintenance work area. Complete these steps on the Assignees tab.

1. Create this IF expression:

(Task.payload. transactionApprovalRequest.moduleIdentifier == "Make Personal Contribution")

2. Complete the THEN fields, as shown here.

THEN Field Value
List Builder Supervisory
Response Type Required

This response type makes the notification actionable, instead of just informational.

Number of levels 1

Starting Participant HierarchyBuilder.getPrincipal (Task.payload. transactionApprovalRequest.Requestor,-1,n
Top Participant HierarchyBuilder.getPrincipal (Task.payload. transactionApprovalRequest.Requestor,-1,n
Auto Action Enabled True

Auto Action "APPROVE"

Rule Name AutoapprovePersonalContribution
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Related Topics
« How Default Approval Tasks for Salary and Individual Compensation Work

Route Approval for Individual Compensation or Personal
Contribution Allocation by Action

You can route individual compensation and personal contribution allocations to different approvers depending on
the action used to make the allocation. To make these changes to individual compensation and personal contribution
approval rules, go to Navigator > Tools > Transaction Console.

1. On the Transaction Manager: Transactions page, click the Approval Rules tab.
2. Onthe Transaction Manager: Rules page, search for and click any process you want to change:
o Administer Individual Compensation

o Manage Individual Compensation
o Manage Personal Contributions

3. If the process configuration bypasses approvals, click the Bypass Approvals icon to turn off the bypass.
4. Add arule.

a. Click the corresponding Configure Rules icon.

b. On the Approval Rules page, click the Add New Rule icon.

c. On the graphic, click the rule oval that just appeared, for example, Rule1.
5. Configure the rule to route by the module identifier.

a. Inthe Rule: Add Details section, enter a rule name, such as Administer Action, Manage Action, or
Contribution Action.

Click Configure Rule Conditions.
On the Condition Details dialog box, click the box with the existing expression 1==1.
Click Edit Selection.

On the Approval Rules: Edit Condition Expression dialog box, change Enter a number to Select from
attribute.

In the Select Attribute list, select transactionApprovalRequest > moduleldentifier.
Change Select Operator to ==.

Change Select value type to Enter a string.

In the field that appears, enter the appropriate module identifier:

P an T

~ 7 0@ =

Action Module Identifier
Make Personal Contribution Make Personal Contribution
Individual Compensation Change Variable Allocation
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Action Module Identifier

Administer Individual Compensation = Administer Variable Allocation

Click OK.

k. On the Condition Details dialog box, review the expression. It should look something like this expression for
the Administer Individual Compensation module identifier:

(transactionApprovalRequest.moduleIdentifier == "Administer Variable Allocation")

I. Click OK.
6. Add the approver.
a. Onthe Approval Rules page graphic, in the path of your new rule, click the THEN object to highlight it.

b. Inthe Approvers pane, click the Add Approver Participant icon next to the appropriate approver, such as
Representative.

c. Click Submit.

Related Topics
- How You Configure Different Approval Flows for Individual Compensation Allocations and Personal
Contributions
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9 Market Data

Overview of Market Data

Various job evaluation methods exist as a way to price jobs according to their worth. Market data are a method to price
jobs that are externally focused, so you attract and retain workers based on the labor market.

The foundation for any job evaluation method, including market data, is to start with good job descriptions.

You might want to compare your salaries, salary ranges, and other compensation such as bonus or stock to prepared
industry-wide data to make sure your compensation is in line with your company’s goals. For example, you might want
to make sure you award your people at the 50th percentile of the industry average by job and location. Or you might
want to award base pay at a lower percentile but award stock at a higher level.

With market data you map external survey jobs and locations with internal jobs and locations. Then, you import the
surveys and use the market data subject area in OTBI to consolidate the data. After you create composites of your
survey data, you import these composites. Finally you can display the composites in the worksheet or administer
workers in Workforce Compensation.

You can find the market data tasks in the Compensation work area under Market Data.

Here's a diagram that shows you the market data task flow:
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Compensation
Types

i Surveys

Job Structures (optional )

Supplier
Structures

JobList

Location List

Load Supplier Data
Import Survey —-—— (HDL /HSDL)

Load HDL/HSDL

Market Segments 4—— or add manually

View data at these locations:
Import «  View Market
T s 4—— | oad HDL/HSDL Composites
«  WFC Worksheet
«  WFC Admin Workers
) «  WFC Individual
View Market Data - Worker View

How You Use Market Data Surveys to Create Composites

Surveys are market data from an individual supplier. Composites are aggregated survey data.
Here are the steps that you take to import and use survey data and convert them to composites.

Decide which surveys to buy and participate in.

Receive surveys from suppliers.

Use OTBI to help you complete surveys.

Return surveys to the suppliers.

Receive survey results from each supplier.

Import the surveys using the Import Survey task.

Use OTBI to analyze your people’s data versus the surveys’ data.

Take any actions based on your analysis, such as, updating salary ranges or aligning salaries with the market.
Use OTBI to aggregate surveys into composites.

VOOV AWNA
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10. Import composites using the Import Composites task.
11. Display composites in Workforce Compensation.
12. Line managers and administrators make compensation allocation decisions based on the composites.

Note: If you already have composites, you can start from step 10. However, in that case, the survey data won'’t be in
the subject area.

Related Topics
« Overview of Market Data

 Import Survey for Market Data
» Import Composites for Market Data

Compensation Types for Market Data

Your first task is to define the compensation types that you want to display in market data. Compensation types let you
identify different kinds of pay, such as base salary and bonus, and import survey data for each type.

You can find the Compensation Types page in the Compensation work area under Market Data.

The Compensation Types page is where you identify the market target. For example, if you target the 50th percentile of
the market for Base Salary then you can select that option. If you target the 40th percentile for base salary and the 60th
percentile for bonus, then this is where you identify that mix of pay. The target appears in market composites wherever
they occur in the application.

We deliver several common compensation types, but you can add your own. For example, you might want to offer
supplemental life insurance to executives and review that across competitors in the survey data. Create a compensation
type with the name Executive Benefit Supplemental Life Insurance. Select the Compensation Group of Benefits and a
Data Type of Other.

If you need to set market targets separately for different countries, create and load survey data in that manner. For
example, if the India salary market target is 60% and United States is 50%, create separate compensation types for
them. Load the India salary with one compensation type and the US salary with another.

Related Topics
« QOverview of Market Data

Overview of Supplier Structures

The Supplier Structures page in the compensation work area is where you match your internal jobs and locations to
survey jobs and locations.

You start by adding your suppliers and their surveys. You can have multiple suppliers and each supplier can have
multiple surveys. On the Manage Job List page, you load or manually add survey jobs and match them to your internal
jobs or positions. On the Manage Location List page, you can load or manually add survey locations and match them to
internal locations. You can match several internal locations to a survey location.
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Here's a list of the subtasks for the supplier structures task:

Page Description

Manage Surveys You add your suppliers and their surveys on this page. You can have multiple suppliers and each
supplier can have multiple surveys. You add details for each supplier. For example, you can add a
supplier like Hay. And then you can add surveys from Hay like Hay Professional Survey and Hay
Executive Survey.

Manage Job Structures You can associate job function, job family and other structures to survey jobs. These are entirely
optional. If you do use these values you need to configure them before you add jobs. Then, you can
select the attributes from job structures when you're in the Manage Job List page. Job structures
are Job Family, Job Function, Career Stream or Band, or Career Level. You can use the Manage Jobs
Structures task, for example, to contain info about the survey jobs. This associates these Job Structures
to survey jobs only. It's not tied to internal jobs.

Manage Job List You can load or manually add survey jobs or positions and match them to your internal jobs or
positions. At the top of the page there’s info about the number of survey jobs and what you've
matched. To use any of the Job Structures (Job Function, Job Family, Career Stream or Band, Career
Level or Other Level) associated with Survey Jobs, be sure to add them first or they won't be available
to select. These are optional.

You use the Job Match Notes section to record notes about why job matches change over time. For
example, last year you might have recorded internal Accountant 1as a match to survey Accountant.
But this year changes in the internal job description for Accountant 1 no longer matches the survey
description for Accountant. Because you might need to explain this to the survey auditor at a later
time, it's a good idea to make a note about your decision when it occurred.

Manage Location List On the Manage Location List page, you can load or manually add survey locations and match them to
internal locations. You can match many internal locations to a survey location.
You can map on a many to 1basis here. This is helpful especially if the survey location is broader than
your internal locations. For example, if the survey location is Northern California, then you can include
all your Northern California locations, such as San Ramon and Oakland in the mapping.
This helps your downstream analysis by associating the survey data with all the employees in those

internal locations. Another example is if the survey data is by country, and you have a few locations in
that country.

Related Topics
« Overview of Market Data

How You Match a Survey Job or Position to Your Internal
Data

In the Match Internal Job or Position section, you match the survey job to your job or position.

Search for the internal job or position code that matches the survey job. If you've identified parent benchmark jobs in
Global HR, the child jobs appear below the match.
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Related Topics
« Overview of Supplier Structures

Difference Between Global HR Benchmark Jobs and
Survey Benchmark Jobs

The Parent Job or Global HR Benchmark indicator refers to a setting in Jobs in Global HR.
Here's the difference between Global HR Benchmark jobs and Survey Benchmark jobs.

- Survey benchmark jobs are matched to internal jobs or positions in Supplier Structures. Any of your internal
jobs that you match to survey jobs, are survey benchmark jobs.

Parent Job or Global HR benchmark jobs are indicated that way in the job table, and have child jobs associated
with them.

Related Topics
« Overview of Supplier Structures

Import Survey for Market Data

Surveys are market data from an individual supplier.

You can use the Create Import Template button on the Import Market Data page to invoke the HSDL.You can only load
surveys and not manually add them. However, after you load them, you can modify editable columns like dates, and
percentiles. You can use the HCM Data Loader to create survey records when you implement Market Data for the first
time or provide regular updates.

Before you start
Here’s some things to consider before you begin.
- You need to have a supplier and a survey, with survey jobs and locations, before you import surveys. You can
use existing compensation types.

- The Batch Name, Supplier Code, Survey Code, Survey Location Code, Survey Job Code, Compensation
Type Code, and Industry fields are required.

- Theindustry column can'’t be blank. It can be All, ALL, #NULL, or anything else.

Here's what to do

1. Create the market data workbook in the Compensation work area.
a. On the Tasks panel tab under Market Data click Import Survey.
b. On the Import Survey page, click Create Import Template to create the workbook.
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2. Enter survey data.

Add enough rows to accommodate your supplier's data. Copy the market data and paste them into cells with a white
background. The workbook adds a symbol in the Changed field to mark the rows that you added. Reordering or
removing columns in the import file causes the upload process to fail.

3. When you're done, click Upload. The application uploads only those rows that are marked as Changed. It ignores
any changes in cells without a white background.

CAUTION: Don't select the Upload and then immediately download option when prompted during an upload.
The data that you uploaded immediately downloads back into the workbook, hiding any errors that occurred
during the upload.

4. Validate changes.

On the Import Survey page, search for and select the start date and record type, or other search criteria.

5. Resolve errors.

The upload process automatically updates the Status cell in each workbook row. If there are errors that require
review, the process:

a. Rolls back the change in the application.
b. Setsthe workbook row status to Upload Failed
c. Continues to the next workbook row

To view and resolve an error:

a. Double-click Update Failed in the Status field.
b. Fix any data issues in the workbook.
c. Upload the latest changes.
New uploads to existing data make date-effective changes to the data.

Use the Data Exchange work area under My Client Groups to see the upload. You see if the process completed
successfully and learn about any error messages.

Related Topics
+ Overview of Market Data

 Guidelines for Loading Market Data Objects

Market Segments

Market segments are groups of locations.

After you review your survey and internal locations you can select segments or locations based on geographic labor
market pay differences. You can find the Market Segments task in the Compensation work area under Market Data.

You can decide, for example, that some of your market data should use internal locations for market comparisons, while
other portions of your organization need segmentation. You might want to consolidate internal locations into market
segments if your composites in some locations are all the same. Let’s say you have 3 offices in the San Francisco Bay
Area, and the market data for those is the same.
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Rather than loading the same data 3 times into 3 locations, you can create a market segment that includes your 3

locations and load the composites once. You might decide that the administrative jobs data differs enough locally in
the Bay Area that you want to use internal locations for those jobs. However, the manager jobs don’t have such local
differentiations. Load the administrative jobs using internal locations, and load the managerial jobs using segments.

Related Topics
+ Overview of Market Data

Import Composites for Market Data

Composites are aggregated survey data. They're summaries of all survey data.

Composites are mapped to your internal jobs or positions, and internal locations or segments.

Note: If you use only 1survey, the survey tables hold the raw survey data from the supplier, while the composite table
holds your vetted data that you prepared for line manager consumption.

You can use the Create Import Template button on the Import Market Composite page to invoke the HDSL You can
also use the HCM Data Loader to upload the consolidated surveys from the suppliers.
Before you start
Here’s some things to consider before you begin.
- Make sure to load only segment or location within a row, and not both. If you use location, you need to make
sure the segment column has a #NULL in it.

- Similarly, make sure to load only job or position within a row, and not both. If you use position, you need to
make sure the job column has #NULL in it.

- Theindustry column can’t be blank. It can be All, ALL, #NULL, or anything else.
- Use internal codes for jobs, positions or locations, and not the survey codes you use to load composites.

- Remember: composites are no longer raw survey data, but aggregations of all the surveys, so any individual
survey codes no longer apply.

To use the imported data, you need to complete one or both of these tasks, either before or after the import:

- To view in workforce compensation you need to enter a market composite effective date for the plan cycle.

- To see the individual worker view you need to create a market composite tile in the individual worker view task.

Here's what to do

1. Create the market data workbook in the Compensation work area.
a. On the Tasks panel tab under Market Data click Import Composites.

b. On the Import Composites page, click Create Import Template and select either Load by Segment or
Load by Location to create the workbook.
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2. Enter composite data.

Add enough rows to accommodate your composite data. Copy the composites and paste them into cells with a white
background. The workbook adds a symbol in the Changed field to mark the rows that you added. Reordering or
removing columns in the import file causes the upload process to fail.

3. When you're done, click Upload. The application uploads only those rows that are marked as Changed. It ignores
any changes in cells without a white background.

CAUTION: Don't select the Upload and then immediately download option when prompted during an upload.
The data that you uploaded immediately downloads back into the workbook, hiding any errors that occurred
during the upload.

4. Validate changes.
a. Onthe Import Composites page, search for and select the start date and record type, or other search
criteria.

5. Resolve errors.

The upload process automatically updates the Status cell in each workbook row. If there are errors that require
review, the process:

a. Rolls back the change in the application.
b. Sets the workbook row status to Upload Failed
c. Continues to the next workbook row

To view and resolve an error:

a. Double-click Update Failed in the Status field.
b. Fix any data issues in the workbook.
c. Upload the latest changes.
New uploads to existing data make date-effective changes to the data.

Use the Data Exchange work area under My Client Groups to see the upload. You see if the process completed
successfully and learn about any error messages.

Related Topics
« Overview of Market Data

 Guidelines for Loading Market Data Objects

Options to View Market Composites in Compensation

You can view market composites in workforce compensation and in market data.

Market Composite Views

To view in workforce compensation you need to do the following in the Workforce Compensation Plans setup task:

Enter a market composite effective date on the Configure Plan Cycles page.

Enable market composites column on the Configure Worksheet Page Layout page, Detail Table tab, Additional
Information section.
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- Enable Individual Worker View and create a market composite tile on the Individual Worker View page.

Line managers and administrators can view market composites in multiple ways.

Role Location

Line Manager Market Composites Region in the Compensation Info page, This is accessible via the Compensation
Info quick action in the My Team tab.

Line Manager or Compensation Manager = Market Composites dialog box on the Workforce Compensation Worksheet

Individual Worker View page on the Workforce Compensation Worksheet

Compensation Manager Administer Workers page, Compensation tab in the Compensation work area
Compensation Analyst View Market Composites page in the Compensation work area
Related Topics

» Overview of Market Data
« How You Configure Market Composites Display

How You Configure Market Composites Display

You can select and label market composites for display in the downstream application using the Configure Market
Composites Display task.

You can populate all the columns in the composites table, so professional users have access to complete data, while
controlling the downstream consumption of specific columns. You select and label market composites for display in the
downstream application using the Configure Market Composites Display task.

On the Configure Market Composites Display page, first use the tabs to select the downstream application page. Next,
use the add action to include the compensation types and then use the list of values to select the compensation types
you want to display. Enter a compensation types display name if you want it to appear with a friendly label. Additionally,
enable the Market Target as desired. You can also enter a market target display name if you want it to appear with a
different label. You define the market targets within the compensation types task.

After you save, you can click the compensation types name link to go to the Configure Composite Columns subtask
where you enable the percentiles that you want to appear. You can also enable the chart and select various other
columns.

Related Topics
» Options to View Market Composites in Compensation

« Compensation Types for Market Data
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10 Payroll Elements and Compensation

How Compensation Uses Payroll Elements

Oracle Fusion Global Human Resources, Oracle Fusion Cloud Compensation, and Oracle Fusion Cloud Total
Compensation Statement record compensation. They then transfer the compensation to payroll providers, and store
custom data at the worker level using payroll elements.

People then link these elements to salary bases, individual and workforce compensation plans, and total compensation
statements.

Compensation Object Element Use
Salary basis Create element entries that pass salary amounts to payroll.
Individual compensation plan option Record allocation amounts using the element input values. The element can also decide costing.

Create element entries that pass stock grant dates and numbers of shares granted. You can also
post stock awards directly to the compensation stock table. Use the Stock Grants task, the integrated
workbook, HCM Data Loader, or HCM Spreadsheet Data Loader.

Nonsalary workforce compensation Create element entries that the Transfer Workforce Compensation Data to HR process uses to pass the
component component amount, including lump sums. The process also uses them to pass stock grant dates and
numbers of shares granted.

You can also post stock awards directly to the compensation stock table. Use the Stock Grants task, the
integrated workbook, HCM Data Loader, or HCM Spreadsheet Data Loader.

Total compensation statement A source of the actual compensation shown for the mapped compensation items.

To hold worker-level data referenced or used in a calculation during a workforce compensation cycle, you can create an
information element with multiple input values. Then people configuring workforce compensation plans can use a fast
formula to display the element entry values in appropriate worksheet columns.

Before You Can Use Payroll Elements in Compensation

Whether you've Oracle Fusion Cloud Global Payroll Interface or Oracle Fusion Cloud Global Payroll, you must define
payroll statutory units to use in Oracle Fusion Cloud Compensation. You must also associate a legislative data group
with each unit.

Do this using the Manage Legal Entities and Manage Legal Entity HCM Information tasks. It ensures that when
you hire people, payroll relationships get created automatically. People need these payroll relationships to get their
compensation element entries created.
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Payroll Definitions

The payroll definition supplies each person's pay period frequency and end dates. Even if you use a third-party payroll
provider, you need to define a payroll if any of these conditions apply:

- You want to use nonrecurring elements.

Note: We recommend that you assign payrolls to everyone, even when using only recurring elements.

- You want to create a salary basis that uses a frequency of Payroll period.

- You're implementing total compensation statements and these conditions apply:

o You use recurring elements and want total compensation statements to prorate salary element
entries when someone gets hired during a payroll period. You also want the proration to happen when
someone's employment is terminated during a payroll period.

o You want to let individuals view their total compensation statement details to see payroll period amounts.

+ You license Oracle Global Payroll Interface.

You don't need to define payroll definitions when both of these conditions apply:
- You use only recurring elements defined at the assignment level.
- You store salary at the assignment level of a legal employer.

But if you use compensation history, all compensation awards appear in the recurring payment sections as end-of-year
amounts.

Consolidation Groups

If you create payroll definitions, you need to also define consolidation groups. Each legislative data group that you
define elements for needs to have at least one consolidation group.

Define Elements, Balances, and Formulas

The Define Elements, Balances, and Formulas task list contains the tasks required for creating payroll elements for
compensation, absences, time and labor, and HR management.

You can also use this task list if you're recording earnings, deductions, and other payroll data for reporting,
compensation and benefits calculations, or transferring data to a third-party payroll provider.

Note: If you're using Oracle Global Payroll, use the Define Payroll task list instead. The Define Payroll task list includes
other tasks required to set up payroll processing.

Required Tasks

Your business requirements and product usage decide which required tasks you need to complete. The required tasks
include:

Elements
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- Payroll Definitions, which is usually required to support elements
- Consolidation Groups, which is required for creating payroll definitions

If you use predefined Payroll Interface extracts to transfer data to a third-party payroll provider, you might need to
create element subclassifications, balances, organization payment methods, and object groups. See the Global Payroll
Interface documentation for more information.

Before You Begin

Before you start the Define Elements, Balances, and Formulas task list, complete the tasks these offerings contain.

Task Use To Why It's Important

Manage Legal Entities Create payroll statutory units. Ensures that hiring employees automatically
creates payroll relationship records.

Manage Legal Entity HCM Information Associate a legislative data group with each Ensures that hiring employees automatically
payroll statutory unit. creates payroll relationship records.

Manage Features by Country or Territory Select Payroll Interface as the extension for any = Ensures that you use the appropriate element
countries or territories where you extract HR templates to create earnings.

data to send to a third-party payroll provider.

Configure Legislations for Human Resources
Use this task to create and edit legislative data for a country or territory that doesn't have a predefined country
extension. It guides you through configuring some payroll objects and values required for creating elements, including:
- Tax year start date
- Period of service on rehire rules
- Default currency
- Element classifications
- Component groups
- Payment types

I Note: Complete this task before the other tasks in this task list.

Elements

Use elements to communicate payment and distribution information to payroll applications from the source
applications listed in the following table.

Source Application Element Purpose
Compensation - Earnings and deduction elements, such as bonuses, overtime earnings, and voluntary
deductions.

- Information elements to load user-defined data to use during a workforce compensation cycle.

Benefits - Deduction elements to record activity rate calculation results, such as:
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Source Application Element Purpose

o Employee contributions and employer distributions for medical options

o Flex credits for flex benefits

- Earnings elements to disburse unused credits as cash.

Time and Labor Time card details such as salary, overtime hours, and shift unit payments.

Absence Management Absence details such as number of hours, days absent, or accrual absence balance details.

Payroll Definitions

The payroll definition supplies the payroll period frequency and dates, which some applications use for payroll
calculations. A payroll is assigned to the assignment record of an employee, it indicates the payroll frequency for the
assignment such as weekly. This table shows which applications require payroll definitions.

Application Payroll Definition Required? Usage Conditions

Global Payroll Interface Yes, optional Required if you run the Calculate Gross
Earnings process

Compensation Yes, optional Required if you capture salary with a frequency
of payroll period

Benefits Optional Required to use the payroll period frequency to
calculate communicated rates or values passed
to payroll.

Time and Labor Optional NA

Absence Management Optional NA

Consolidation Groups

You must have at least one consolidation group for each legislative data group where you create elements. Payroll
definitions require a consolidation group.

Other Payroll-Related Setup Tasks

Your implementation might require other tasks from My Client Groups.

Task Requirements

Organization Payment Methods To record personal payment methods for your employees, you need to create organization payment
methods and associate them with your payroll definitions. Organization payment methods define the
combination of payment type and currency to use for payments to employees or external parties.

Element Classifications Primary element classifications are predefined. If you run the Calculate Gross Earnings process
(provided with Global Payroll Interface), you might create subclassifications to feed user-defined
balances.

Fast Formulas The Elements task provides predefined payroll formulas for payroll interface users. You can also write

formulas for several uses, including:
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Task Requirements

Validating user entries into element input values
Configuring compensation, benefit, and accrual plan rules

Calculating periodic values for gross earnings and defining element skip rules for the Calculate
Gross Earnings process (provided with Global Payroll Interface)

Balance Definitions If you're using Global Payroll Interface, creating earnings elements creates balances automatically. You
can edit these generated balance definitions.
If you're using the Calculate Gross Earnings process, you might want to create other balances for
extracts or reporting.

Object Groups You can create object groups to specify subsets of elements or payroll relationships to include in a
report or process, such as the Calculate Gross Earnings process.

Related Topics
« Overview of Using Formulas

« Payroll Definitions
« Payroll Balance Definitions
« How Payroll Elements Hold Information for Multiple Features

Create a Payroll Element to Use with Salary Bases

Configure the payroll element for use in recurring base pay, such as annual salaries and hourly earnings. This guidance
applies to US legislative data groups (LDG).

You can use the same payroll element with multiple salary bases if they've the same currency. You can’t use the same
element for salary bases, individual compensation plans, and workforce compensation plans, or a combination.

1. Go to My Client Groups > Compensation > Elements.

2. Create an element.

3. Onthe Create Element dialog box, complete these steps:
a. Selecta US LDG.

b. Select the primary classification, such as Standard Earnings. The listed classifications depend on the LDG
that you selected.

c. Optionally select the secondary classification, such as Regular. When the selections don't really match your
purpose, you can skip this step.

d. Select the appropriate category, if required, such as Standard.
e. Click Continue.
4. On the Create Element: Basic Information page, complete these steps:

a. Enter a descriptive name that lets you and others easily figure out the use or purpose of the element.
Make sure that the name starts with a letter and contains only letters, numbers, spaces, hyphens, or a
combination of these. It can't contain any special characters.

You can include a prefix, such as SB that lets people easily identify that the element is for a salary basis. You
don't want people using the same element in different compensation objects because it can lead to payroll
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b.

e.

conflicts. It can also lead to unexpected deletions of salary or individual compensation. Two example
names are SB US Annual Salary and SB California Hourly Wages.

Complete these basic information fields.

Field Value Guidance

Reporting Name Enter the name that you want to show in compensation history, on reports, and on payslips
for this earnings payroll element.

Reporting names need to be unique for elements that you add to compensation history.

Effective Date Enter 1/1/1951.

Enter an early date so that the element is available for use immediately in your salary bases,
and individual and workforce compensation plans.

Currency Select US Dollar.

Decides each individual's local salary currency.

What is the earliest entry date for this = Select First Standard Earning Date.
element?

What is the latest entry date for this This date decides how element entries process after someone's job is terminated or they're
element? transferred to another payroll. Select the value that fits your business process.

At which employment level should Select Assignment.
this element be attached?
Term-level elements aren’t supported.

Specify that this element recurs each payroll period.

Specify whether a person can have more than one entry for this element in a payroll period. To let people
link the same salary element to multiple salary bases, select Yes.

To accept the remaining default values, click Next.

5. If your implementation includes it, on the Create Element: Additional Details page, complete these steps:

a.
b.

Select the calculation rule, such as Flat amount.

Select the default periodicity, which is the frequency that the salary basis stores the amount in. The value
should be the same as the salary basis frequency, such as Hourly, Weekly, or Monthly.

Select the conversion rule for the element. For the calculation used by each conversion rule, see Conversion
Rule Options for Configuring Additional Details of Payroll Elements.

To accept the default values for the remaining rules, click Next.

If you use Global Payroll or Global Payroll Interface, configure more details for base pay elements, such as
proration and retroactive changes.
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6. On the Create Element: Review page, complete these steps:

a. Review all your rules and options to ensure that every value is correct.
b. To create the element, click Submit.

7. On the Element Summary page, complete these steps:

a. Review the generated input values. To link the element to a salary basis, the element needs to have a
monetary input value and the Periodicity input value.
- If your implementation includes Global Payroll, you can use the automatically created Amount input
value as is with no extra configuration. If Amount wasn’t automatically created, you need to create a
monetary input value so that people can link the element to a salary basis.
- If the primary classification is Standard Earnings, the Periodicity input value was automatically
created. If the primary classification is Information, you need to create it.
b. Make the element eligible for everyone to use. The element will apply only to people assigned the salary
basis linked to this payroll element.
i. Inthe Elements Overview section, select Element Eligibility.
ii. Click Actions > Create Element Eligibility.

iii. Inthe General Information section, Element Eligibility Name field, enter the element name with the
suffix Open. For example, for the SB US Annual Salary payroll element, the element eligibility name
would be SB US Annual Salary Open.

iv. Enter the same effective date for element eligibility that you did for the element effective date, such
as 1/1/1951.

v. To prevent the creation of duplicate element entries when creating or loading salary, make sure that
the Automatic entry option is clear.
c. Click Submit.
d. Click Done.

Related Topics
» How Element Classification Components Work Together

- Payroll Element Eligibility

» Options to Determine an Element’s Latest Entry Date

- Periodicity Conversion

» How Payroll Elements Hold Information for Multiple Features

Create a Payroll Element to Use with Individual
Compensation Plans

Configure the payroll element for use in recurring or nonrecurring individual compensation allocations, voluntary
contributions, and nonmonetary information. For example, use it for allowances, spot bonuses, stock grants, retirement
savings plans, charitable donations, and storage of duration or points information.

You can use a payroll element in only one option of one individual compensation plan. And you need to use different
elements for salary bases and individual compensation plans.

This guidance applies to US legislative data groups (LDG).
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1. Go to My Client Groups > Compensation > Elements.

2. Create an element.

3. Onthe Create Element dialog box, complete these steps:

a. Selecta US LDG.

b. Select the primary classification. The listed classifications depend on the LDG that you selected.

Element Use

Recurring plan payments

Nonrecurring plan payments for
bonus or lump sum elements

Recurring and nonrecurring voluntary
deductions for individuals’ savings
contributions and charitable
deductions

Stock grants and awards

Storing nonmonetary information

Suggested Primary Classification

Standard Earnings

Supplemental Earnings

Voluntary Deductions or Pretax Deductions

Information

c. Optionally select the secondary classification. When the selections don't really match your purpose, you

can skip this step.

Element Use

Recurring plan payments
Nonrecurring plan payments

Recurring and nonrecurring voluntary
deductions

Stock grants

Storing nonmonetary information

Suggested Secondary Classification

Regular Not Worked
Awards and Prizes, Bonus, another relevant option, or leave it blank.

Select the relevant option. Otherwise, leave it blank.

Leave it blank.

d. Select the appropriate category, if required, such as Standard.

e. (Click Continue.

4. On the Create Element: Basic Information page, complete these steps:

a. Enter a descriptive name that lets you and others easily figure out the use or purpose of the element.
Make sure that the name starts with a letter and contains only letters, numbers, spaces, hyphens, or a
combination of these. It can't contain any special characters.

You can include a prefix, such as IC that lets people easily identify that the element is for an individual
compensation plan. You don't want people using the same element in different compensation objects
because it can lead to payroll conflicts. It can also lead to unexpected deletions of salary or individual
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compensation. Example names are IC Gym Allowance, IC Car Allowance, IC Quarterly US Sales Award, IC
New Hire Stock Grant, and IC Red Cross Contribution.

b. Complete these basic information fields.

Field

Reporting Name

Effective Date

Currency

What is the earliest entry date for this
element?

What is the latest entry date for this
element?

At which employment level should
this element be attached?

Value Guidance

Enter the name that you want to show in compensation history, on reports, and on payslips
for this earnings payroll element.

Reporting names need to be unique for elements that you add to compensation history.

Enter 1/1/1951.

Enter an early date so that the element is available for use immediately in your salary bases,
and individual and workforce compensation plans.

Select US Dollar.

Identifies the currency of the entered and displayed allocation, deduction, or contribution
amount.

Select First Standard Earning Date.

This date decides how element entries process after someone's job is terminated or they're
transferred to another payroll. Select the value that fits your business process.

Select Assignment.

Relationship-level and term-level elements aren’t supported.

c. Specify whether this element recurs each payroll period or requires an explicit (nonrecurring) entry, such as
a bonus, stock grant, or onetime charitable donation.

d. Specify whether a person can have more than one entry for this element in a payroll period. To let people
link the same element to multiple individual compensation plans, select Yes.

e. To accept the remaining default values, click Next.

For Information elements, skip to the Double-Check Your Selections and Submit the Element section by

clicking Next again.
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5. If your implementation includes it, on the Create Element: Additional Details page, complete these steps:
a. Select the calculation rule. For recurring and nonrecurring plan payments and nonrecurring voluntary
deductions, select Flat amount. For recurring voluntary deductions, select Flat amount or Percentage of
Earnings.
b. Select the default periodicity, which is the frequency that the plan stores the amount in.

Element Use Value Guidance
Recurring plan payments The typical value is Monthly.
Nonrecurring plan payments Quarterly, Annually, or Periodically

Nonrecurring voluntary deductions

Recurring voluntary deductions Typically the same periodicity as base pay, such as Annually or Monthly

c. Select the conversion rule for the element. For the calculation used by each conversion rule, see Conversion
Rule Options for Configuring Additional Details of Payroll Elements.

d. To accept the default values for the remaining rules, click Next.
6. On the Create Element: Review page, complete these steps:
a. Review all your rules and options to ensure that every value is correct.
b. To create the element, click Submit.
7. On the Element Summary page, complete these steps:
a. Review the generated input values.

- For the input value that you link to the plan option, make sure that Special Purpose is Primary
input value. Typically, this is the Amount input value. If the value wasn’t automatically created, you
can manually add and configure it here. On individual compensation pages and in notifications,
the primary input value appears in the Value column. Detail pages show other input values. And
notifications can show other input values if the ORA_CMP_BIP_IC_SHOW_INPUT_VALUES profile
option is enabled.

- For each input value that doesn't apply to the plan, deselect the Displayed and Allow User Entry
options, if they aren’t already clear.

- For stock grant information elements, make sure that an input value with the Number unit of
measure has Special Purpose set to Primary Input Value. The element date feeds the Grant Date
column of the stock history table and the primary input value feeds the Shares Granted column. The
Shares section of people's Compensation page uses these values. Depending on configurations,
people's total compensation statements can also use them.

- For storage of nonmonetary information, make sure that Primary Input Value doesn't have Money as
the unit of measure.

b. To validate input values entered on individual compensation pages, add the relevant validation fast
formula. For example, add a validation formula to enforce length of service requirements. A recipient’s
service must be more than 10 years to get a proposed award of 1,000 USD or more. The proposed
allocation for anyone with shorter service must be less.
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c. Optionally complete the steps to set up minimum and maximum values when you use these elements with
individual compensation plans:

- Standard earnings elements with a Regular Not Worked secondary classification
- Supplemental earnings elements

Setup steps:

i. Inthe Element Overview, Input Values section, select Amount.

ii. Inthe Input Values section, on the Edit menu, select Correct.
iii. Inthe Default Entry Values and Validation section, enter a minimum or maximum value, or both.
iv. Select Warning or Error, as appropriate.

o Warning: Show a message when the manager or HR specialist enters an amount that's below
the minimum value or above the maximum value, if set. This usage enables them to still
continue with their submissions.

o Error: Show a message when someone enters an amount that's below the minimum value or
above the maximum value, if set. This usage prevents them from continuing until they enter an
amount that's within the specified limits.

d. Make the element eligible for everyone to use. The element will apply only to people assigned the salary
basis linked to this payroll element.

i. Inthe Elements Overview section, select Element Eligibility.
ii. Click Actions > Create Element Eligibility.

iii. Inthe General Information section, Element Eligibility Name field, enter the element name with the
suffix Open. For example, for the IC Gym Allowance payroll element, the element eligibility name
would be IC Gym Allowance Open.

e. Click Submit.
f. Click Done.

Related Topics
« How Element Classification Components Work Together

- Payroll Element Eligibility

» Options to Determine an Element's Latest Entry Date

« Periodicity Conversion

» How Payroll Elements Hold Information for Multiple Features

Create a Payroll Element to Use with Workforce
Compensation Plans

Configure the payroll element for use in recurring or nonrecurring workforce compensation allocations and
nonmonetary information. For example, use it for allowances, spot bonuses, and stock grants. Also use it to store
duration or points information and custom worker data.

This guidance applies to US legislative data groups (LDG).
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You can use the same payroll element with multiple workforce compensation plans if they have the same currency. You
can’t use the same element for different components in a workforce compensation plan. You also can’t use the same
element for salary bases, individual compensation plans, and workforce compensation plans, or a combination.

1. Go to My Client Groups > Compensation > Elements.
2. Create an element.
3. On the Create Element dialog box, complete these steps:
a. Selecta US LDG.
b. Select the primary classification. The listed classifications depend on the LDG that you selected.

C.

d.
e.

Element Use Suggested Primary Classification
Recurring plan payments Standard Earnings
Nonrecurring plan payments for Supplemental Earnings

bonus or lump sum elements

Stock grants and awards Information

Storing nonmonetary information

Optionally select the secondary classification. When the selections don't really match your purpose, you
can skip this step.

Element Use Suggested Secondary Classification

Recurring plan payments Regular Not Worked

Nonrecurring plan payments Awards and Prizes, Bonus, another relevant option, or leave it blank.
Stock grants Leave it blank.

Storing nonmonetary information

Select the appropriate category, if required, such as Standard.
Click Continue.

4. On the Create Element: Basic Information page, complete these steps:

a.

Enter a descriptive name that lets you and others easily figure out the use or purpose of the element.
Make sure that the name starts with a letter and contains only letters, numbers, spaces, hyphens, or a
combination of these. It can't contain any special characters.

You can include a prefix, such as WFC that lets people easily identify that the element is for a workforce
compensation plan. You don't want people using the same element in different compensation objects
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because it can lead to payroll conflicts. It can also lead to unexpected deletions of salary or compensation.
Example names are WFC Gym Allowance, WFCC Car Allowance, and WFC Quarterly US Sales Award.

b. Complete these basic information fields.

Field Value Guidance

Reporting Name Enter the name that you want to show in compensation history, on reports, and on payslips
for this earnings payroll element.

Reporting names need to be unique for elements that you add to compensation history.

Effective Date Enter 1/1/1951.

Enter an early date so that the element is available for use immediately in your salary bases,
and individual and workforce compensation plans.

Currency Select US Dollar.

Workforce compensation components with a local currency determination code of Salary
Basis Currency use the currency of the element linked to the individual’s salary basis.

What is the earliest entry date for this = Select First Standard Earning Date.
element?

What is the latest entry date for this This date determines how element entries process after someone's job is terminated or
element? they're transferred to another payroll. Select the value that fits your business process.

At which employment level should Select Assignment or Term.
this element be attached?

c. Specify whether this element recurs each payroll period or requires an explicit (nonrecurring) entry, such as
a bonus or stock grant.

d. Specify whether a person can have more than one entry for this element in a payroll period. To let people
link the same element to multiple workforce compensation plans, select Yes.

e. To accept the remaining default values, click Next.

For Information elements, skip to the Double-Check Your Selections and Submit the Element section by
clicking Next again.

5. If your implementation includes it, on the Create Element: Additional Details page, complete these steps:
a. For the calculation rule, select Flat amount.
b. Select the default periodicity, which is the frequency that the plan stores the amount in.

Element Use Value Guidance

Recurring plan payments The typical value is Monthly.
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Element Use Value Guidance
Nonrecurring plan payments Quiarterly, Annually, or Periodically

c. Select the conversion rule for the element. For the calculation used by each conversion rule, see Conversion
Rule Options for Configuring Additional Details of Payroll Elements.

d. To accept the default values for the remaining rules, click Next.
6. On the Create Element: Review page, complete these steps:
a. Review all your rules and options to ensure that every value is correct.
b. To create the element, click Submit.
7. On the Element Summary page, complete these steps:
a. Review the generated input values.
- For the input value that you link to the compensation component, make sure that Special Purpose

is Primary input value. Typically, this is the Amount input value. If the value wasn’t automatically
created, you can manually add and configure it here.

- For each input value that doesn't apply to the plan, deselect the Displayed and Allow User Entry
options, if they aren’t already clear.

- For stock grant information elements, make sure that an input value with the Number unit of
measure has Special Purpose set to Primary Input Value. The element date feeds the Grant Date
column of the stock history table and the primary input value feeds the Shares Granted column. The
Shares section of people's Compensation page uses these values. Depending on configurations,
people's total compensation statements can also use them.

- For storage of nonmonetary information, make sure that Primary Input Value doesn't have Money as
the unit of measure.

b. Make the element eligible for everyone to use. The element will apply only to people assigned the salary
basis linked to this payroll element.

i. Inthe Elements Overview section, select Element Eligibility.
ii. Click Actions > Create Element Eligibility.

iii. In the General Information section, Element Eligibility Name field, enter the element name with the
suffix Open. For example, for the WFC Gym Allowance payroll element, the element eligibility name
would be WFC Gym Allowance Open.

c. Click Submit.
d. Click Done.

Related Topics
» How Element Classification Components Work Together

- Payroll Element Eligibility

« Options to Determine an Element's Latest Entry Date

- Periodicity Conversion

» How Payroll Elements Hold Information for Multiple Features
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Conversion Rule Options for Configuring Additional

Details of Payroll Elements

Use this information to help you select the correct conversion rule when you're configuring the additional details for

payroll elements linked to compensation objects.

Conversion Rule Calculation

Standard Rate Annualized 1. Convert the source amount and
periodicity to an annual value using
default values of 2080 hours, 260 working

days.

2. Convert the amount to the required

periodicity and rate.

Standard Rate Daily 1. Calculate a daily rate using default value

260 working days.

2. Convert the amount to the required
output periodicity and rate.

Standard Working Hours Rate 1. Convert the source amount and working
Annualized hours to an annual value. Use the person's
standard working hours.

2. Calculate the rate.

Assignment Working Hours Rate 1. Convert the source amount and working
Annualized hours to an annual value. Use the person's

working hours.
2. Calculate the rate.

Periodic Work Schedule Rate 1. Convert the monetary value and work

Annualized schedule to an annual value. Use the
person's work schedule for the payroll
period for daily and hourly conversions.

2. Calculate the rate.

ORACLE

Example

NA

NA

Scenario: The person works 40 hours a week with a monthly
salary of 1000 US dollars.

Calculation: ((1000*12) / (40.00*52) = 5.77 an hour

Scenario: The person works 40 hours a week, with a 37.5
standard working hours a week, and a monthly salary of 1000
US dollars.

Calculation: ((1000*12) / (37.50*52) = 615 an hour

Scenario for a person assigned a monthly payroll:

«  The person has a monthly salary of 1000 US dollars.

- The formula checks the work schedule details for the
month.

Daily conversion calculation: 1000 a month / 20 days in the
month =50

For a person not assigned a payroll: The calculation uses the
weekly rate and converts the result to an annual amount. The
calculation then divides the annual amount by the number of
days or hours in that week, according to the work schedule.
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11 Base Pay Overview

Overview of Base Pay Configuration

Base pay is a person's salary amount. Managers and HR specialists view and adjust this amount or any component
amounts or percentages over the time someone works in their organization. Each salary record they manage has an
associated salary basis.

Here's how the salary basis configuration works with salary records and payroll processing.

- Calculations use the frequency and annualization factor of the salary basis to decide the annualized salary that
appears on the salary record. Calculations also use these salary basis settings and the full-time equivalent value
from the employment record to decide the annualized full-time salary.

- The salary record uses any salary components configured on the salary basis to itemize salary adjustments for
reports, such as merit and location.

- The payroll element associated with the salary basis holds the salary amount entered on the salary record. The
basis passes that amount to payroll for processing.

- The grade rate and differential profile associated with the salary basis decide the salary metrics and validation
messages people see on the salary record. Associating them with the salary basis is optional, so they aren't part
of every salary basis configuration.

Salary Basis Salary Record
LDG Payroll Element Salary
Freguency Salary Components Salary Components

Annualization Factor

Grade Rate Salary Metrics
Differential Profile and Validation

You configure grades, grade rates, progression grade ladders, rate definitions, and payroll elements using the Base Pay
task list in the Compensation work area. You can also manage lookups, actions, and action reasons.

Related Topics
» How You Enable Salary Itemization Using Incremental Components

» How You Store the Salary Amount and Pass It to Payroll for Processing
- How Salary Metrics Are Calculated
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How Salary Basis Options Work with Salary Amounts and
Calculations

The interval used to quote and store salary, such as hourly or annually, is the frequency of the salary basis associated
with the salary record.

The annualization factor is the numeric multiplier for the frequency. Calculations use the factor and the salary amount
to decide the annual salary amount, as these examples show.

Frequency Annualization Factor Salary (USD) Annual Salary (USD)
Annually 1 50,000 50,000
Monthly 12 10,000 120,000
Hourly 2080 100 208,000
Related Topics

» Overview of Base Pay Configuration
« Examples of Annual Salary and Annualized Full-Time Salary Calculations
« How You Change a Salary to Account for a Changed FTE

How You Store the Salary Amount and Pass It to Payroll
for Processing

The salary basis holds the overall salary amount from the salary record. It passes the amount to the element entry for
payroll processing each pay period.

Legislative Data Group (LDG)

You configure each salary basis for a specified LDG. If your organization has multiple LDGs, you need to create a
uniquely named salary basis for each unique set of characteristics applicable to each LDG. The LDG limits the payroll
elements that you can associate with the salary basis.

Payroll Element

You attach a single payroll element to each salary basis to hold the overall salary amount. The elements that you can
select from meet these criteria:

- They're valid for the selected LDG.

- They recur.
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- They're either Earning or Information elements.
- They include eligibility definitions.

The required element eligibility definition can include eligibility criteria. We recommend that you leave the
eligibility open on the payroll element.

Make sure that individual compensation doesn't also use the element you select. Using the same element across
compensation objects can lead to payroll conflicts. It can also lead to unexpected deletions of salary or individual
compensation.

Restrictions

You can link recurring elements to multiple salary bases only if they meet these conditions:

- Headquarters-based grades have a base pay of X.

- Grades for all other locations have a base pay of X - 2%.

Input Value

An element can have multiple input values. The element input value that you select in the salary basis, such as Amount,
is the value that stores the salary amount.

The monetary amount stored in the element entry is the salary amount in the salary information for the person's
assignment. That salary amount is in the frequency of the person's salary basis, such as annually or hourly.

If you don't use Oracle Fusion Global Payroll, you can store the salary amount using information payroll elements.

- If the element includes the Periodicity input value, the element entry stores the annual salary amount.

- If the element doesn't include the Periodicity input value, the element entry stores the salary amount in the
same frequency as the salary basis.

Here's how the payroll formula processes the input values of element entries received in the frequency of the salary
basis:

Salary Basis Frequency Amount Passed to Payroll Payroll Processing

Annually Annual amount Converts the annual amount to the appropriate
payroll period amount.

Hourly Hourly rate Multiplies the hourly rate by the number of
hours reported for the payroll period.

The resulting base pay earnings appear on the payslip for the payroll element associated with the salary basis.

Currency

The element currency automatically decides the salary basis currency used to pay the person.

Reference

The Configuring Payroll Elements for Use in Oracle Fusion Compensation document (ID 7589502.7) explains how
compensation uses payroll elements. It also explains how to configure the elements for specific uses.
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Related Topics
» Overview of Base Pay Configuration

- Create a Payroll Element to Use with Salary Bases

How Many Salary Bases to Create

You need to create a separate salary basis, for each unique combination of the following characteristics associated with
a worker's base pay.

A good practice if you require many salary bases in your organization is to use descriptive names. Examples are CA
Hourly Wages, UK Annual Salary with Components, and Adjunct Pay 3 Credit Courses.

Legislative Data Group (LDG)

How many LDGs are in your enterprise? You can create salary bases within a particular LDG. You can't share salary bases
across LDGs. Each salary basis name and each salary basis code must be unique within a legislative data group (LDG).

Frequency and Annualization Factor

How many different frequencies for quoting base pay are in use? People with multiple assignments on different payroll
frequencies need to have a different salary basis associated with each assignment.

Do any of the frequencies have multiple annualization factors for base pay? Your number of salary bases increases by
one for each extra annualization factor in each separate LDG.

Payroll Element and Currency

Do you want to use the same payroll element for different salary bases? You can do this if the element has these
configurations:
It's a recurring earnings element.

It allows multiple entries in the same period.

How many currencies do you pay people in, within a single LDG? You need one payroll element for each currency within
an LDG. You also need a separate salary basis for each payroll element.

Components

Do you want to itemize salary? You need one extra salary basis for each unique collection of components.

Grade Rates and Differential Profiles

How many grade rates are you using? The number of salary bases increases by one for each grade rate in use. You can
reduce the number of grade rates by using a differential profile. Profiles with the compensation zone or compensation
zone and business unit criteria can have grade rates configured instead of multipliers. The number of salary bases
increases by one for each differential profile in use.
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Rounding Rules and Decimal Precision

How many different rounding rules do you use for salary amount? The number of salary bases increases by one for

each rounding rule in use.

How many different decimal places do you display? The number of salary bases increases by one for each decimal

precision in use.

Related Topics

 Incremental Salary Component Lookups
- How Salary Basis Options Work with Salary Amounts and Calculations

» Create a Payroll Element to Use with Salary Bases

« Grade Rates

How You Can Audit Salary Data

You need to enable audit for salary data using the Manage Audit Policies task.

Document Records for Salary

Proposers can attach document records while submitting salary proposals using responsive Change Salary and Salary
History actions. Approvers can view the attachments while deciding to approve or reject the proposal.

After approval, the attachments are available in the individual's document records. People can also see the attached
document records on the My Compensation and Compensation Info salary details pages.

Proposers can include document records of both Person and Assignment types. And actions tag document records with
the action occurrence identifier. Here's what happens to salary and the document record during certain scenarios, and

depending on your setup:

Scenario

During global transfer that copies salary

When someone uses Change Salary to
correct a salary created with HR actions,
such as Hire, Promote, and Local and
Global Transfer

When someone uses Change Salary to
correct a salary created with compensation
actions, such as Change Salary or Salary
History

ORACLE

What Happens

- The Global Transfer action copies salary to the destination legal employer.

- The action moves the assignment-level document record. But it doesn’t link the document to the
copied salary.

- The action creates an action occurrence.

- The document of record created with the original transaction isn't visible.

- The process doesn't create an action occurrence.

- The document of record created with the original transaction is visible.

87


https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20030818

Oracle Fusion Cloud Human Resources Chapter 11

Implementing Compensation Base Pay Overview
Scenario What Happens
When you've Reuse Action Occurrence - Actions reuse the action occurrence when the effective date, action, and reason match that of the
Identifier enabled assignment. The document of record created with the original transaction is visible and people

can't delete it.

- Actions create an action occurrence when the effective date, action, and reason are different. The
document of record created with the original transaction isn’t visible.

When you've Combined Correction and - Actions overwrite the action occurrence with the value selected by the proposer in the action. If
Deletion for Assignment, Salary, and the proposer’s selection is different from that of the salary, then the document of record attached
Document Records on View Employment to the salary isn't visible.

Details Page enabled

Let Proposers Include Document Records in Salary
Proposals

Make the Document Records section visible so that proposers can include documents in their salary proposals. And
optionally filter the types of documents that they can include by action.

1. Make the Document Records section visible in these Transaction Design Studio rules:
o Change Salary
o Salary History
o My Compensation
o Compensation Info
2. Optionally, filter the document types by action. If you don't do this filtering, proposers can add all document types
allowed by their document type security profiles. This filtering applies only when proposers add new document
records.
a. Inthe Setup and Maintenance work area, search for and click the Manage Enterprise HCM Information
task.
. Search for HCM Flow and Document Type Mapping.
c. Select the document types for these HCM flows:
- Change Salary for Line Manager
- Change Salary for Compensation Manager
- Salary History
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12 Salary Basis Introduction

Salary Basis Options for Determining Salary Amount

When you configure a salary basis, you need to specify whether it determines the salary amount by user, by incremental
components, by simple components, or by rate components.

Related Topics
- Salary Amount Is Determined by User

- Salary Amount Is Determined by Incremental Components

- Salary Amount Is Determined by Simple Components

- Salary Amount Is Determined by Rates

- FTE Adjustments When Salary Amount Is Determined by Simple Components

Salary Amount Is Determined by User

With this type of salary basis, HR specialists or managers enter salary amounts, adjustment amounts, or adjustment
percentages when changing salary. You can use this type to identify salary amounts using grade step progression.

Related Topics
 Basic Process to Default Salary Amounts from Grade Ladder Rates

Salary Amount Is Determined by Incremental
Components

With this type of salary basis, HCM specialists or managers itemize the salary adjustment using incremental
components provided by the basis. Or they select the components when changing salary. Which method they use
depends on the salary basis configuration.

| CAUTION: To identify salary amounts using grade step progression, don't select this type of salary basis.

Only the first salary record itemizes the entire salary amount. All later salary records itemize only the adjustment
amount, using percentages or amounts.

Example
On the first salary record, the HR specialist defines a 28,000 USD salary, as shown here.
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Merit

Location
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Amount

20,000
5,000

3,000

The next year, the manager adjusts that person's salary to 32,000 USD, as shown here.

Component

Base
Merit

Location

Related Topics

Adjustment Amount Adjustment Percentage
5,000 18

0 0

-1,000 -0.04

 Incremental Salary Component Lookups

Salary Amount Is Determined by Simple Components

With this type of salary basis, HCM specialists or managers itemize salary changes using simple components. For
example, this $100 salary is made up of four itemizations.

ORACLE
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Salary $100

. Special Allowance

Each component has its own characteristic and change history, and affects salary in a different way. For example,
a component can be a fixed or user-enterable amount. Or it can be a fixed or user-enterable percentage of another
component. And you can add the component to the overall salary, subtract it from the overall salary, or make it
independent of the overall salary.

. Base Salary Housing Allowance . Transport Allowance

Tip: You should use the simple components on responsive pages with salary information. Don't use classic pages to
create, change, or delete salary that uses simple components. You can use classic pages to view simple component
information.

Example

Here's a person's initial salary determined by three simple components and how their manager uses theses
components to adjust their salary a year later. On their first salary record, the HCM specialist defines their 25,000 USD
salary, as shown here.

Component Amount
Base 20,000
Merit 5,000
Location 3,000
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The next year, their manager adjusts their salary to 32,000 USD, as shown here.

Component Amount Adjustment Amount Adjustment Percentage Prior Value

Base 25,000 5,000 25 20,000

Merit 5,000 0 0 5,000

Location 2,000 -1,000 -33.33 3,000
Related Topics

» Simple Salary Component Lookups
» Example Simple Component Configurations with People Entering Values and Fixed Percentages

» Example Simple Component Configurations with Grade Progression Rate, User Entered Values, and Fixed
Percentages

Salary Amount Is Determined by Rates

With this type of salary basis, HCM specialists or managers itemize the salary adjustment using Oracle Fusion Cloud
Global Payroll rate definitions. The overall salary is calculated by summing and subtracting other rates included in the
salary basis.

Rates can be entered by users or calculated by multiplying a factor against another rate value. They can also be derived
using value by criteria or the progression grade ladder. The rates included in the salary basis can have default values.
They can also have frequencies and currencies that are different from those for the overall salary.

CAUTION: Don't include formula-based rate definitions and rate contributors in a salary basis. Also don't use
formulas for validation or to default values. Fast formula database items can't access data proposed in flows and not
yet saved to the database.

You create salary basis rate components using the payroll Rate Definitions quick action for My Client Groups. Be sure to
link a rate definition to only one salary basis to avoid issues when moving a worker to another basis.

Examples

Here, a person's overall salary is calculated by summing three other rate components. Two of the components have the
same frequency as the overall salary component, and one component has a different frequency.

Salary Component Frequency Component Value Source Example
Annual Base Annual User entered 40,000
Allowance 1 Annual User entered 20,000
Incentive Monthly Defaulted from an element entry 1,000
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Overall Salary

Frequency

Annual
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Component Value Source Example

Calculated with this expression: Annual Base + Allowance 1 + (Incentive 72,000
x 12)

40,000 + 20,000 + (1,000 x 12)

40,000 + 20,000 + 12,000

Here, a person's overall salary is calculated by summing two other rate components. Both components have the same
frequency as the overall salary component.

Salary Component

Annual Base

Housing Allowance

Overall Salary

Frequency

Annual

Annual

Annual

Component Value Source Example
User entered 40,000
Calculated with workers at headquarters getting 50 percent of their annual base 20,000

and all others getting 40 percent
Calculated using this expression: Annual Base + Housing Allowance 60,000
40,000 + (40,000 x .50)

40,000 + 20,000

Here, a person's overall salary is calculated by summing four other rate components. One of the components has the
same frequency as the overall salary component, and the other three components have a different frequency.

Salary Component

Annual Base

Housing Allowance

Special Allowance

Variable Incentive

Overall Salary

ORACLE

Frequency

Annual

Monthly

Monthly

Monthly

Annual

Component Value Source Example
User entered 48,000
Calculated as 50 percent of monthly base 2,000

(Annual Base / 12) x .50

(48,000 / 12) x .50

4,000 x .50
Defaulted from an element entry 1,000
Specified factor to apply to the Annual Base component, the calculated value is 1%

loaded into an element entry

Calculated with this expression: Annual Base + (Housing Allowance x 12) 84,480
+ (Special Allowance x 12) + (Variable Allowance x 12)

48,000 + (2,000 x 12) + (1,000 x 12) + (80,000 x .01)

48,000 + 24,000 + 12,000 + 480
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Rounding Rules, Salary Amounts, and Decimal Places to
Display

You can specify separate rounding rules for the salary amount, annualized values, and salary ranges on a salary basis.
You can also specify the decimal places to show for all numeric salary values that you see on the salary record.

Use the Salary Basis task in the Compensation Management work area.

Rounding Rules and Usages

Here's how amounts and ranges use each rounding rule.

Rounding Rule Usage

Salary amount Used by calculations that include the salary amount, for example:

- Toincrease a salary using a percentage, such as 3.5%
- To convert the salary to a different frequency, such as from monthly to annually

- To prorate the salary based on a specific full-time equivalent, such as from 1 FTE to 0.5 FTE

It's also used when calculating simple component amounts from percentages or adjustment
percentages. The rounding rule doesn’t apply to the overall salary amount because it's a sum of the
component amounts.

Annualized values Specifies how the annual salary and annualized full-time salary amounts appear.

Salary range Specifies how salary ranges appear and when calculating revised salary ranges, for example:

- To convert the salary range from one frequency to another

- To apply salary differentials

The rounding rules always affect amounts and values from when you set them and onward. They don't affect previously
calculated amounts and values. Here's how you can ensure consistency across historical and current salary amounts:

1. Create another salary basis with new rules instead of editing an existing salary basis.
2. Update the salary records with this new salary basis from a specific date.
You can use loading tools, such as HCM Data Loader and HCM Spreadsheet Data Loader to make this transition

seamless. Be sure to set the old salary basis to Inactive. This way it's no longer available for people to add it as part of
their salary proposals.

Rounding Rule Place and Decimal Place to Display

We recommend that you match the decimal place of your salary amount rounding rule with the decimal place to display.
Here's what happens when the decimal and rounding rule places don't match.
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Mismatch Issue

If the decimal place to display is longer than
your rounding rule place, salary amounts have
extra zeroes at the end.

If the decimal place to display is shorter than
your rounding rule place, salary amounts get
truncated.

Example Scenario

Salary amount: 15.7923234
Decimal place to display: 4

Rounding rule: Nearest .01

Salary amount: 15.7923234
Decimal place to display: 2

Rounding rule: Nearest .0001

Chapter 12
Salary Basis Introduction

Example Results

Calculations round the amount to 15.79 and
salary pages display the amount as 15.7900.

Calculations round the amount to 15.7923 and
salary pages display the amount as 15.79.

Payroll element entries ignore the decimal place to display from the salary basis because the elements always use the
decimal place of the currency definition. For example, US currency is defined to 2 decimal places. Even if you set your
salary amount display to 4 places, the element entries round the amount to 2 places.

Related Topics

- Overview of Base Pay Configuration
« Can HCM Data Loader round salary amounts when it loads salary information?

ORACLE
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15 Simple and Incremental Component
Itemization of Salary

Considerations for Using Salary Bases with Incremental
Components versus Simple Components

When you configure salary bases, you can use incremental or simple components to itemize salary adjustments. The
incremental and simple components that you can configure come from lookups and their values can be either an

amount or a percentage.

Consider these key differences when selecting the salary basis type.

Criteria

Source of component names

Component types

Input type

Default value

Amount or percentage

Adjustment history

ORACLE

Incremental Components

CMP_SALARY_COMPONENTS lookup

None

A Person can enter an amount or a percentage
against the incremental component.

None

Simple Components

ORA_CMP_SIMPLE_SALARY_COMPS lookup
User entered amount

User entered percentage

Fixed amount

Fixed percentage

Overall salary

Progression grade ladder rate

When allowed, a person can enter an amount
or a percentage. The percentage applies

to the amount of another, specified simple
component. A person can also enter the
adjustment amount or percentage to apply to
the previous simple component value.

You can configure the simple components to
use static default values or values provided by
progression grade ladder rates.

You can even configure the components to
use default values calculated by applying
percentages to other specific simple
components. For example, you can calculate a
car or housing allowance as a percentage of a
base salary.

Can be either

The adjustment applies to only the current
salary record.

Adjustments apply to the current and future
salary records.
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Criteria

Visibility of previous amount

Effect of full-time equivalent (FTE)

Effect on overall salary

Required or optional

Grade Step Progression

Incremental Components

Simple Components

Example scenario: In 2001 the worker gets a merit component of $100. In 2002, they get a $10

increase and in 2003, they get a $15 increase.

Results: Their salary history shows the
incremental merit component amount of $100
in 2001. It shows the adjustment amounts of
$10 in 2002 and $15 in 2003.

Their history doesn't show the calculated
amount of $110 in 2002 or $125 in 2003.

None. People proposing or reviewing proposed
salary changes can't see the previous amounts
or percentages.

None

The individual values are added to the previous
salary amount to decide the new overall salary.

You can configure a fixed set of incremental
components that always show when people
propose salary changes. Or, you can let them
select the incremental components they want
to use in their salary proposal, if any.

Results: Their salary history for the simple merit
component shows the amount of $100 in 2001,
$110 in 2002, and $125 in 2003.

The history of a simple component is preserved
when the salary basis changes and both

bases use simple components of the same
component type.

People proposing and reviewing proposed
salary changes can see previous amounts or
percentages.

Each value gets adjusted for FTE.

You can specify whether the individual values
add to or subtract from the overall salary
amount. You can also configure individual
values to be independent of the overall salary.

You specify whether they're optional. People
need to provide values for any required
simple components when they propose salary
changes. And, they can select the optional
components they want to include, if any.

Consider these key differences when selecting the salary basis type of a salary basis used in grade step progression:

Criteria

Populate salary from progression grade ladder

Grade step progression batch processes

Integration

Incremental Components

No

Not available

Consider these key integration differences when selecting the salary basis type:

Criteria

Workforce Compensation
Total Compensation Statements

Oracle Transactional Business Intelligence
(OTBI) reports

ORACLE

Incremental Components

Simple Components

Yes when the simple component type is
Progression grade ladder rate

Available

Simple Components

Available

Caninclude
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Criteria

Global Payroll
Supported flows
Approval payload

Notifications shows component break up
History

HCM Data Loader Salary Basis and Salary
Allocation objects

HCM Extracts

Global transfer

Incremental Components

GHR actions, Offers, Change Salary, Salary

Supported when you can let HCM specialists

Chapter 13
Simple and Incremental Component Itemization of Salary

Simple Components

Available

HR actions, Offers, Change Salary, Salary History

Attributes available
Change Salary, Salary History

Also available in GHR data models

Supported

User entities and database item groups available

Supported

and managers select the incremental
components to use in their salary proposal, if

any
REST services
Download salaries Supported
Database view

Audit

Autocomplete

CMP_ASG_SALARY_COMPONENTS_V

Supported
Not supported
CMP_ASG_SALARY_SIMPLE_CMPTS_V

Available

There's no new object available to set defaults for either incremental or simple component

values. You can default only the salary basis, not other attributes, such as component amounts or

percentages.

Related Topics

- Salary Amount Is Determined by Incremental Components

- Salary Amount Is Determined by Simple Components

Simple Component Types

You can include up to six different types of simple components in a salary basis configuration.

Type of Simple Component Description

User entered amount

User entered percentage
component.

Fixed amount
it.

ORACLE

The person proposing salary can enter the amount.

The person proposing salary can enter the percentage, which is then applied to the specified

The amount comes from the salary basis configuration and the person proposing salary can't override
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Type of Simple Component Description
Fixed percentage The percentage comes from the salary basis configuration and the person proposing salary can't

override it. The percentage applies to the other, specified component.

Overall salary The amount is calculated from the other component amounts that are configured to add to or subtract
from the overall salary. The person proposing salary can't override the amount.

Progression grade ladder rate The amount comes from the progression grade ladder configuration. it can be either the grade rate
value or grade step rate value. The person proposing salary can overwrite the value.

Related Topics
» Create a Progression Grade Ladder to Default Salary Amounts

- Create a Progression Grade Ladder for Batch Processing

Optional Simple Components in Salary Bases

People proposing salary add or remove optional simple components in responsive flows using the Choose Components
menu. They're included at the end of the salary details table instead of the position specified by the sequence set on the
salary basis.

The optional components do appear in the specified sequence when people view salary history.

HCM specialists and line managers all see the same optional components for the salary basis. If you need only HCM
specialists to add them, consider adding guidance on pages with salary information that discourages line managers
from adding them.

Tip: You can't include simple components when you use classic Change Salary pages or Salary sections.

You've three options for the Optional attribute:

Option Effect on the Simple Component
No It's required and appears in all salary changes.
Yes, don't carry forward It's optional and won't ever appear automatically when proposing or creating salary through scheduled

processes, HCM Data Loader, and HCM Spreadsheet Data Loader. The person proposing a salary
change needs to select the component to include it in their proposal. They need to do this for each
salary proposal, even if the current salary includes the optional component.

Yes, carry forward It's optional and won’t automatically appear as a part of the first salary proposal. The person proposing
a salary change needs to select the component to include it in their proposal. After they include, it
continues to appear in future salary changes.

For example, the salary basis has car allowance set as an optional component to carry forward. A line
manager adds the car allowance to their worker’s salary change. All future salary proposals for that
worker continue to include the car allowance component until it’s explicitly removed.
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Example Simple Component Configurations with People
Entering Values and Fixed Percentages

Here are two examples of how you can configure simple components for people to enter amounts and percentages to
add to the overall salary. You can also include simple components that are fixed percentages and independent of the

overall salary.

Example 1

The first example has three simple components that add to an overall salary component. It also has two fixed
percentage components that are independent of the overall salary.

Component

Basic salary
Housing

Flexible benefit plan
Annual gross pay
Provident fund

Gratuity

Example 2

Type

User entered amount
User entered
percentage

User entered amount
Overall salary

Fixed percentage

Fixed percentage

Component
Percentage Applies
To

NA

NA

NA
NA
Basic salary

Basic salary

Effect on Overall
Salary

Add

Add

Add
NA
None

None

Default Value

NA

50%

NA

NA

12%

4.81%

Example

100,000

50,000

60,000
210,000
12,000

4,810

The second example also has three simple components that add to an overall salary component. And, it has three fixed
percentage components that are independent of the overall salary.

Component

Basic salary

Housing

Special allowance

Annual gross pay

Provident fund

ORACLE

Type

User entered amount
User entered
percentage

User entered amount
Overall salary

Fixed percentage

Component
Percentage Applies
To

NA

NA

NA
NA

Basic salary

Effect on Overall
Salary

Add

Add

Add
NA

None

Default Value

NA

40%

NA

NA

12%

Example

100,000

40,000

60,000
200,000

12,000
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Component

Gratuity

Variable pay

Related Topics

Type

Fixed percentage

Fixed percentage

Component
Percentage Applies
To

Basic salary

Overall salary

Effect on Overall
Salary

None

None

- Salary Amount Is Determined by Simple Components

Example Simple Component Configurations with Grade

Default Value

4.81%

20%

Chapter 13
Simple and Incremental Component Itemization of Salary

Example

4,810

40,000

Progression Rate, User Entered Values, and Fixed
Percentages

Here are two examples of how you can configure simple components that provide salary from rates in progression

grade ladders.

You can include simple components for people to enter amounts and percentages that also add to the overall salary.

And, you can include simple components that are fixed percentages that add to the overall salary or are independent of

it.

Example 1

The first example has five simple components that add to an overall salary component.

Component

Basic salary

Housing

Flexible benefit plan

Provident fund

Gratuity

Total cash

Example 2

Type

Grade progression rate

Fixed percentage
User entered amount
Fixed percentage

User entered
percentage

Overall salary

Component
Percentage Applies
To

NA
NA
NA
Basic salary

Basic salary

NA

Effect on Overall
Salary

Add
Add
Add
Add

Add

NA

Default Value

NA

50%

NA

12%

5%

NA

Example

100,000
50,000
60,000
7,200

5,000

222,200

The second example also has five simple components that add to an overall salary component. And, it has a fixed
percentage component that's independent of the overall salary.

ORACLE
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Component Type Component Effect on Overall Default Value Example
Percentage Applies Salary
To
Basic salary Grade progression rate. NA Add NA 100,000
Housing Fixed percentage NA Add 50% 50,000
Flexible benefit plan User entered amount =~ NA Add NA 60,000
Provident fund Fixed percentage Basic salary Add 12% 7,200
Gratuity User entered Basic salary Add 5% 5,000
percentage
Total cash Overall salary NA NA NA 222,200
Variable pay Fixed percentage Basic salary None 20% 44,440
Related Topics

« Salary Amount Is Determined by Simple Components

How You Migrate Salary Bases with Simple Components

You can use the standard import and export methods and the .csv or .xml files.

How You Enable Salary Itemization Using Incremental
Components

You can enable itemization that lets HR specialists and managers reflect the different reasons for salary changes, such
as merit or location. Use the Salary Basis task in the Compensation work area.

Incremental Component Configuration
Here are the key settings for the salary basis that let you include salary components for itemization.

Field Value

Salary Basis Type Salary adjustment amount is determined by incremental components.

Components to Display When Adjusting Either of these:
Salary

- Select specific incremental components to display during allocation.

- Enable incremental component selection during allocation.
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You add incremental salary components or can change the available components by editing the
CMP_SALARY_COMPONENTS lookup type. Use the Manage Common Lookups task in the Compensation work area.

Incremental Component Processing

When values change for incremental salary components, the payroll element associated with the salary basis holds the
new salary amount calculated from the component adjustments. Payroll doesn't receive individual component values
for processing.

Example

The person's current salary is 50,000 USD. Their manager enters incremental component adjustment percentages and
salary calculations decide the monetary amounts, as shown here. The calculations then sum the monetary amounts and
the original salary amount to decide the new salary amount of 60,000 USD. Here's the equation:

(5,000 + 3,000 + 2,000 + 50,000)

Salary Component Adjustment Percentage Calculated USD
Merit 10 5,000
Promotion 6 3,000
Adjustment 4 2,000

Related Topics
 Incremental Salary Component Lookups
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14 Examples of How Simple Components
Work

A New Hire Action with Simple Components

Here's an example of what happens in the salary section of a New Hire action when the selected salary basis type is
simple components.

1.

2.
3.

You select the Simple Components Salary Basis (all required) salary basis and the required components appear
in the table.

The Basic salary component lets you enter an amount, such as 40,000.

The Housing allowance component lets you enter a percentage, such as 60%. Then it applies the percentage to
the Basic salary component amount to calculate the allowance amount, such as 24,000.

The Transport allowance component is a fixed amount, such as 1,800, that you can't remove or change.

The Special allowance component is a fixed percentage, such as 40% that you can’t remove or change. The
component applies the percentage to the Basic salary component to calculate the allowance amount.
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6. The Overall salary component adds all the other component amounts together to get the overall salary amount,
such as 81,800.

© Salary Details

*Salary Basis
Simple Componenits Salary Basis (all mandatory) o

Component Name Percentage Amount Annual Amount
Basic salary 40,000.00 e 40,000.00
Hou.sing allowance 60.00 e 24,000.00 24,000.00
(Basic salary)
Transport allowance 1,800.00 o 1,800.00
spectlalosanes 40.00 e 16,000.00 16,000.00
(Basic salary)
Overall salary 81,800.00 e 81,800.00
*Salary Amount Grade Name
81,800.00 USD Annually ZCMP IC1
Annual Salary Compa-Ratio
§1,800.00 USD (FTE 1) 78.65
Annualized Full-Time Salary Quartile
81,800.00 USD Below Range

Proposed Salary

81 ,80000 USD Annually

83,200.00 124,800.00

Related Topics
 Salary Amount Is Determined by Simple Components

A Change Salary Action and Simple Components

Here's an example of what happens in the salary section of a Change Salary action when the selected salary basis type
is simple components.

1. For the Basic salary component, you can enter an adjustment amount, such as 2,000, or a percentage, such as
5%. Then it calculates the adjustment percentage or amount and the proposed component amount, such as
42,000. Or you can directly enter the proposed amount and the component calculates the adjustment amount
and percentage.
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2. For the Housing allowance component, you can enter an adjustment amount, such as 1,620, or percentage,
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such as 6.75%. Then it calculates the adjustment percentage or amount and the proposed component amount,
such as 25,620. Or you can directly enter the proposed amount and the component calculates the adjustment

amount and percentage.

3. The Transport allowance component is a fixed amount, such as 1,800, and you can't remove or change it.
4. For the Special allowance component, the adjusted percentage, such as 5%, is fixed and you can't change it.

The component calculates the adjustment amount, such as 800, and the proposed component amount, such

as 16,800.

5. The Overall salary component adds all the other component amounts together to get the overall salary amount,

such as 86,220.

@ Salary Details

*Salary Basis

Component Name

Basic salary o 40,000.00

Housing allowance 24.000.00
(Basic salary) ] i

Transport allowance e 1.800.00

Spedial allowance o 16,000.00

(Basic salary)

Overall salary e 81,800.00

*Salary Amount
86,220.00 USD Annually

Adjustment Amount
4,420.00 USD

Adjustment Percentage
5.40 9%

Annual Salary
86,220.00 USD (FTE 1)

Current Salary

81 ,80000 USD Annually

83,200.00 124,800.00

Show Current Salary Details

Simple Components Salary Basis (all mandatory)

Prior Amount Adjustment Amount

2,000.00

1,620.00

0.00

800.00

4,420.00

Adjustment

Piiceniage Percentage Amount
5.00 42,000.00

6.75 61.00 25,620.00

0.00 1,800.00

5.00 40.00 16,800.00

540 86,220.00

Annualized Full-Time Salary
86,220.00 USD

Grade Name
ZCMP IC1

Compa-Ratio
82.90

Quartile
1

Proposed Salary

86,22000 USD Annually

+4,420.00 (+5.40%)

83,200.00 124,800.00

Annual Amount

42,000.00

25,620.00

1,800.00

16,800.00

86,220.00

Related Topics

- Salary Amount Is Determined by Simple Components

ORACLE
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The First Allocation and Next-Year Changes with Simple
Components

Here’s an example where you enter the salary information for a new hire and then change their salary a year later. This
salary information includes a salary basis with required simple components.

New Hire Action

While working through the New Hire action, in the Salary section, you select the Salary Required Components salary
basis, which includes required simple components. In the table that appears, you see all the required components and
any default values. You also see that you can enter a basic salary amount and adjust the default housing allowance
percentage. The travel and city allowance value are fixed, so you can’t remove or edit them.

The name of the other component appears below the percentage component name. For example, Housing allowance is
calculated as 50% of Basic salary component value. So below Housing allowance you Basic salary as a tip that housing
allowance is based on it.

Component Name Percentage Amount Annual Amount Annualized Full-Time
Amount

Basic salary NA 0 0 0

Housing allowance 50 0 0 0

(Basic salary)

Travel allowance NA 19,600 19,600 19,600
City allowance 10 0 0 0

(Basic salary)

Overall salary NA 19,600 19,600 19,600

When you enter the basic salary amount of 50,000, the salary calculations automatically decide the other component
values.

Component Name Percentage Amount Annual Amount Annualized Full-Time
Amount

Basic salary NA 50,000 50,000 50,000

Housing allowance 50 25,000 25,000 25,000

(Basic salary)

Travel allowance NA 19,600 19,600 19,600
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Component Name Percentage

City allowance 10

(Basic salary)

Overall salary NA

Change Salary Action

Amount

5,000

99,600

Chapter 14
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Annual Amount

5,000

99,600

Annualized Full-Time
Amount

5,000

99,600

It's a year later and you want to change the person's salary. The Change Salary page shows the current salary details. In
the prior amount column, you see the current component amounts adjusted for frequency and FTE, if any.

Component Name Prior Amount

Basic salary 50,000
Housing allowance 25,000

(Basic salary)

Travel allowance 19,600
City allowance 5,000

(Basic salary)

Overall salary 99,600

Adjustment
Amount

0

Adjustment
Percentage

0

0

0

Percentage

NA

NA

10

NA

Amount

50,000

25,000

19,600

5,000

99,600

Annual Amount

50,000

25,000

19,600

5,000

99,600

You can use either the adjustment amount or adjustment percentage to calculate the new component amount. Or you
can directly enter the new component amount. Whichever way you make your changes, as you enter the values, other
values for that component get recalculated. And the other effected components with a higher process order also get

recalculated.

Component Name Prior Amount

Basic salary 50,000
Housing allowance 25,000

(Basic salary)

Travel allowance 19,600
City allowance 5,000

(Basic salary)

ORACLE

Adjustment
Amount

5,000

5,250

400

500

Adjustment
Percentage

10

21

2.04

10

Percentage

NA

55

NA

10

Amount

55,000

30,250

20,000

5,500

Annual Amount

55,000

20,250

20,000

5,500
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Component Name Prior Amount Adjustment Adjustment Percentage Amount Annual Amount
Amount Percentage
Overall salary 99,600 1,150 119 NA 110,750 110,750

Working Hours Change and Simple Components

When you change a person’s FTE (full-time equivalent) value, for example from 1to .9, the prior component amounts
automatically adjust for the proposed FTE. This way you can do a direct comparison between current and proposed
amounts.
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Change Working Hours
Neil (T4) RJ

(1) When and Why

@ Working Hours
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(2] Salary

*Salary Basis

Standard Mandatory

Component Name
Basic salary

Housing allowance
{Basic salary)

Travel allowance

City allowance
(Basic salary)

Overall salary

Action
Working Hours Change

*Salary Amount
99,675.00 USD Annually

Adjustment Amount
0.00 USD

Current Salary

Salary Basis

Component Name
Basic salary

Housing allowance
{Basic salary)

Travel allowance

City allowance
{Basic salary)

Overall salary
Action

Salary Change

Salary Amount
110,750.00 USD Annually

Adjustment Amount
11,150.00 USD

Components

Adjustrent
Prior Amount Adjustment Amount o A Percentage Amount
Percentage
0.00 0.00 500.00
27,225.00 0.00 000 55.00 27,225.00
18,000.00 0.00 000 18,000.00
4,950.00 0.00 0.00 10.00 4,950.00
99,675.00 0.00 0.00 99,675.00

110,750.00 uso ann

Hide Current Salary Details

Adjusted to 0.9
FTE Values

Standard Mandatory Components

Adjustment Amount Adjustment Percentage

5,000.00 10.00

5,250.00

400.00
500.00 10.00
11,150, 11.19

Annual Amount

49,500.00

~
s}
™
N}
&
8

18,000.00

4,950.00

99,675.00

Adjustment Percentage
0.0

Annual Salary
99,675.00 USD (FTE 0.9)

Next Salary Review Date
m/dryy
osed Salary

99,8 5.00 usp annually

0.00 (0.00%)

FTE Values

Percentage Amount

55,000.00

55.00 30,250.00

10.00 5,500.00

110,750.00

Adjustment Percentage
1119 %

Annual Salary
110,750.00 USD (FTE 1)

Nesxt Salary Review Date

oF

Annual Amount

55,000.00

30,250.00

20,000.00

5,500.00

Seniority Dates
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Salary Frequency Change and Simple Components

When you change from a salary basis with a monthly frequency to a salary basis with an annual frequency, the prior
component amounts adjust automatically.

The current monthly amounts get converted to prior annual amounts. And these annual amounts become the default
proposed amounts and annual amounts. This way values set for simple components of a salary basis configuration
carry forward to the simple components of another salary basis.
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(1) When and Why # ki

© Salary Details

*Salary Basis

| Mandatory Componer
Component Name Prior Amount fdjustment Amount Percentage Amount Annual Amount
Percentage
Basic salary 60 00¢ 0 60,000.0C

Housing allowance

0.0 C 50.

(Basic salary

Travel allowance 19,2000 0.00 000 19,200, 19,204
C\tyallowan_ce 0.0( 00 o4 &

( ary)

Overall salary 0.0C 0.0( 0 115,20 15.2

Monthly amount Annualized Full-Time Salary
ar z adjusted to 115,200.00 USD
WAl annual amount

*Salary Amount

Adjustment Amount Grade Name
0.00 USD ZCMF
Adjustment Percentage Compa-Ratio
0.0( 6.80
Annual Salary Quartile

1 2.00 (. FTE 1 1
Current Salary Propased Salary

9,600.00 usp montt 15,200.00 usp annaaly

0.00'0.00%)
000.00
Hide Current Salary Details
Salary Basis
$ fard Monthly Components Monthly amo
Component Name Percentage Amount Annual Amount
Basic salary 00 60,00
Housing allowance e, o
(Basic salary]

Travel allowance 192
City allowance y o 6
(B salary) i
Overall salary 9,600.00 15,2
Salary Amount Compa-Ratio
0 USD Monthly 2.31

Annual Salary Quartile
115.200.00 | FTE 1 2
Annualized Full-Time Salary Quintile

5,200.00 |
Grade Name

ZCN
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Component Type Changes and Simple Components

When you change from a salary basis with simple components to a salary basis that includes components of the same
name and type, the component values carry across the salaries. If the type changes, you don’t see a prior amount.

The salary bases in this example both have five simple components.

- Both bases include the Basic salary, Travel allowance, and Overall salary components and the components have
the same type.

- Both bases include the Housing allowance component. But the first basis has the user entering a percentage
while the second basis has the user entering an amount.

- Only the first basis includes a City allowance component.

- Only the second basis has a Variable allowance component.

- The first salary basis has an annual frequency and all five components are required.

- The second salary basis has a monthly frequency and three components are required while two components

are optional.

Annual Salary Basis with Five Required Components

Component

Basic salary

Housing allowance

Travel allowance
City allowance

Overall salary

Type

User enters amount

User enters
percentage

Fixed amount
Fixed percentage

Overall salary

Component
Percentage Applies
To

NA

Basic salary

NA
Basic salary

NA

Affect on Overall
Salary

Add

Add

Add
Add

No effect

Optional

No

No

No
No

No

Default Value

50

19,200
10

NA

Monthly Salary Basis with Three Required Components and Two Optional

Components

Component

Basic salary
Housing allowance

Travel allowance

ORACLE

Type

User enters amount
User enters amount

Fixed amount

Component
Percentage Applies
To

NA
NA

NA

Affect on Overall
Salary

Add
Add

Add

Optional

No
No

Yes, don't carry
forward

Default Value

None
None

1,600
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Component Type Component Affect on Overall Optional Default Value
Percentage Applies Salary
To
Overall salary Overall salary NA No effect No NA
Variable allowance User enters amount NA No effect Yes, don't carry 0
forward

You start proposing a salary change and select the second salary basis. You can see that only the prior Basic salary
amount adjusted for the new frequency, from 50,000 to 4,166.67. Even though the Housing allowance exists in the
second salary basis, you don't see a prior amount because the component types are different.

Change Salary

Price R

@ When and Why

7

@ Ssalary Details

Cunent Solary

100,000.0000

Next, you include the optional components, which appear in the last rows of the table, below the Overall salary

component. You can see that the prior Travel
the new frequency.

ORACLE

allowance amount automatically adjusted from 19,200 to 1,600 because of
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® When and Why

@ salary Details
—
SR——— wage
.
A solory
Aooualusd Pl Time Slary
e ome
Goret sy Propored Slary
99,200.0000 5,766.67
i
o N\ Anomt a
- D
A sary Quartte
Ansiend TS =
Gade e
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15 Rates-Based Component Itemization of
Salary

Comparison of Rate Component Categories for Salary
Bases

When you determine the salary amount using rates, you can use Element, Derived, Grade Rate, and Value by Criteria
rate definitions. These definitions are the multiple components of pay that make up the salary amount.

We don't recommend using other rate categories, such as Formula, because of possible performance issues and data
access constraints.

As shown here, Element rates use payroll element input values of either amount or factor. Value by Criteria rate
definitions use Value by Criteria definitions. And Derived rates can use Element, Grade Rate, and Value by Criteria rates
as rate contributors.

Payroll Element with S I
Input Values of Amount Conég?eustmg ValuDrgf?'%t(i:g;ena
or Factor
T M
Rate
Definitions J
Element ‘ ‘ Derived }(— ‘ Grade Rate ‘ ‘ Value by Criteria
b ol
Rates-based Salary
Basis (Multiple
Components of Pay)
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This table identifies key properties and whether they're allowed or required (Y) or not allowed or required (N).

Property Element Rate Derived Rate Overall Salary Rate Grade Rate Rate Value by Criteria Rate
Definitions Definitions Definitions Definitions Definitions
Need to associate a Y N Y N N

payroll element

User can enter or Y N N N N
override the value

Store the rate valuein = Y N N N N
an element entry

After final salary Y Y Y Y Y
approval, calculate

salary component

values and store them

in the CMP_SALARY_

PAY_COMPONENTS

table

Rate provides a default Y N N Y N
value

Rate can be a baserate Y Y Y Y N
Rate can be an overall Y Y NAW N N
salary

Element Rate Components in a Salary Basis

Use Element rate definitions in a salary basis to get a default value from element entries. Or use them to let the person
allocating salary enter a flat amount or factor as an input value for a payroll element.

For example, you create a rate definition that uses the Incentive element. If the incentive is stored as a monetary value,
select Amount. If the incentive is a factor of another value, such as another rate definition, select Factor.

You need to create the payroll element with a calculation type of Flat amount or Factor before you can use it in an
Element rate definition. Choosing Amount in the rate definition automatically defines the contributor. You must define
the contributor when choosing Factor. The factor is used to calculate the rate amount, which can be included in the
overall salary amount. For both rate definitions, you need to select the corresponding calculation rule. For element rates
of Amount, select Flat amount. For element rates of Factor, select Factor.

CAUTION: Link a payroll element to only one rate. Linking the element to multiple rates can cause issues, such
as when a worker moves to another salary basis. Also be sure to select the Override Allowed option for the rate
definition. This way people allocating salary can enter an amount or a factor.

To create rate definitions, go to My Client Groups > Compensation > Rate Definitions. Be sure to link a rate definition
to only one salary basis to avoid issues when moving a worker to another basis.

18
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Derived Rate Components in a Salary Basis

Use Derived rate definitions in a salary basis to get a calculated rate by adding or subtracting one or more rates, or rate
contributors.

Derived rate definitions can get values from one or more other rate definitions, including rates that get element entry
values. For example, you can add regular salary, car allowance, and incentive pay rate contributors together to create
an overall salary rate definition. When creating a derived rate definition, you add the relevant contributors and specify
whether to add or subtract each contributor when calculating the derived rate value.

To create rate definitions, go to My Client Groups > Compensation > Rate Definitions. Be sure to link a rate definition
to only one salary basis to avoid issues when moving a worker to another basis.

Grade Rate Rate Components in a Salary Basis

Use Grade Rate rate definitions in a salary basis to get the rate value for the grade or grade and step value of the
person's work assignment.

The grade or grade and step can come directly from the assignment progression ladder or from the retained pay
extensible flexfield (EFF) associated with the assignment. For example, you've the Consultants grade ladder with these
grades, steps, and rate values:

Grade Step Rate Value
G1 S1 n
G1 S2 12
G2 S1 21

One worker's salary basis has the rate contributor as a grade ladder, and their work assignment has the grade G1and
step S1, so their rate is 11. Another worker's salary basis has the rate contributor as a retained pay EFF. And the retained
pay EFF for their work assignment has the grade G2 and step S1, so their rate is 21.

To create rate definitions, go to My Client Groups > Compensation > Rate Definitions. Be sure to link a rate definition
to only one salary basis to avoid issues when moving a worker to another basis.

Value by Criteria Rate Components in a Salary Basis

Use Value by Criteria rate definitions in a salary basis to get a value from an Oracle Fusion Cloud Global Payroll value by
criteria definition.
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You decide the criteria to enter and the resulting tree structure. In each branch of the tree, you can have multiple
evaluation conditions and the value to return. You can also define a default value, for criteria that doesn't meet the
conditions, or to define minimum and maximum thresholds.

For example, you can calculate allowance for workers based on their job.

- If the worker is a Consultant, pay them 45,000 USD.

- If the worker is a Senior Consultant, pay them 55,000 USD.

- If the worker is a Principal Consultant, pay them 65,000 USD.
- Otherwise, pay them 35,000 USD

Or you create a value by criteria definition that returns a flat amount based on the worker's location. You use that
definition in a Value by Criteria rate, and include that rate as a contributor to a derived rate definition.

To create rate definitions, go to My Client Groups > Compensation > Rate Definitions. Be sure to link a rate definition
to only one salary basis to avoid issues when moving a worker to another basis.

Related Topics
« Overview of Values Defined by Criteria

- Calculate Values Defined by Criteria

« Calculate a Rate Using Multiple Values Defined by Criteria

- Rates Based on Values Defined by Criteria

 Allowance Setup Using Rate Definition and Value By Criteria for Qatar

Database Items That Can Detect Proposed Info in Salary
Value by Criteria Rate Definitions

You can detect proposed information and calculate rate values in various flows, such as Hire an Employee, and Local
and Global Transfer, when using these special database items in Value by Criteria rate definitions.

Other database items won't detect the proposed information and will thus calculate rate values based on information in
the database tables.

Attribute Name Database Item Name Comments

Business Unit PER_ASG_BUSINESS_UNIT_ID

Location PER_ASG_LOCATION_NAME

Legal Employer PER_ASG_ORG_LEGAL_EMPLOYER_NAME

Department PER_ASG_ORG_DEPARTMENT_NAME

Worker Category PER_ASG_EMPLOYEE_CATEGORY_MEANING
PER_ASG_EMPLOYMENT_CATEGORY_
MEANING

Period of Service (seniority) PER_ASG_REL_LENGTH_OF_SERVICE
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Attribute Name

Legal Employer Level Seniority Date

Enterprise Seniority Date

Legal Employer Level Hire Date

Enterprise Hire Date

Number of Child Dependents

Assignment Number
Assignment ID
Assignment Start Date

Job

Job Code

Job Family

Business Unit
Location
Department
Legal Entity
Normal Hours

Assignment Category

Legal Employer
Assignment Flex
Grade Flex
Grade Code
Grade

Grade Ladder
Grade Step

Location Flex

ORACLE
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Database Item Name

PER_ASG_REL_ADJUSTED_SVC_DATE.
PAYROLL_INTERFACE_ORIGINAL_DATE_OF_
HIRE
PER_ASG_REL_ORIGINAL_DATE_OF_HIRE

PER_PERSON_ENTERPRISE_HIRE_DATE

PER_PER_CONTACT_DEPEN_CHILD_COUNT

PER_PER_CONTACT_DEPEN_CHILD_COUNT_
LOC

PER_ASG_ASSIGNMENT_NUMBER
PER_ASG_ASSIGNMENT_ID
PER_ASG_EFFECTIVE_START_DATE
PER_ASG_JOB_ID
PER_ASG_JOB_NAME
PER_ASG_JOB_CODE
PER_JOB_FAMILY_ID
PER_JOB_FAMILY_NAME
PER_ASG_BUSINESS_UNIT_NAME
PER_ASG_LOCATION_ID
PER_ASG_DEPARTMENT_ID
PER_ASG_LEGAL_ENTITY_ID
PER_ASG_NORMAL_HOURS
PER_ASG_EMPLOYEE_CATEGORY
PER_ASG_EMPLOYMENT_CATEGORY
PER_ASG_ORG_LEGAL_EMPLOYER_NAME
PER_ASG_DF

PER_GRADES_DF
PER_ASG_GRADE_CODE
PER_ASG_GRADE_ID
PER_ASG_GRADE_LADDER_PGM_ID
PER_GRADE_STEP_NAME

PER_LOCATIONS_DF

Comments

Returns seniority date in a legal employer
(relationship seniority date).

Returns first original date of hire regardless of
legal employer.

Returns relationship original date of hire.

Returns earliest relationship start date, which is
the first hire date regardless of legal employer.

Descriptive flexfield.

Descriptive flexfield.

Descriptive flexfield.
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Attribute Name Database Item Name Comments
Grade PER_ASG_GRADE_NAME
Salary Basis CMP_ASSIGNMENT_SALARY_BASIS_NAME Works in only flows that have both employment
and salary sections included. Won't work in the
Action PER_ASG_ACTION_CODE standalone Change Salary flow
Reason PER_ASG_ACTION_REASON_CODE

Important Value by Criteria Settings for Rate
Components in Salary Bases

Here are some important naming conventions and selections to follow when creating value by criteria definitions to use
in salary bases with rate components.

- Avalue definition is required to create a Value by Criteria definition, but rates-based salaries ignore the value
definition. You can select any existing value definition or create your own.

- The Criteria and Value names need to be unique for the selected legislative data group.

- To return an amount, in the Unit of Measure field, select Money. Also select the relevant Periodicity and
Currency values.

- Toreturn a factor, in the Unit of Measure field, select Number.

Related Topics
» Overview of Values Defined by Criteria

Run Salary Processes

Salaries can change because of changes to the salary structure or worker attributes. Use the Run Salary Processes and
Review Proposed Salary Changes and Rate Values tasks to handle these changes.

Tip: The Run Salary Processes process doesn’t affect candidates and pending worker salaries.

When you submit the Run Salary Processes process, you specify whether to create salaries or correct salary records, by
recalculating rate values. You use population filters to identify the workers and salary assignments the process should
check. Use the run type to specify whether to commit the new or corrected salaries to the CMP salary, CMP rate values,
and PAY EE tables. Or you can specify to wait for review.

When it runs, the process calculates what the rate values will be on the effective date and compares the results with
CMP table values to identify salary changes. It creates salary proposals and details. For example, the process identifies
whether the proposal is for a new salary or a correction and includes the salary amount, rate values, action, and reason.
If you specified to wait for review, you review the Run Rates-based Process results using the Review Proposed Salary
Changes and Rate Values task.
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For example, the salary for a group of workers has two components. One component is a user-entered annual base
amount, the other is a derived rate that's 50% of the annual base for people working at headquarters. Changes

to compensation policy for this group require changes to the relevant salary basis rate component. Workers at
headquarters need to get a derived rate that's 60% of the annual base. Here's how you'd configure the processed
depending on whether you want to change or correct salary.

Parameter Change Correct

Process Mode Create another salary by recalculating rate Correct salary by recalculating rate values
values

Effective Date January 1of next year Start date of the salary basis

Run Type Calculate salary values and wait for review Calculate salary values and wait for review

Population Filter Select the relevant salary basis Select the relevant salary basis

Here's a flow diagram of Run Salary Processes.

Show results and 3 Review and

Rates engine messages, and allow for ¢ identify data to

updates commit

Call  Values Review run
Identif Compare Create proposed salaries Commit to:
T a!;’wd Calculate rate results with and details, such as if 1. CMP salary
3 value on CMP tables y new or correction, salary | ; 2. CMP rate
ass?arl?'u?énts effective date — and identify amount, rate values, Commit values

g changes action, and reason salary 3. PAY EE tables

The Run Salary Processes and Review Proposed Salary Changes and Rate Values tasks are available on the My Client
Groups > Compensation page.

Improve Performance

By default, the Run Salary Processes process has 3 threads with chunk sizes of 20. You can increase the total threads
and check performance until you reach the best total for your volume.

1. Go to My Client Groups > Compensation > Configure Compensation Batch Parameters.
2. Change the Run Salary Processes total threads count.
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3. Save your changes and close the page.

4. Test performance.

5. Repeat until you reach the best performance for your volume.

Mapping process.

Chapter 15
Rates-Based Component Itemization of Salary

Note: Changes to the total threads for this parameter also affect the Generate Compensation Zone and Address

Considerations for Using Salary Bases with Simple

Components versus Rate Components

When you configure salary bases, you can use simple or rate components to itemize salary adjustments.

The simple components that you can configure come from lookups and their values can be either an amount or a
percentage. The rate components come from rate definitions and can be element, derived, grade rate, or value by

criteria rates.

Consider these key differences when selecting the salary basis type.

Criteria

Level of configuration effort

Supported requirement
complexity

Component creation

Component types

Element entry creation for salary

Correct or update existing
salaries when component
calculation logic changes

Post salary change proposals
automatically

ORACLE

Simple Components

Simple

Simple to medium

ORA_CMP_SIMPLE_SALARY_COMPS lookup type that shows
on salary bases in component drop-down lists

User entered amount

User entered percentage

Fixed amount

Fixed percentage

Progression grade ladder based

Overall salary

Element created for the overall salary component, with the
provided value

No

Rate Components

Medium to complex

Medium to complex

Rate definitions that show on salary bases in
component drop-down lists

Element amount rate

Element factor rate

Value defined by criteria rate

Derived rate

Grade rate

Retained pay

Element created for the overall salary rate
Value isn't stored for the element created for

the overall salary

Yes, use the Run Salary Processes process

Yes, use the Run Salary Processes process
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Criteria

Wait for salary change proposal
reviews before posting

Enter or fix components

Values can be amount or
percentage

Calculated value can be
overridden

Default component

Default component using logic
Calculate component value
based on other attributes, such

as grade or location

Include components that don't
affect overall salary

Component calculations can
include other component values

Define valid component value
ranges

Components can be optional
Accept overall salary and
distribute that into other
components

(India basket of allowance sort of
requirements)

FTE won't affect the component

value

Define rounding rules per
component

Define decimal display per
component

Vary currency or frequency per
component

Where frequency is configured
Can make date-effective
changes to components

Can add or remove components
for a salary basis that's in use

ORACLE
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Simple Components

No

Yes

Yes

No

No

No, you can default only a fixed value

No

Yes

Limited

No

Yes, you can carry forward an optional component for all later

changes or applicable for just the single proposal

No

No

No, only at the salary-basis level

No, only at the salary-basis level

No

Salary basis

No

Not recommended

Rate Components

Yes, use the Run Salary Processes process

Yes

Yes

No

No

Yes, using value by criteria or another rate
definition

Yes, see Database Items That Can Detect
Proposed Info in Salary Value by Criteria Rate
Definitions

Yes, you still need to add these rates to the
overall salary rate definition and deduct them
Yes

Yes

No

Yes

Configurable

Yes

Yes

Yes

Overall salary rate definition using a custom
periodicity fast formula

Yes, but not recommended

Not recommended
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Criteria Simple Components Rate Components
Can use in offers and workforce = Yes Yes

compensation

Grade step progression Yes No
processes can change salary

Database items for use in Yes, ORA_CMP_ASSIGNMENT_SALARY_SIMPLE_ Yes, ORA_CMP_ASSIGNMENT_SALARY_
other HCM products, including =~ COMPONENT_UE and ORA_CMP_ASSIGNMENT_SALARY_ RATES_UE and ORA_CMP_ASSIGNMENT_
Global Payroll and Workforce SIMPLE_COMPONENT_RGE_UE SALARY_RATES_RGE_UE

Compensation. You can also
use them in HCM extracts for
external interfaces

Database view CMP_ASG_SALARY_SIMPLE_CMPTS_V CMP_ASG_SALARY_RATE_COMPTS_V

Supports REST, HCM Data Yes Yes
Loader, and HCM Spreadsheet
Data Loader

Limitations Lookup tags aren't considered; all components configured for = See the limitations section, for example, a
the salary basis show when proposing salary rates-based salary needs to have all future
salary bases also be rates-based

Can use the Salary History Yes No
action
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16 Rate Component Attributes for Salary
Bases

Base Rate Attribute for Salary Basis Rate Components

Select the Base Rate rate component attribute if other rates in the salary basis base their calculations on this rate.

For example, your day shift and night shift workers have different base pay rates. You provide each set of workers
different allowances, which are a percentage of the base rate.

1. You create two salary bases, one for night shift and one for day shift, and add the appropriate base rates to
each salary basis.

2. You add the same allowance rate to each salary basis. The allowance rate will use the base rate in it's salary
basis to calculate the allowance amount.

You can add a base rate contributor without needing to explicitly identify the contributing rate. This flexibility lets
you define multiple base rates for different worker groups and a subset of other rates that use the base rate in their
calculations.

Overall Salary Attribute for Salary Basis Rate
Components

Select the Overall Salary rate component attribute if the rate represents an overall salary rate to use in the salary basis.
The overall salary is calculated by summing and subtracting other rates included in the salary basis.

Rates-based salary bases need to have an overall salary rate to get certain salary basis attributes. For example, the
periodicity of the overall salary rate sets the salary basis frequency. The overall salary rate also calculates the overall
salary amount used in the Change Salary task.

Periodicity Attribute for Salary Basis Rate Components

You need to specify a periodicity, such as Hourly or Weekly, for the returned rate and each rate contributor used in
salary basis rate components. The overall salary rate definition periodicity is the rate component frequency for the
salary basis.

Derived rate calculations use the periodicity of the rate contributors to appropriately convert contributor values and
derive the rate value when not all periodicities are the same. Typically, the derived rate and associated rate contributors
all have the same periodicity--and frequency.
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Default Value Attribute for Salary Basis Rate Components

You can default values for element rates by specifying a specific value or selecting a value by criteria definition. When
you select a value by criteria definition, the definition needs to return a number.

FTE Attribute for Salary Basis Rate Components

You can have a rate definition consider the full-time equivalent when calculating the value by selecting the FTE option.

We recommend that you don't select this option because salary ranges, compa-ratio, and other salary metrics are
already adjusted for FTE. Adjusting individual rates for FTE might result in inaccurate salary values.

Factor Attribute for Salary Basis Rate Components

You can set a factor in the rate definition. When you use a factor, the rate amount is calculated by multiplying the rate
contributor or the rate value by the factor.

For example, one rate definition for a salary basis is a monthly Variable Incentive that's 1% of the Annual Base rate
definition. So the factor of the incentive rate definition is .01.

Periodicity Conversion Formula Attribute for Salary Basis
Rate Components

You can control the annualization factor by specifying a periodicity conversion fast formula.

Here's what to do if you need an annualization factor not available in the delivered formula:

1. Create a formula by copying the text from a delivered conversion formula.
2. In the copy, make the input and output parameter names the same.
3. Save, compile, and use the copy fast formula in the rate definition.

Note: The Hourly rate periodicity differs from the Work Hour compensation annualization factor. The Hourly
periodicity is 2920 while the Work Hour annualization factor is 2080.
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17 Example Rate Definition Configurations for
a Salary Basis

Overview of Example Rate Definitions for a Salary Basis

The topics in this chapter show you examples of how to set up five different types of rate definitions for a salary basis.

The definitions will be for a base salary, an allowance, a short-term incentive plan, a grade-based performance award,
and an overall salary. Users will enter values for the base salary and short-term incentive plan rate components. The
values for the other three rate components are calculated and can't be overridden.

Create a Base Salary Rate Definition

Users enter the base salary rate value while allocating salary. The rate contributes to the overall salary rate (also known
as total target compensation) and is used to calculate the short-term incentive plan amount.

1. Create the payroll element, US Base Salary in this example, using the Standard Earnings template, the Flat amount
calculation rule, and an Annually periodicity. We recommend that you configure the element eligibility as open. For
more details about creating compensation payroll elements, see Create a Payroll Element to Use with Salary Bases.

2. Go to My Client Groups > Compensation > Rates Definition.
Create a rate definition.
4. On the Create Rate Definition dialog box, complete the required fields, as shown by these example values:

W

Field Value
Category Element
Effective Start Date 1/1/00
Legislative Data Group field US LDG
Storage Type Amount

The calculation rate contributor is automatically defined for this storage type.

Element US Base Salary

o Link a payroll element to only one rate. Linking the element to multiple rates can cause issues,
such as when a worker moves to another salary basis.

o The element name becomes the default rate definition name and short name, which you can
overwrite as appropriate.

5. Click OK.
6. On the Create Rate Definition page, in the Basic Details section, select the Base Rate checkbox.
7. In the Returned Rate Details section, confirm that the Periodicity value is Annually.
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8. Click the Override and Defaulting Rules tab.
9. Select the Override Allowed checkbox so that people allocating salary can enter an amount.
10.Click Submit.

Related Topics
» Element Rate Components in a Salary Basis

Create an Allowance Rate Definition for a Salary Basis

Users enter the allowance rate value while allocating salary. The rate contributes to the overall salary rate (also know as
total target compensation).

1. Create the payroll element, US Allowance in this example, using the Standard Earnings template, the Flat amount
calculation rule, and a Calendar Month periodicity. We recommend that you configure the element eligibility as open.
For more details about creating compensation payroll elements, see Create a Payroll Element to Use with Salary
Bases.

2. Go to My Client Groups > Compensation > Rates Definition.
Create a rate definition.
4. On the Create Rate Definition dialog box, complete the fields, as shown by these example values:

W

Field Value
Category Element
Effective Start Date 1/1/00
Legislative Data Group field US LDG
Storage Type Amount

The calculation rate contributor is automatically defined for this storage type.

Element US Allowance

o Link a payroll element to only one rate. Linking the element to multiple rates can cause issues,
such as when a worker moves to another salary basis.

o The element name becomes the default rate definition name and short name, which you can
overwrite as appropriate.

5. Click OK.

6. On the Create Rate Definition page, in the Returned Rate Details section, confirm that the Periodicity value is
Calendar Month.

7. Click the Override and Defaulting Rules tab.
8. Select the Override Allowed check box so that people allocating salary can enter an amount.
9. Click Submit.
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Create a Short-Term Incentive Plan Rate Definition for a
Salary Basis

Users enter the short-term incentive plan rate percentage value while allocating salary. It's stored in an element entry
and the corresponding amount is calculated immediately. The plan rate contributes to the overall salary rate, also known
as total target compensation.

1. Create the US STIP payroll element using the Standard Earnings template, the Factor calculation rule, and an
Annually periodicity. We recommend that you configure the element eligibility as open. For more details about
creating compensation payroll elements, see Create a Payroll Element to Use with Salary Bases.

2. Go to My Client Groups > Compensation > Rates Definition.
Create a rate definition.
4. On the Create Rate Definition dialog box, complete the required fields as shown here:

W

Field Value
Category Element
Effective Start Date 1/1/00
Legislative Data Group field US LDG
Storage Type Factor

You'll need to define the calculation rate contributor for this storage type.

Element US Short-Term Incentive Plan

o Link a payroll element to only one rate. Linking the element to multiple rates can cause issues,
such as when a worker moves to another salary basis.

o The element name becomes the default rate definition name and short name, which you can
overwrite as appropriate.

5. Click OK.

6. On the Create Rate Definition page, in the Returned Rate Details section, confirm that the Periodicity value is
Annually.

7. Inthe Calculation Details section, click the Add icon.

8. On the Create Rate Contributor dialog box, select Base Rate.

9. On the Create Rate Contributor page, in the Periodicity field, select Annually.

10.Click Save and Continue.

11. Click the Override and Defaulting Rules tab.

12. Select the Override Allowed checkbox so that people allocating salary can enter an amount.
13. Click Submit.
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Create a Grade-Based Value by Criteria Definition for a
Salary Basis Rate Definition

The grade-based performance award rate value identifies hourly workers with a grade of M1, M2, or M3 using value by
criteria conditions.

1. Go to My Client Groups > Compensation > Values Defined by Criteria.
2. Create the Hourly Staff Performance Award value definition.
a. On the Criteria and Values toolbar, click the Create icon.
b. On the Create Values Defined by Criteria dialog box, complete the fields, as shown by these example values.

Field Value

Name Grade-Based Performance Award

Effective Start Date 1/1/00

Legislative Data Group US LDG

Use existing range group Select

Value Definition Group Any value, such as Workers Compensation
c. Click OK.

3. On the Create Values Defined by Criteria: Grade-Based Performance Award page, configure the value definition
criteria.

a. Select the Grade-Based Performance Award row.

b. On the toolbar, click the New icon.
c. On the Create Calculation Value Definition dialog box, select Criteria.
d. Click OK.
e. On the Create Criteria dialog box, complete the fields, as shown by these example values.
Field Value
Calculation Value Definition Name Pay Frequency
Value Definition Group Any value, such as Performance Award
Retrieval Date Effective Date
Sequence 1
Database Item Name PER_ASG_HOURLY_SALARIED_CODE
Display Name Pay Frequency
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4. On the Create Values Defined by Criteria: Grade-Based Performance Award page, create the M1, M2, and M3 criteria

Field
Operand
Literal Value
f. Click OK.
definitions.
a.

-0 2 n O

In the Criteria and Values table, expand the Grade-Based Performance Award row.

Select the Pay Frequency = H row.
On the toolbar, click the New icon.
On the Create Calculation Value Definition dialog box, select Criteria.

Click OK.

On the Create Criteria dialog box, complete the fields, as shown by these example values.

Field

Calculation Value Definition
Name

Value Definition Group

Retrieval Date
Sequence

Database Item Name
Display Name
Operand

Literal Value

M1

Grade = M1
Any value, such as
Performance Award

Effective Date

PER_ASG_GRADE_NAME

Grade

M1

M2

Grade = M2
Any value, such as
Performance Award

Effective Date

PER_ASG_GRADE_NAME

Grade

M1

M3

Grade = M3
Any value, such as
Performance Award

Effective Date

PER_ASG_GRADE_NAME

Grade

M1

g. Click OK. Repeat these steps twice, to add the M2 and M3 calculation value criteria.
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5. On the Create Values Defined by Criteria: Grade-Based Performance Award page, create the M1, M2, and M3 value

definitions.

a. Inthe Criteria and Values table, expand the Grade-Based Performance Award row.

b. Select the Grade = M1, M2, or M3 row.

c. On the toolbar, click the New icon.

d. On the Create Calculation Value Definition dialog box, select Value.

e. Click OK.

f. Onthe Create Value dialog box, complete the fields, as shown by these example values.
Field Value M2 M3
Calculation Value Definition M1 M2 M3
Name
Value Definition Group Any value, such as Workers Any value, such as Workers Any value, such as Workers

Compensation Compensation Compensation

Retrieval Date Effective Date Effective Date Effective Date
Calculation Type Flat Amount Flat Amount Flat Amount
Periodicity Annually Annually Annually
Unit of Measure Money Money Money
Currency UsD uUsD uUsD
Flat Amount 700 750 800

g. Click OK. Repeat these steps twice, to add the M2 and M3 calculation value definitions.

6. On the Create Values Defined by Criteria: Grade-Based Performance Award page, create the default criteria.

a. Select the Grade-Based Performance Award row.

b. On the toolbar, click the New icon.

c. On the Create Calculation Value Definition dialog box, select Criteria.

d. Click OK.

e. On the Create Criteria dialog box, complete the fields, as shown by these example values.
Field Value
Calculation Value Definition Name Default Condition
Value Definition Group Any value, such as Workers Compensation
Retrieval Date Effective Date
Default Criteria Select

f. Click OK.

7. On the Create Values Defined by Criteria: Grade-Based Performance Award page, review your value definition.
8. When you're ready, click Submit.
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9. Click Done.

Create a Grade-Based Performance Award Rate
Definition for a Salary Basis

The grade-based performance award rate value identifies hourly workers with the M1, M2, or M3 grades using value by
criteria conditions.

1. Create the values defined by criteria definition, Grade-Based Performance Award in this example.
2. Go to My Client Groups > Compensation > Rates Definition.
3. On the Rate Definitions page, click the Create icon.
4. On the Create Rate Definition dialog box, complete the required fields, as shown by these example values:
Field Value
Category Value by Criteria
Effective Start Date 1/1/00
Legislative Data Group field US LDG
5. Click OK.

6. On the Create Rate Definition page, enter a short name, such as Grade Perf Award Hrly.

7. In the Value by Criteria Name field, search for and select the value definition, such as Grade-Based Performance
Award.

8. Select the Reporting Required option, if it's not already selected.

9. Click Submit.

Create an Overall Salary Rate Definition for a Salary Basis

The overall salary rate definition is derived from other rate definitions. In this example, the overall salary is derived from
the base salary, allowance, short-term incentive, and performance award rate definitions.

1. Create the payroll element, US Overall Salary in this example, using the Standard Earnings template, the Flat amount
calculation rule, and an Annually periodicity.

On the Element Summary: US Overall Salary page, in the Standard Rates section, make sure that the Process in
payroll run option isn't selected. Or, you can make sure that Process in payroll run isn't selected for the elements
of any rate contributors, and is selected for the overall salary element. We also recommend that you configure the
element eligibility as open.
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o Base salary

o Allowance

o Short-term incentive

o Performance award
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3. Go to My Client Groups > Compensation > Rates Definition.
4. On the Rate Definitions page, click the Create icon.
5. On the Create Rate Definition dialog box, complete the required fields, as shown by these example values:

Field

Category
Effective Start Date

Legislative Data Group field

6. Click OK.

Value

Derived Rate
1/1/00

US LDG

7. On the Create Rate Definition page, complete the basic fields, as shown by these example values:

Field

Name
Short Name

Element Name

Overall Salary

Reporting Required

Value

Overall Salary

OVERALL SALARY

US Overall Salary

You need to associate a payroll element with this rate to store the amount in an element entry.
Select

This amount appears on pages and in work flows containing salary information, and it's used to

calculate salary metrics, such as compa-ratio.

Select

8. In the Rate Contributors section, added the base salary rate definition.

e ngoo

ORACLE

On the toolbar, click the Create icon.

On the Create Rate Contributor dialog box, in the Contributor Type field, select Base Rate.

On the Create Rate Contributor page, in the Employment Level field, select Payroll Assignment.
Click Save and Continue.
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9. In the Rate Contributors section, add the allowance, short-term incentive, and performance award rate definitions.
On the toolbar, click the Create icon.

On the Create Rate Contributor dialog box, in the Contributor Type field, select Rate Definition.

On the Create Rate Contributor page, in the Rate Name field, select the appropriate rate definition.
Confirm that the periodicity is correct.

Click Save and Continue.

Repeat these steps until you've added all the rate definitions contributing to the overall salary.

-0 9 n T

Create a Rates-Based Salary Basis

Create a salary basis with base salary, allowance, short-term incentive plan, grade-based performance award, and
overall salary rate components. Users will enter values for the base salary and short-term components. The other
component values are calculated and can't be overridden.

Go to My Client Groups > Compensation > Salary Basis.

On the Salary Basis page, click the Create icon.

On the Create Salary Basis page, enter a name, such as US Rates-Based Salary.
In the Salary Basis Type field, select Salary amount is determined by rates.

In the Rates section, add the rate definitions, as shown by these example values:

A WN B

Rate Definition Name Category

US Base Salary Element

US Allowance Element

US Short-Term Incentive Plan Element
Grade-Based Performance Award Value by Criteria
Overall Salary Derived Rate

6. Click Validate.

7. Fix any validation issues and validate again until validation completes successfully.
8. Click Save and Close.
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18 Rates-Based Salaries

Dos and Don’ts for Assigning and Changing Rates-Based
Salary

After you assign workers a rates-based salary basis, you shouldn't make intrusive changes to the rate definitions
or component configurations. Instead, create other definitions or salary bases with the new rate component
configurations.

Examples of intrusive changes:
- Adding or removing rates from the salary basis
- End dating rate definitions
- Adding, removing, or changing contributing rates
Here’s the best practice method for handling changes to rates-based worker salaries:

1. Create other rate definitions or another salary basis with the new rate components configuration.
2. Assign the new salary basis to workers effective as of the change date.
3. Inactivate the old salary basis, so that it's no longer used.

Considerations When Using Rates-Based Salary

Consider dates used in salary calculations, inserting retroactive salaries, handling employment terminations, and
changing the salary basis type. Also consider salary copy during mass change of legal employer and what corrections
and updates you can make using HCM Data Loader.

Consideration Comments

Date used in salary calculations for offer The calculations use the assignment effective start date, which changes depending on if the proposed
and pending worker flows start date is in the future or the past.

- Future: The assignment effective start date is the same as the offer creation date.

- Past: The assignment effective start date is the same as the proposed start date.

Inserting retroactive salary Use the Change Salary task in the compensation app to insert the retroactive rates-based salary
between existing rates-based salary.

You can’t use HCM Data Loader.
Handling employment termination Terminating a worker’s employment end dates the corresponding element entries based on their
termination rule. Their salary doesn’t get end dated, but rate values no longer get calculated. So, you

need to manually end date the salary.

Changing to another salary basis type Delete all the rates-based salaries for the assignment. Then you can create another salary for the
worker that’s user determined, uses incremental components, or uses standard components.
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Consideration

Copying salary during mass change legal
employer

Salary corrections and updates using HCM
Data Loader

New work relationship created as part of
a global transfer for a source assignment
that uses a rates-based salary type

Sharing rate definitions among salary
bases
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Comments

CAUTION: These kinds of deletions can create cascading effects on payroll or other downstream
processing, so be careful making these kinds of changes.

It's a best practice to use rates-based salary for all employees in the legislative data group or legal
employer. This way migrating from rates-based salary to another type is no longer necessary.

Rates-based salary can include element rates, which the salary process can copy to the destination
employer. The payroll process also copies element entries. This dual copy can lead to errors when
creating the destination salary.

To prevent errors, you can define an element group to exclude rate elements when submitting the
mass change process. This ensures that the salary copy process copies the element entries, but not the
payroll process.

After a worker has a rates-based salary basis, you can’t correct their salary with another salary basis.
You need to delete the rates-based salary and create another salary using the new salary basis.

I Note: You can delete only the most recent salary.

When you update salary with another rates-based salary basis, the element entries belonging to the
primary rates of the old salary basis aren’t end dated. You need to use HCM Data Loader and the
Element Entry object to update the end date of the affected element entries.

The rates-based salary of the source assignment gets end dated 1 day before the effective date of
the new relationship. If you cancel the new relationship, the end date for the source assignment isn't
automatically removed. You need to remove it manually.

There can be issues with worker salaries when they're shifted between salary bases that share rate
definitions.
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19 salary Basis FAQs

Can | change or delete a salary basis that's in use?

You can't delete or change any characteristic after you associate the salary basis with anyone.

Can | add effective-dated changes to the salary basis?

You can't because the salary basis isn't an effective-dated object.

Where does the annualization factor for a salary basis
that uses payroll period frequency come from?

The period type on the payroll linked to a person's assignment decides the number of payroll periods in a year. These
payroll periods are the annualization factor.

Can | use the same payroll element for multiple salary
bases?

Yes, if it's a recurring element that you classify as an earnings element and configure to enable multiple entries in the
same period.

Related Topics

Can | update an element mapped to a salary basis that's
in use?

Yes, but only the next salary change recognizes the updated element or input value. At that time, salary processing end
dates the element entry associated with the prior salary.

When you update the element mapping, no changes apply to the person's data.
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Can managers change the salary basis of a salary
record?

Yes. You can hide or show the edit capability for managers using personalization on the pages where managers enter
salary allocations.
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20 Salary Ranges and Metrics

How You Validate Salary Changes with the Grade Range

You can verify that salary changes fall within the appropriate range for each person using grade range validation.

This validation generates a warning message when someone enters a new or adjusted salary that's outside the person's
assignment grade range. The person can ignore the message or revise the salary to fall within the valid range.

The assignment grade in the grade rate attached to the salary basis defines the minimum and maximum grade range
values. You can adjust the base ranges by linking a differential profile to the salary basis. Differentials apply according to
one of these criteria:

Location
Business unit
Location and business unit
. Compensation zone
- Compensation zone and business unit

You can also associate grade rate differentials that override the grade rate, and thus the grades and grade ranges,
associated with the salary basis. The grade rate from the differential profile needs to have corresponding grades for all
the grades of the grade rate linked to the salary basis.

Related Topics
« Overview of Salary Range Differentials

« Grade Rates

Salary Range Violation Behavior for Proposed Salaries

Specify how to handle salary range violation for various compensation actions, such as Change Salary and Salary
History. This handling also applies to Offer and HR actions that include the Salary section, such as Offer, Hire, Promote,
and Transfer.

You configure violation behavior using the Salary Range Violation Behavior field of the salary basis. You can let people
propose salaries that violate the salary range with or without a warning. Or, you can prevent people from proposing any
salaries that violate the salary range. For example, you warn people when their proposed salaries are below or over the
specified salary range. Or, you don't let anyone propose salaries that are below or over the specified salary range.

The default value for the Salary Range Violation Behavior field of all existing salary bases is Warn. We don't recommend
that you change it to Error for existing salary bases because you can get errors with historic data. For example, you've
an existing salary basis with a salary range of 100 to 200 USD. The salary basis is associated with a 2010 salary record
where the salary amount was 95 USD. It's also associated with a 2015 salary record where the salary amount was 105
USD. When you change the violation behavior to Error and try to load salary for 2020, you can get the violation error for
2010. The error occurs even though that's not the record you're correcting. To set the violation behavior to Error, then
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we recommend that you create another salary basis to use with new salaries. This way, you can avoid issues with historic
data.

When you set the violation behavior to Warn, you don't see the warning message when you load salaries using
these tools: REST API, HCM Data Loader, and HCM Spreadsheet Data Loader. These tools show you only errors. The
Download Salaries task and grate step progression processes ignore this violation behavior.

Related Topics
» Overview of Base Pay Configuration

» How You Validate Salary Changes with the Grade Range
» Overview of Salary Range Differentials
- How Salary Metrics Change According to the Grade Rate and Salary Range Differentials

How Salary Metrics Are Calculated

Salary amount has a date while full-time equivalent (FTE), grade, grade rate, and differential profile have effective dates.
Thus, a salary record can apply logic for multiple combinations of FTE, grade, grade rate, and differential to different
time periods.

So, how are salary metrics, such as compa-ratio, range minimum, and range maximum, calculated? The metric
calculations use a reference date. Here's how we decide that date:

If the salary record has an end date that's earlier than the current date, then use the salary end date.
If the start date of the salary record is in future, then use the salary start date.

If the salary record started in the past and doesn't have an end date, then use the current device date.

Related Topics
» How Salary Metrics Change According to the Grade Rate and Salary Range Differentials
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21 Salary Range Differentials

Overview of Salary Range Differentials

You can configure salary range differentials to adjust base salary ranges from the grade rate associated with the salary
basis. Differentials vary, for example, to reflect the cost of living in different locations or the relative ease of hiring.

For example, salaries for workers in the Central US are in the base range of the grade rate. Salaries for workers in the
South are in a discounted range with a 0.9 factor, and for workers on the East and West Coasts, they’re in a premium
range with a 1.1 factor. Salaries in New York City, Los Angeles, and San Francisco are in a super premium range with a
factor of 1.2.

Salary Ranges Across Geographies for the Same Grade
350

300 120
250 100
200 80
90
150 75
60
100
0
50 50U
25 30
0
Min Mid Max
—Discounted Range —Base Range Premium Range Super Premium Range

Select the level of granularity that best supports your salary policies and processes:

Location

Business unit

Location and business unit
- Compensation zone

- Compensation zone and business unit

145
ORACLE



Oracle Fusion Cloud Human Resources Chapter 21
Implementing Compensation Salary Range Differentials

When using a Grade Rate type differential profile, you can configure an overriding grade rate to use instead of the salary
basis grade rate. The adjusted salary range is the range of the overriding grade rate.

When using a Factor type differential profile, you can configure the differentials to enforce relevant statutory limits
around minimum salaries by setting lower limits.

You can also configure compensation zone, and compensation zone and business unit differentials to account for
nonoffice workers. Do this by specifying which address types to use, and in what order, to identify the applicable
differential. For example, you're going to associate the differentials with people who work at client sites and from home.
And, you want to use their remote addresses, rather than their work addresses to identify their compensation zones and
differential factors. You want to identify the client site address first and the home address only if there isn't a client site
address.

Related Topics
- How Salary Metrics Are Calculated

« How Salary Metrics Change According to the Grade Rate and Salary Range Differentials

Configure Salary Range Differentials

You can adjust base salary ranges from the grade rate associated with the salary basis using salary range differentials.

Go to My Client Groups > Compensation > Salary Range Differentials.

On the Salary Range Differentials page, click the Create icon.

On the Create Salary Range Differential page, in the Properties section, complete the required fields.
. Select the criteria, such as Location or Compensation Zone.

Select the type.

In the Differentials section, configure the differentials. When your criteria is compensation zone based, you can
select the Factor or Grade Rate type.

o To configure the differential to apply factors to the existing grade rates, select Factor.

oUv A UN S

o To configure the differential to apply alternate grade rates in place of the grade grate associated with the
salary basis, select Grade Rate.

7. Optionally, for differentials that use compensation zone criteria, enable checking for the remote worker address
type. Specify up to three address types to check in the order that differential processing should consider them. The
process stops checking as soon as it finds an address, whether that address is in the first address type or the last.

8. Save and close the differential.

Related Topics
» Overview of Salary Range Differentials

« Configure Compensation Zone Types and Zones
- How Salary Metrics Change According to the Grade Rate and Salary Range Differentials
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Basic Process to Configure and Apply Zone-Based Salary
Range Differentials

You need to complete these tasks to set up and use compensation zones in salary range differentials. These types of
differential profiles work with only responsive salary pages and flows. Classic pages and flows ignore them.

1. Create compensation zone types by going to Setup and Maintenance > Compensation > Base Pay >
Compensation Zones.

You use compensation zone types, such as compensation or wage regions, to categorize zones and group them
together. You need to create your zone types before you define one or more zones for a geographical boundary.
You can create a zone type that contains geographical boundaries from anywhere in the world, or that contains only
geographies in a specified country. When you create a zone type for a country, you can define which geography
types or geographies you can select when you create the zones.

2. Create compensation zones by going to Compensation Zones.

Compensation zones are geographical boundaries for a zone type, for example, the San Jose compensation zone.
Zones are based on the geography hierarchy data of the master reference. You create zones in a zone type and

you can associate geographies to define the zone. For example, you've the Compensation Regions zone type. You
create a West Coast zone that has the state of California as one of its geographies. In a geography, you can specify a
postal range. So for the state of California, for example, you can specify that the zone spans the postal codes 90001
through 90011.

Compensation zones are intelligent enough to apply salary range differentials based on the worker’s assignment or
nonassignment location. For example, they can apply the differential to the work location or a remote location, such
as a client location or home address. The salary range differential identifies the compensation zone that the address
is part of, and applies the factor or overriding grade rate defined for that zone.

Optionally load compensation zone geographies using only the Export to CSV File and Import from CSV File actions
for the Compensation Zones task.

3. Create zone-based salary range differentials by going to My Client Groups > Compensation > Salary Range
Differentials. You can also create them using HCM Data Loader or HCM Spreadsheet Data Loader. You configure
salary range differential details at the level of granularity that best supports your salary policies and processes. For
example, you can maintain differential factors at the location level, or at the State or District level. Add compensation
zone criteria and define the differentials for each zone type and zone.

Optionally set minimum limits when you've statutory minimum salary limits that you need to enforce. You can also
enable work from home processing for people working remotely, such as at client sites or from home.

4. Create salary bases by going to My Client Groups > Compensation > Salary Basis. On the Salary Ranges tab, add a
grade rate to the salary basis. Then add the appropriate zone-based differential profile.

Related Topics
- Configure Compensation Zone Types and Zones

« Overview of Base Pay Configuration
« Configure Salary Range Differentials
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Zone-Based Salary Range Differential Processing

Differential processing identifies the minimum, midpoint, and maximum points of the salary range using the
assignment grade and the grade rate of the salary basis. When the worker is working from home, it then decides if the
differential profile has work from home processing enabled.

If not enabled, it finds the work location to process. If there's no work location or a location isn’t included in the
differential profile, the salary basis grade rate is used in payroll processing. No differential is applied.

If enabled, it finds the person addresses to process.

Next differential processing finds the compensation zone type and zone for the identified address of work location or
person. And it applies the differential factor or overriding grade rate for the corresponding compensation zone type and
zone. It uses the differential factor or overriding grade rate to recalculate the minimum, midpoint, and maximum points
of the salary range.
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Work Location Example

Here's an example of this differential processing based on the work location for two workers in California. They both
have the same assignment grade and salary basis. Their locations put them in different compensation zones, so their
salary ranges and related salary metrics are thus different.

Assignment Info

Grade

Work Location

Salary Info

Salary Basis

Grade Name

Salary Range
Compensation Zone Type
Compensation Zone

Salary

Worker 1

ZMCPIC1

Bakersfield Branch Office

Individual Contributor
ZMCPIC1

50,000 - 100,000 USD annually
Individual Contributor CA
Bakersfield

61,000 USD annually

Worker 2

ZMCPIC1

Redwood Shores HQ

Individual Contributor

ZMCPIC1

150,000 - 300,000 USD annually
Individual Contributor CA
Headquarters

161,000 USD annually

Remote Work Example

Here’s how differential processing would change the salary range for Worker 2 if they were a remote worker. They live in
Modesto, CA, which is in the same compensation zone as Bakersfield.

Assignment Info

Work Location

Worker 2

Redwood Shores, CA

Home Address Modesto, CA
Grade ZMCP IC1
Working at Home? Yes

Salary Info

Salary Basis Individual Contributor

Grade Name ZMCPIC1

Salary Range 50,000 - 100,000 USD annually

Compensation Zone Type
Compensation Zone

Salary

ORACLE

Individual Contributor CA
Bakersfield

161,000 USD annually
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Factor Type Salary Range Differentials That Include
Lower Limits

You might have statutory limits for salaries that you need to enforce, such as salary minimums. You can enforce lower
limits in factor type salary range differentials associated with salary bases.

These differential processing flows compare the processing behavior when the differential has lower limits versus when
it doesn't. In this example differential profile, the Redwood Shores HQ zone has a lower limit of 160,000.

Compensation Zone Differential Factor Lower Limit Frequency of Minimum Amount Annualization Factor for Mir
Amount

Redwood Shores HQ 1.5 160,000 Annually 1

Bakersfield Branch Office 0.5 80,000 Annually 1

The base range of the salary basis that includes this differential profile is 100,000 to 200,000. Normally, the adjusted
ranges for the Redwood Shores HQ zone would be 150,000 to 300,000 after applying the 1.5 differential. But, this
differential has a lower limit of 160,000 and that minimum overrides the 150,000 minimum. So the effective salary
range becomes 160,000 to 300,000. If the differential profile didn’t have any lower limit, the adjusted base range would
remain 150,000 to 300,000.

Configure Compensation Zone Types and Zones

Here's how you configure the compensation zone types used to group zones together and the zones that make up a
zone type. Go to Setup and Maintenance > Compensation Management > Base Pay > Compensation Zones.

Create the Compensation Zone Type

We recommend limiting the number of compensation zone types, preferably to 1, such as by postal code. Here's how
you create a zone type:

On the Manage Zone Types page, click the Create icon.

Enter a name for the zone type.

Specify the boundary of the zone type.

Select the geography.

At the appropriate geographic level, such as Postal Code, select Zone Creation Allowed.

A WN

CAUTION: You need to make sure that geography validation is enabled for the No Styles Format address style of the
selected geography level. Otherwise you won't see the adjusted salary ranges for individuals in this compensation
zone. Use the Manage Geographies task and the Manage Geography Validation action.
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Create a Zone

Configure your zones so that an address is part of only one zone. If an address is part of multiple zones, the salary
changes that include zone-based differentials can't figure out which zone applies. Thus, they can't apply any differential.
Also, configure the zones for a zone type at the same level to minimize or prevent zone overlaps. For example, if Zone 1
is at the State level, then define the other zones at the State level also.

Here's how you create a zone:

1. Onthe Manage Zone Types page, search for and select your new zone type. If you click the zone type, you open
a read-only page with details of the zone type configuration. You can't add zones from that page.

Click Next.

On the Manage Zones for Zone Type page, click the Add icon.
On the Create Zone page, enter the general information.
Associate geographies with your new zone.

vih N

Click the Add icon.
On the Add Geography dialog box, search for and select the geography that you want to add.
Click Save and Close.

Review the start dates of the associated geographies. When you associated the geography, it
automatically set the start date to the system date at that time. You can edit the date, as needed.

e. When you finish associating geographies, on the Create Zone page, save and close your new zone.

6. When you finish adding zones to your zone type, on the Manage Zones for Zone Type page, save and close
your zone type.

angouow

Best Practices When Using Postal Codes
If you've fewer than 5 postal codes, add the codes directly in the zone definition instead of using postal ranges. For
example, add the 90009 postal code directly to the zone instead of adding it as the range, from 90009 to 90009.

Avoid defining overlapping geographies or postal code ranges across compensation zones. For example, you defined
these postal code ranges:

- Compensation Zone 1for CA with the range from 91000 to 91999
- Compensation Zone 2 for CA with the range from 91111 to 91729

In this case, the differential profile logic identifies both compensation zones for the 91112 postal code and thus won't
apply any differentials for 91112.

Tip: The postal code data type is CHAR, so the zone ranges get calculated as character ranges, not numeric. For
example, a zone with the postal range from 10 to 100 includes these postal codes: 11, 12, 13, and 14. It doesn't include
these postal codes: 20, 21, 30, 31, 40, 90, 99.

Related Topics
- Overview of Salary Range Differentials

- Configure Salary Range Differentials
« How Salary Metrics Change According to the Grade Rate and Salary Range Differentials

152
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=s20072818

Oracle Fusion Cloud Human Resources Chapter 21
Implementing Compensation Salary Range Differentials

Compensation Zone-Based Differential: Options for
When Work from Home Is Yes, But Evaluation Should
Use Work Locations

You can configure compensation zone-based salary range differentials to evaluate remote worker addresses and
calculate salary ranges. And you can specify the processing order for up to three address types.

You can configure compensation zone-based salary range differentials to evaluate remote worker addresses and
calculate salary ranges. And you can specify the processing order for up to three address types.

When using this kind of differential, can you use work locations to identify the applicable differential for certain remote
workers? For example, in some US states, remote workers have the option to go into an office. Or they need to goin1or
2 days a week. So for some states, even when Work from Home is Yes, you want the differential to use the work location.

Here are three configuration options that let you use people’s work locations to identify the applicable differentials, even
when Work from Home is Yes.

Separate Differentials and Salary Bases

In this approach, you can create two different differential profiles for the remote workers.

- One differential doesn’t process remote workers, thus evaluating only people’s work locations.

- Another differential does process remote workers and specifies to use home addresses.

Each set of remote workers needs to have a different salary basis, such as, US Remote by Work and US Remote by
Home.

Different Field to Record Actual Work from Home Status

In this approach, you can use a different assignment field or a descriptive flexfield to record the actual work from
home status. The value of this other field could typically be the same as the value of the delivered Work from Home
assignment field. But you can vary the value for people in the states where differential processing should use the work
location instead of remote addresses.

- Where differential processing should use remote workers’ home addresses, make sure that the Work from
Home assignment field is Yes.

- Where differential processing should use remote workers’ work locations, make sure that the Work from Home
assignment field is No.

Then you can create a differential that processes remote workers. Processing will evaluate the addresses as specified.

Person Addresses with Work Locations

In this approach, you extend the address type lookup to let you set up a work address as another person address. Next,
for the remote workers where differential processing should use their work location, you create the appropriate work
person addresses. Then you create a differential with remote worker processing enabled. Processing will evaluate the
specified address types in the specified order.
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For example, a remote worker has a home-type address in Jacksonville, FL, a work-type address in Orlando, FL. And
their Work from Home is Yes. Their differential has the Work address type as sequence 1and Home address type as
sequence 2, so differential processing uses their Orlando, FL address.

This approach means that every applicable remote worker will also have their work address maintained as one of their
person addresses. Whenever the work location changes, someone also needs to manually change the corresponding
person address.

Generate Compensation Zone and Address Mapping

For salary range differentials with compensation zone criteria, differential processing finds the zone and zone type each
time someone views and adjusts the salary amount.

The differential process does this by evaluating the person's maintained addresses against the defined compensation
zones. Depending on the number of zones, zone types, and address details, this evaluation can be time consuming.
To see the correct salary ranges in Oracle Fusion Cloud Workforce Compensation and Oracle Transactional Business
Intelligence reports, run the Generate Compensation Zone and Address Mapping process. Also run it to optimize
differential processing because it finds the compensation zone and zone type for each address, and stores them for
immediate reference.

You can run the generate process in two modes.

Run Mode Descriptions

Create incremental mappings Creates mappings between zones and zone types that match the specified parameters and person or
work location addresses when something changed or is new

Purge and recreate mappings Purges all existing mappings

Creates the maps again between the zones and zone types that match the specified parameters and all
person or work location addresses

Here's how we recommend that you schedule the process.

Schedule Mode Descriptions

One-time Run the mapping process to create all zone mappings for both work location and person addresses.
You might use this mode to create a baseline. You might also use it to update work location addresses
because they change infrequently.

Recurring Schedule the mapping process to run regularly to create incremental zone mappings. You might use
this mode to update person addresses for remote workers because they can change more often. For
example, client work locations change as the person moves changes projects.

The generated mappings improve the performance of responsive pages with salary information. The differential
process knows the person's compensation zone and can apply the relevant differential to salary range calculations.
Here's the high-level process flow.
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When the mapping isn't available, differential processing finds the zone and zone type for the person or work address. It
then applies the relevant differential.

Improve Performance

By default, the Generate Compensation Zone and Address Mapping process has 3 threads with chunk sizes of 20. You
can increase the total threads and check performance until you reach the best total for your volume.

Go to My Client Groups > Compensation > Configure Compensation Batch Parameters.
Change the Run Salary Processes total threads count.

Save your changes and close the page.

Test performance.

Repeat until you reach the best performance for your volume.

A UWN

Note: Changes to the total threads for this parameter also affect the Run Salary Processes process.

Related Topics
» Overview of Salary Range Differentials

« Configure Compensation Zone Types and Zones
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Enable Geography Validation for Compensation Zones

You need to make sure that geography validation is enabled for the No Styles Format address style of the selected
geography level.

1. Go to Setup and Maintenance > Tasks panel Search > Manage Geographies.

2. Search for a country. For example, you can search by entering the country name United States or the two letter ISO
code US.

3. In the Search Results area, select the country, such as United States.
4. Click Actions > Manage Geography Validation.

5. On the Manage Geography Validation page, you see the geography types that are available for the country in the
Geography Mapping and Validation section.

6. Make sure that the No Styles Format address style is selected. You define validation for this address style so that
the validations are run for all addresses in the country.

7. For the geography types to include in the geography validation, such as Postal Code, select Geography Validation.

Load Compensation Zone Geographies Using CSV File
Export and Import

After you create you compensation zone types and zones, you can load the corresponding zone geographies from a .csv
file.

Go to Setup and Maintenance > Compensation > Base Pay.
In the Show field, select All Tasks.
If you don't see the Actions column, on the toolbar select View > Columns > Actions.

. Generate a CSV export package for the Compensation Zones task by selecting Actions > Create New > Export to
CSV File.

a. Onthe Export Setup Data to CSV File page, enter a descriptive process name.
b. Click Submit.
5. Track the export process by selecting Actions > View All > Export to CSV File.

6. Download the export file from the Export Setup Data to CSV File History: Compensation Zones page, after the export
process completes. Select Actions > CSV File Package > Download.

7. Extract the contents from the .zip file to an appropriate folder.
8. Open the ORA_HZ_GEO_RELATIONSHIP.csv file.

A WN S
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9. Using the existing geography rows as reference, add the new geographies. For each new geography, you need to add

2 rows to the file. To avoid damaging the data, use a text editor, such as Notepad++, and not Microsoft Excel. Save

the file as you go and when you're done.

Also, the ORA_HZ_GEO_RELATIONSHIP.csv file has three start date columns. Here's the date you need to enter in

each column:

o StartDate: Enter the start date of the zone.
o SubjStartDate:

- If the 'SubjGeographyName' column is zone, enter the zone start date.
- If the 'SubjGeographyName' column is postal code, enter the postal code start date.
o ObjStartDate:

- If the 'ObjGeographyName' column is zone, enter the zone start date.
- If the 'ObjGeographyName' column is postal code, enter the postal code start date.
You can source the start and end dates by running these two queries:

SELECT SELECT

geography name, geography name,

country code, to_char(start _date, 'YYYY/MM/DD') start_date,
geography element2, to_char (end date, 'YYYY/MM/DD') end date,
geography element3, FROM

geography element4, fusion.hz_geogrpahies
to_char(start_date, 'YYYY/MM/ WHERE
DD') start date, geography name in ('_ZONE NAME')
to_char(end_date, 'YYYY/MM/DD')

end date,

FROM

fusion.hz_geogrpahies
WHERE

geography name in ('999999')

AND country code = 'US'

AND geography type = 'POSTAL
CODE'

AND geography use = 'MASTER

REF'

ORDER BY

Geography element2,

Geography element3,

Geography element4,

Geography_ name

10.Create a .zip file with all the extracted files and the updated ORA_HZ_GEO_RELATIONSHIP.csv file.

11. Import the .zip file for the Compensation Zones task by selecting Actions > Create New > Import from CSV File.

12. On the Import Setup Data from CSV File page, search for and select the new .zip file.
13. Click Submit.

14.Track the import process by selecting Actions > View All > Import from CSV File.
15. After the process completes, you're ready to verify the loaded geography data.

ORACLE
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22 Base Pay Lookups and Troubleshooting

Incremental Salary Component Lookups

HR specialists and line managers can use incremental salary components to itemize new or adjusted salary, to reflect
the different reasons for their allocations. Here are the incremental components bundled in the implementation:

- Adjustment: Regular and automatic adjustment
- Cost of Living
Equity: Adjustment to correct salary compression or inversion
Location
Market: Adjustment due to salary being out of line with the market
Merit
Promotion
Progression: Regular and automatic adjustment
- Structured: Adjustment dictated by union or employment contract, such as an increase after 3 months

You can change or add components to the CMP_SALARY_COMPONENTS lookup type to better support your reporting
policies for salary allocations. Use the Manage Common Lookups task in the Setup and Maintenance work area.

[temization

The salary record stores the incremental component itemizations and uses them to calculate new salary. When
component values change, the payroll element holds the new salary amount calculated from the component
adjustments. But it doesn't receive individual component amounts for processing. The incremental values entered in
the salary record apply only to that record and don't apply to any future salary records.

Related Topics
- How You Enable Salary Itemization Using Incremental Components

« Overview of Lookups

Simple Salary Component Lookups

HR specialists and line managers can use simple salary components to itemize new or adjusted salary, to reflect the
different reasons for their allocations. Here are the simple components bundled in the implementation:

Basic salary
Housing allowance
- Special allowance

- City allowance
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- Transport allowance
- Travel allowance

- Wage progression rate
- Variable allowance

- Overall salary
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You can change or add components to the ORA_CMP_SIMPLE_SALARY_COMPS lookup type to better support your
reporting policies for salary allocations. Use the Manage Common Lookups task in the Setup and Maintenance work

area.

[temization

Simple component itemizations let you maintain the values for the components and you typically configure them to
calculate new salary. When simple component values change, the salary record calculates the new salary amount. The
payroll element holds this new salary amount, but it doesn't receive individual component amounts for processing.

Related Topics

- Salary Amount Is Determined by Simple Components

« Overview of Lookups

Troubleshoot Salary-Related Issues

Here are some salary-related issues that might occur and solutions to help you fix them.

Issue

The salary element entry didn't get
created.

The salary ranges are incorrect for an
hourly person.

Salary changes are stuck in the approval
flow.

An individual's salary page has a message
that's something like this: Changes to
this data are pending approval. HR
specialists and compensation managers
or administrators don't have a Withdraw
option for the transaction in their worklist.
And sometimes, the person record gets
locked after changing the salary.

ORACLE

Solution

The salary basis element doesn't get created if inconsistencies exist between the element eligibility and
the payroll data of the person's assignment.

Using the Element Entries task in the Person Management work area, set the Effective Date to same
date as the salary start date. Then search for the salary basis element in the Element Name column.
If you don't see the element listed, the person isn't eligible for the element. You need to verify the
eligibility and effective dates configured for the element.

Check the annualization factor of the grade rate associated with the salary basis. The annualization
factors for the salary basis and grade rate might differ, even if the frequency for both is Hourly. Salary
range calculations use the frequencies and factors of the salary basis and the grade rate. If they don't
match, the calculations convert grade rate values to those of the salary basis.

Ask the person who submitted the salary change to use their worklist to withdraw the change. They
can also see who the current approver is, so they can ask the approver to approve or reject the
proposed changes.

If you still see the pending approval notification in the Change Salary flow, your approvals
administrator can use the transaction console to cancel the change. If you still see the pending
approval, have your help desk log a bug with Oracle Support. The bug should be for the Salary
component of Oracle Fusion Workforce Compensation.
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Issue

Salary notifications are blank.

The salary details in notifications are
blank.

People need to see salary information, but
not make any changes.

People need to see salary information, but
must not be able to make any changes.

ORACLE
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Solution

The person might have a custom role. Add the Approve Salary Updates privilege to their application
role. Or, add these three resources to a custom entitlement and add the entitlement to their application
role.

- HcmDetectCompletedTransaction.xml

- ChangeSalaryApprovalTask_TaskFlow.xml
. ChangePayNtfsFlow.xml

The person probably doesn't have a compensation role. Depending on whether they should have read-
only or read and write accesses to the salary details, add one of these job roles:

- View Salaries

- Manage Salaries

For detailed solution steps, see Approval Notifications - You Don’t Have Permission to Access this
Information (document ID 2272593.7).

Grant them access to the Compensation Info task, which they can review salary information. Reserve
the Change Salary role for the people who need to manage the salary data.
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23 Default Salary from Grade Ladder Rates

Basic Process to Default Salary Amounts from Grade
Ladder Rates

For details about defaulting salary, see the How do | default salary from grade ladder rates? playbook.
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24 Grade Step Progression Configuration

Manage Grade Step Progression

For information about setting up grade step progression, see the How do I set up a grade ladder for grade step
progression? playbook.

Examples of Adding Progression Rules

For details, see Example Progression Rules Applied at Each Level in the How do | create progression rules? playbook.
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25 Transaction Dates and On Eligibility in
Grade Step Progression Processing

Date Codes and Eligibility Options for Grade Step
Progression

For information about setting up grade step progression, see the How do I set up a grade ladder for grade step
progression? playbook.

167
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30261505
https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30261505

Oracle Fusion Cloud Human Resources Chapter 25
Implementing Compensation Transaction Dates and On Eligibility in Grade Step
Progression Processing

168
ORACLE



Oracle Fusion Cloud Human Resources Chapter 26
Implementing Compensation Global Settings for Grade Step Progression Processing

26 Global Settings for Grade Step Progression
Processing

Batch Settings for Grade Step Progression Processing

For information about batch settings, see the Global Settings for Grade Step Progression Processing chapter in the How
do | manage grade step progression processes? playbook.
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27 Grade Step Progression Processing

Overview of Grade Step Progression Processing

For information about processing, see the Grade Step Progression Processing chapter in the How do | manage grade
step progression processes? playbook.
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28 Examples of Grade Step Progression
Processing

Examples of Grade Step Progression Processing

For examples about processing, see the Examples of Grade Step Progression Processing chapter in the How do | manage
grade step progression processes? playbook.
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29 Proposed Grade Step Progression and
Salary Updates

Overview of Proposed Progression and Salary Updates

For information about proposals, see the How do review and understand results from grade step progression processes?
playbook
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50 Adjustments to Salary Amounts in
Proposed Progression and Salary Updates

Overview of Parameters That Affect Salary Amounts for
Proposed Progression and Salary Updates

For information about the parameters, see the How do review and understand results from grade step progression
processes? playbook
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51 Individual Compensation Plans Overview

Overview of Individual Compensation

You can let managers and specialists award compensation outside of the regular compensation cycle. For example,
a line manager can give someone a spot bonus or grant stock shares. And a compensation manager can give people
education reimbursements.

You can also let people make and change their own contributions to charitable or savings plans. These off-cycle
allocations and contributions require appropriate payroll elements and individual compensation plans.

- The payroll element communicates the payment or distribution details to payroll for processing. For example, a
company car plan has options with different compensation amounts for various mileage ranges. A spots bonus
plan has options with different fixed monetary amounts.

- The plan includes at least one option that links the payroll element to the plan. It also decides when payments
start and end, the people eligible for the plan, and when people can access the plan. For example, a car
allowance plan has multiple options for monthly payments starting January 1and ending December 31
according to mileage ranges. People in field sales and service jobs are eligible for the plan, and managers can
award compensation when they hire, transfer, and promote people.

You can also let people view nonmonetary awards by adding the relevant plans to compensation history. To let them
view their payment and contribution history, add the payroll elements linked to the plans that have recurring payments
or contributions.

Options in an Individual Compensation Plan
Configuration

Each individual compensation plan needs at least one option. You can set up a nonmonetary option, such as grant
stock shares, or a monetary option. Link a payroll element, and optionally select a budget pool and request or require
attachments.

When you create the option, you need to select the appropriate payroll element. You can select one element per
legislative data group. So you can link an option to multiple elements only when the element legislative data groups
are different. Proposers see the input values configured for the element when they select the option while allocating
compensation or contribution. The monetary amounts that they propose are in the currency of the element. On pages
that include the currency switcher, people viewing the proposed amounts can see them in their preferred currency.

CAUTION: Make sure that salary bases don't use the element selected for the option. Using the same element across
compensation objects can lead to payroll conflicts. It can also lead to unexpected deletions of salary or individual
compensation.

You can optionally select a budget pool to let managers track off-cycle and on-cycle awards.
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You can also request or require that proposers attach a specific document type to help approvers decide whether to
approve or reject proposed plan allocations. For example, set up a vehicle allowance option to require a vehicle details
document. The documents get retained in people's document records for future reference.

The document settings affect all flows except Offer flows. Currently people can't add attachments in the Offer flows, so
the flows ignore any option document settings configured for the individual compensation plan.

Related Topics
« Document Type Settings for Individual Compensation

 Create a Payroll Element to Use with Individual Compensation Plans
» How You Let Managers Track Off-Cycle and On-Cycle Compensation Against a Budget

Document Type Settings for Individual Compensation

Make sure that document types you use with compensation objects, such as options for individual compensation plans,
have these configurations. Manage document type configurations using the Document Type task.

Field Value

Document Type Level Assignment

Category Compensation
Minimum Attachments 0

Document Name Applicable Relevant and Required
All other attributes Not required

Allow Occurrences Yes

Payment Dates in an Individual Compensation Plan
Configuration

You specify when plan payments start and end using standard date rules. For example, the person proposing the award
can set the payment date. You only need to set end dates for recurring payments, such as car allowances.

If you select the Start or submission date option, the award or contribution uses the start date when people can set it
during actions. Otherwise, the award or contribution uses the date when they submit the action.
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Related Topics
« Sync Individual Compensation Plan Dates with the Start Date in a Pending Worker Action

« Sync Individual Compensation Plan Dates with the Projected Hire Date in an Offer
« Payment End Date Considerations for Individual Compensation Plans
« How the Projected Hire, Start, or Submission Date Works in HR Actions

How Changing the Hire Date Affects Individual
Compensation Allocations

Here's what happens when you change the hire date using the Change Start Date or Edit Work Relationship page:

Date Change Affect on Recurring and Nonrecurring Allocations

New date is before the allocation start date None

New date is between the allocation start Allocation start date changes to match the new hire date
and end dates

New date is after the allocation end date Allocation will be deleted

Eligibility in an Individual Compensation Plan
Configuration

You decide who can participate in the compensation plans or options with eligibility profiles. You can attach eligibility
profiles to the plan, an option, or both.

For example, to the company car plan, you attach an eligibility profile that includes only the Sales and Field Service
departments. To the options, you attach other profiles that restrict payment amounts by mileage ranges.

Compensation eligibility evaluations also use criteria defined at the element eligibility level to decide if someone is
eligible for a compensation plan. The best practice for controlling eligibility is to either use eligibility profiles or element
eligibility, but not both.

If you add multiple profiles, you need to mark at least one profile as required.

Related Topics
- Eligibility Profiles
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How Individual Compensation Plan Eligibility Works with
Assignment Creation Flows

Payroll element eligibility and plan-level or option-level eligibility profiles don't apply because the assignment
information hasn't been submitted yet.

How Individual Compensation Plan Eligibility Works with
Assignment Correction and Update Flows

Payroll element eligibility and plan-level or option-level eligibility profiles apply to the existing assignment information.
But they don't apply to the corrected or updated information because it hasn't been submitted yet.

Plan Access Restrictions in an Individual Compensation
Plan Configuration

Control who can start, update, or stop individual compensation allocations, and for what circumstances by restricting
plan access. For example, set up a plan so that only people using the Manager Personal Contributions action can start,
update, or stop contributions.

Related Topics
« Plan Access Restrictions

- The Difference Between Plan Access Restriction and Access Security
« Copy Individual Compensation Allocations During Local and Global Transfer
« Individual Compensation Plan and Option Visibility

Plan Info in an Individual Compensation Plan
Configuration

To help managers awarding the plan or individuals contributing to the plan, you can optionally provide background
information or instructions. Also include links to relevant documents and websites.

You can also specify whether people viewing the plan see this information when they select the plan, or after they click
Show plan info.
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Validate Individual Compensation Plans

You can validate the integrity of the individual compensation plan that you're editing. Or you can validate all of the plans
on the Individual Compensation Plans page.

You can detect and report on references to all deleted payroll elements still retained in the configured individual
compensation plan options. When someone deletes a payroll element before removing it from the plan option, it creates
orphan data in the individual compensation plan setup table. The orphan data can cause issues in allocations. To
prevent these issues, you can run the Purge Orphaned Payroll Element Setup Data from Individual Compensation Plans
process.

Before purging the orphaned payroll element data, you can run the process in Preview mode and generate a log with
the data the process will likely purge. When you run the process to purge the orphan rows, it cleans up the individual
compensation setup tables.

Journey Checklist Tasks and Individual Compensation
Plan Allocations

You can send people checklist tasks as part of their journeys when they get new individual compensation allocations.
For example, an individual subscribes to a voluntary deduction.

The corresponding journey includes checklist tasks that require an HR specialist to manually generate a membership ID,
enable portal access, and issue a welcome Kkit.

Assign Checklists

You can assign checklist tasks only when people add new individual compensation allocations using actions, such as
these:

Individual Compensation
Manage Personal Contribution
- Administer Individual Compensation
You can also assign tasks with Recruiting and Global Human Resource actions that add individual compensation
allocations. The checklist assigns the tasks after the new individual compensation allocation passes final
approval and the element entries get created. The checklist listens to the new element entries for the

individual compensation allocation using events. For the events to work, make sure that the profile option
HRC_DISABLE_HCM_EVENTS_PROCESSING is N.

Create the Checklist Template
You create a checklist template following the standard procedure and using these individual compensation settings:

- On the General tab, select a category.
- On the Tasks tab, configure the tasks.
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- On the Actions and Events tab, configure the event that causes the journey to assign the checklist. For new
individual compensation allocations, the creation of the entry for the specified element causes the checklist to
assign the task.

a. Add an event. Then in the Name field, select Individual Compensation.

b. Edit the condition and create a group. The attribute defaults to Element Type and the condition defaults
to the Equals operator and Constant operand type.

c. Inthe Operand Value field, click search. Use the Search and Select dialog box to select the appropriate
payroll element for the individual compensation option.

You can use only the OR group connector when you define group conditions for individual compensation. The
conditions don't support the AND connector.

Control When the Checklist Triggers

To control when the checklist triggers, you use the allocation criteria.

- The default Checklist manually allocated or record created or approved option triggers when the individual
compensation allocation gets approved and element entries get created. The trigger ignores the payment start
date.

- The When the action record becomes effective option triggers the checklist on the payment start date.

Related Topics
» Predefined Journey Templates

» Journey Template Definition

» Considerations for Configuring Actions in Journeys
« How You Configure Events in Journeys

- Journey Display Properties

» Deep Links in Journeys

How You Let People Submit Personal Contributions
When Earlier Contributions Are Pending Approval

To let people submit personal contributions when earlier contributions are pending approval, you need to enable the
CMP_DISABLE_PENDING_APPROVALS_CHECK_IN_MANAGE_CONTRIBUTION profile option at the Site level.

You also need to configure the access details of the relevant individual compensation plans. For the Manage Personal
Contribution task, never allow update allocations and never allow the discontinuation of allocations. This access
detail configuration ensures that individuals can't change or delete existing contributions, preventing conflicts for
contributions that are pending approval.

With this option enabled, approvers can't edit submitted contributions as part of their approval. Also, they can't see the
submitted values if they edit the submitted contribution. Line managers, compensation managers and administrators,
and HR specialists can still make updates or deletions using the Manage Individual Compensation or Administer
Individual Compensation tasks. This visibility assumes you configured the plan access to include the corresponding
actions for these tasks.
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Related Topics
« Plan Access Restrictions
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52 Payment Dates in Individual Compensation
Plans

Sync Individual Compensation Plan Dates with the
Projected Hire Date in an Offer

You can sync the payment start and end dates of individual compensation plans included in an offer, with the projected
hire date.

Do this by setting the payment start and end dates of the individual compensation plans to Projected Hire, Start, or
Submission Date. Then whenever you change the projected hire date in an offer and go to the individual compensation
section, the plan payment dates adjust automatically.

For example, you've an offer with a projected hire date of January 1, 2022. The offer includes an individual
compensation plan with payments that start the same day. Later you revise the projected hire date to February 1, 2022.
When you get to the individual compensation section, the existing payment start date automatically adjusts to February
1, 2022, to align with the new projected hire date.

Delay Payment

You can optionally delay the payment date by a specific number of days, months, years, or combination. The offer
calculates the payment start and end dates using the projected hire date and the specified delay. For example, your
offer includes paying a sign-on bonus 1 month after the projected hire date. Because your current projected hire date is
February 1, 2022, the payment start date of the bonus allocation is March 1, 2022.

Override the Payment Date

You can let recruiters override the calculated payment start date, end date, or both when they include the plan in their
offers. When they do override the payment dates, the projected hire date and the payment dates can't automatically
sync anymore. The recruiters need to delete the individual compensation plan and add it again every time they change
the projected hire date. They can't correct the existing payment dates.

Offer flows indicated overridden plan dates with (Set manually).

Examples of How Payment Start Dates in an Offer Sync
with the Projected Hire Date

You have an offer with three individual compensation plans that have slightly different configurations for the payment
start date of Projected Hire, Start, or Submission Date.

Here's how the configurations affect the payment start dates for the three plans when the projected hire date for the
offer changes.
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Configuration

Original Projected Hire
Date

Chapter 32

Payment Dates in Individual Compensation Plans

Original Payment Start
Date

Revised Projected Hire
Date

Adjusted Payment Start
Date

Plan 1, the start date isthe = Jan 1, 2022 Jan 1, 2022 Mar 1, 2022 Mar 1, 2022

projected hire date

Plan 2, the start date is 1 Jan1, 2022 Feb1,2022 Mar 1, 2022 Apr 1,2022

month after the projected

hire date

Plan 3, the start date is the = Jan1,2022 Initially set to Jan 1,2022 Mar 1, 2022 Apr 1,2022

projected hire date, but

recruiters can override the Recruiter overrides to Apr 1, Overridden dates remain
date 2022 unadjusted

The payment start date for Plan 3 doesn't change because the recruiter overrode the original date. The recruiter needs
to delete this individual compensation plan and add it again with the revised payment start date.

After the external candidate accepts the offer with the projected hire date of March 1, 2021, the individual compensation
plans show up on the pending worker page. The plan payment dates for the pending worker are the same dates shown
in the Adjusted Payment Start Date column.

Sync Individual Compensation Plan Dates with the Start
Date in a Pending Worker Action

You can sync the payment start and end dates of individual compensation plans included in a pending worker action,
with the start date.

Do this by setting the payment start and end dates of the individual compensation plans to Projected Hire, Start, or
Submission Date. The plan payment dates adjust automatically whenever people change the start date in the Edit
Pending Worker action and go to the individual compensation section.

For example, you've a pending worker with a start date of January 1, 2022. The details include an individual
compensation plan with payments that start the same day. Later you revise the start date to February 1, 2022. When you
get to the individual compensation section, the existing payment start date automatically adjusts to February 1, 2022, to
align with the new start date.

The plan payment dates won't adjust if people change the start date and don't visit the individual compensation
section. They won't automatically adjust in these situations either:

- When people change the start date in other flows, such as Employment details, Change Employment Start
Dates, and Change Work Relationship Start Date

- On any other pages where people can change the start date of the pending worker.
« When people use HCM Data Loader or REST services

People need to manually delete and re-add the individual compensation plans in all such scenarios.

When someone end dates the individual compensation row in the pending worker flow, the flow carries the end date
forward to the conversion stage.
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Delay Payment

You can optionally delay the payment dates by a specific number of days, months, years, or combination. The pending
worker flow calculates the payment start and end dates using the start date and the specified delay. For example, your
details include paying a sign-on bonus 1 month after the start date. Because your current start date is February 1, 2022,
the payment start date of the bonus allocation is March 1, 2022.

Override the Payment Date

You can let people override the calculated payment start date, end date, or both when they include the plan in the
individual compensation section. When they do override the payment dates, the start date and the payment dates can't
automatically sync anymore. They need to delete the individual compensation plan and add it again every time they
change the start date. They can't correct the existing payment dates.

Pending worker flows identify overridden plan dates with (Set manually).

Examples of How Payment Start Dates in a Pending
Worker Action Sync with the Start Date

You've a pending worker action with three individual compensation plans that have slightly different configurations for
the payment start date of Projected Hire, Start, or Submission Date.

Here's how the configurations affect the payment start dates for the three plans when the start date for the pending
worker changes.

Payment Start Date Original Projected Hire Original Payment Start Revised Projected Hire Adjusted Payment Start
Configuration Date Date Date Date
Plan 1, the start dateisthe = Jan 1, 2022 Jan 1, 2022 Mar 1, 2022 Mar 1, 2022

pending worker start date

Plan 2, the start date is 1 Jan 1, 2022 Feb1,2022 Mar 1, 2022 Apr 1,2022
month after the pending
worker start date

Plan 3, the start date isthe = Jan1,2022 Initially set to Feb 1, 2022 Mar 1, 2022 Apr 1,2022

pending worker start date,

but people can override the Overridden to Apr 1, 2022 Overridden dates remain
date unadjusted

The payment start date for Plan 3 doesn't change because you overrode the original date. When you need to revise the
dates, you need to delete this individual compensation plan and add it again with the revised payment start date.
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Payment End Date Considerations for Individual
Compensation Plans

If the individual compensation plan configuration has a nonrecurring payroll element, the payment end date depends
on the person's payroll relationship. Here are situations that ignore the payment end date configured for the plan:

- When payroll isn't available in the payroll relationship, the payment end date is the same as the payment start
date.

- When payroll is available in the payroll relationship, the payment end date is the period end date for the payroll
process.

The Offer and Pending Worker flow end dates carry forward to the next stage when the end date for the plan payment is
Projected Hire, Start, or Submission Date.

How the Projected Hire, Start, or Submission Date Works
in HR Actions

Here's how the Projected Hire, Start, or Submission Date payment date works with HR actions started from the Manage
Job Offers page or elsewhere.

Started from Manage Job Offers

You can sync the initial payment start and end dates of individual compensation plans included with the projected

hire date of the internal offer. Do this by setting the payment start and end dates of the individual compensation plans
to Projected Hire, Start, or Submission Date. When the proposer starts the HR action, the when date defaults to the
projected hire date of the offer. If the proposer changes the when date and goes to the individual compensation section,
the plan payment dates adjust automatically. If the proposer changes the when date later on, they need to delete and
add the individual compensation plans again, with the correct payment dates.

For example, you've an internal candidate offer with the projected hire date of January 1, 2022. You then start
processing the global transfer with a when date of January 1, 2022. The transfer includes an individual compensation
plan with payments that start the same day. When you get to the individual compensation section, you see that the plan
has a payment start date of January 1, 2022. Before you submit the transfer, you revise the when date to February 1,
2022. When you get to the individual compensation section this time, the existing payment start date remains January
1, 2022. You need to delete the plan and add it again with the correct payment dates.

Started from a Page Other Than Manage Job Offers

The Projected Hire, Start, or Submission Date option works the same as the Start or Submission Date option. When the
proposer sets the when date and goes to the individual compensation section, the section sets the payment dates to
the when date. After that, if the proposer changes the when date, they need to delete the plan and add it again with the
correct payment dates.

190
ORACLE



Oracle Fusion Cloud Human Resources Chapter 33
Implementing Compensation Access and Action Options, and Option Visibility in
Individual Compensation Plans

53 Access and Action Options, and Option
Visibility in Individual Compensation Plans

Plan Access Restrictions

You control the situations when a manager can create, update, or discontinue individual compensation awards using
plan restrictions. These same restrictions let you control similar actions for people contributing to savings and donation
plans.

You configure these restrictions when you create the individual compensation plan using the Individual Compensation
Plans task in the Compensation work area.

Whether to Restrict Access

The first decision you make on the Plan Access tab is whether to restrict access to the plan.

If you select No, the plan becomes available to everyone on all pages where people hire individuals, or manage
individual compensation or personal contributions. It's very rare that you'd select this option. For example,

if you don't restrict access to a bonus plan, then people could manage the bonus plan for themselves. That's
because the plan would appear in the Manage Personal Contributions action.

If you select Yes, you need to add at least one action where the plan should be available. Make sure that you
select all related actions. For example, you set up the plan so that it's visible in the Pending Worker action.

You also want to make it visible in the Hire action. Otherwise, when someone converts to an employee, their
manager can't see the allocation. And, when the manager submits their changes, the employee's allocation gets
removed. You can optionally configure the corresponding access details about when people can start, update,
or stop allocations or contributions.

All Action

The default action All is similar to setting Restrict Plan Access to No, except that you can configure access details. This
action opens plan access to all actions available in the list, including the Manage Contributions action. Basically, anyone
who meets the eligibility criteria for the plan can see the plan. If you added this action to a bonus plan, for example,
anyone eligible for the plan could award themselves a bonus.

To add other access actions, you need to change the All action to something else, such as Hire. Then, the Add icon is
available and you can add any other access actions that are appropriate for the plan.

HR Actions

To make the plan available to people as part of an HR action, add one or more HR actions. For example, add the Transfer
action to a moving allowance plan to make the plan available when people transfer someone using that action.

To make the plan available to recruiters creating or editing job offers, you need to add the same action that they select
in the offer. For example, the recruiter selects the Add Pending Worker or Add Assignment action while creating the
offer. The individual compensation plan access needs to include the same action for the plan to appear in the Other
Compensation section of the job offer.
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Manage Individual Compensation Action

To make the plan available to people when they want to award off-cycle compensation to someone, add the Manage
Individual Compensation action. You can add only this action or also add HR actions. For example:

- You want managers to use the Bonus plan to reward performance. So, you restrict plan access to the Manage
Individual Compensation actions.

- You want managers to use the Bonus plan to award hiring bonuses or to reward performance. So, you restrict
plan access to the Hire and Manage Individual Compensation actions.

Administer Individual Compensation Action

To make the plan available to only HR specialists, compensation specialists, and compensation managers, add
the Administer Individual Compensation action. These people can see plans with this plan access action using the
Administer Individual Compensation task.

Manage Contributions Action

To make the plan available for people to contribute to, such as for retirement savings or charities, add the Manage
Contributions action. Don't add any other actions for contribution plans.

The Difference Between Plan Access Restriction and
Access Security

Access security identifies which roles grant access to actions, such as Individual Compensation, Manage Personal
Contribution, and Administer Individual Compensation.

Plan access restriction identifies which actions, such as Personal Contribution or Individual Compensation, show the
plan. It also lets you control if people can add, edit, or delete contributions or allocations.

Copy Individual Compensation Allocations During Local
and Global Transfer

You can ensure that local and global transfers automatically copy individual compensation allocations and personal
contributions to the new assignment. Do this when you configure plan access for individual compensation plans.

Either set Restrict Plan Access to No. Or set it to Yes and add the Global Transfer action.

Tip: When the plan element uses the Last Standard Process Date or Last Standard Earning Date date, the planisn't
end dated for the source assignment.
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When Allocations and Contributions Aren't Copied

The automatic copy doesn't happen for these situations:

If the legal employers for the source and destination assignments have different legislative data groups

If the local and global transfer action doesn't include the Individual Compensation section, or the person
proposing the transfer don't visit the section

If Restrict Plan Access is Yes and the Global Transfer action isn't added

Individual Compensation Plan and Option Visibility

Your plan configuration decides whether people can see the plan or option when they use the Administer Individual
Compensation, Individual Compensation, and Manage Personal Contribution tasks.

The person getting the compensation allocation or making the personal contribution needs to meet these conditions:
Be eligible for the element you associated with the option.

Meet the criteria of the eligibility profile you associated with the plan, option, or both.

Also, the plan status needs to be Active and plan access should have the appropriate actions added. For example, to be
visible for the Manage Personal Contributions task, plan access needs to have the Manage Contribution action.

Related Topics
« Plan Access Restrictions
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54 Example Individual Compensation Plan
Configurations

Spot Bonus and Stock Grant Plan Configuration

Here's how you create a plan to make a onetime spot bonus payment or stock grant.

1. Create a payroll element that makes a onetime payment. Configure the element to process once per payroll period
and let managers enter the payment amount or grant quantity.

Go to My Client Groups > Compensation > Elements.

2. Create the plan.

a. Go to My Client Groups > Compensation > Individual Compensation Plans.

b. Add an option with the payroll element. For stock grants, be sure to set the nonmonetary units to Shares
and select the grant type.

c. Select a payment or grant start date. If it's present, leave the end date blank to indicate this is a onetime
payment.

d. Optionally, add an eligibility profile to limit the people that the plan applies to. For example, use derived
factors to identify full-time people with a minimum service of 1year as eligible for the spot bonus. Identify
full-time people with a minimum service of 5 years as eligible for the stock grant.

e. Restrict access to specific HR actions, such as Hire and Promote. Also add the Manage Individual
Compensation action so that managers can award bonuses or grant stock to their people using the
Individual Compensation action.

Stock grant records get the stock or trading symbol and grant type from the plan option. They get the grant date and
number of shares granted from the element entries.

Car Allowance Plan Configuration

Here's how you create an ongoing car allowance plan with two payment options. The options vary according to the
distance of regional territories from headquarters.

1. Create two payroll elements to make recurring payments once a month. For territories within a 100-mile radius of
headquarters, set the input value default to 300. For territories beyond a 100-mile radius, set the input value default
to 500.

Go to My Client Groups > Compensation > Elements.
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2. Create the plan.

a.
b.
C.

Go to My Client Groups > Compensation > Individual Compensation Plans

Configure an option for each payroll element.

Let managers enter payment start and end dates according to agreements with their people. For example,
a manager starts payment on the first of the month or the first payroll period after a promotion. They end
payment after 1year.

Attach an eligibility profile that limits plan eligibility to people with the Regional Sales Manager job.
Restrict access to specific HR actions, such as Hire and Transfer. Also add the Manage Individual
Compensation action so that managers can award or update the car allowance for their people using that
action.

Optionally, add instructions that tell managers how the payment policy varies according to the distance
from headquarters. And, include a link to the policy.

Charity or Savings Contribution Plan Configuration

Here's how you create a plan that lets people manage their personal contributions.

1. Create a payroll element to accept recurring contributions per payroll period. Configure the input value to be either a
flat amount or percentage.

Go to My Client Groups > Compensation > Elements.
2. Create the plan.

a.

Go to My Client Groups > Compensation > Individual Compensation Plans.

b. Add an option for contributions of either amount or percentage.
C.
d

Select a start date, typically January 1 of the next calendar year or after open enroliment.

Restrict access to the Manage Contributions action to let people manage their instances of the plan.

You can define periods when people can enroll for the first time, update existing contributions, or stop
contributions. For example, let people always create allocations. Restrict when they can make updates or
discontinuations to a specified period, such as an open enroliment period of November 15 through 30.

Optionally, add instructions that clarify specific plan policies.
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355 Compensation History

Compensation History Categories

Compensation history has a summary table with four categories--Salary, Stock, Other Compensation, and Recurring
Payments--and links to compensation details. Summary info covers 5 years of history while details cover all years.

Salary

The Salary category has these three rows of information:

Row Comments

Overall Salary For the current year, it's the most recent pay rate. The rate appears in the frequency of the person's
salary basis, such as hourly, monthly, or annually.

For previous years, it's the pay rate on 31 December of that year.

Annualized rate Calculated using the person's overall salary and the annualization factor of the salary basis frequency
as of 31 December of that year.

Percentage change The difference in the person's overall salary from the previous year, if history exists.

In the summary table, click the base pay link to view detailed information about salary history, percentage change,
compa-ratio, and growth rate. The detail view includes links to individual base pay change records.

Stock

The Stock category shows a total for each grant type awarded in the unit granted, such as shares or options. In the
summary table, click the grant name to view more information, such as grant date, vested shares, and the estimated
value of unvested shares.

Other Compensation

The Other Compensation category shows nonrecurring monetary compensation, such as commissions, bonuses,
overtime, and reimbursable expenses. In the summary table, click the compensation name to view effective date,
amount, currency, and grand total information about all awards.

You can see elements information with only input values that are numbers, integers, and money because history was
designed for monetary and quantity compensation. For example, you can see salary, bonus, and allowance amounts
and quantities of vested, unvested, exercised, and unexercised stock shares. Also, the overall view shows various totals,
which history can't calculate for nonmonetary and nonnumeric values.
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Recurring Payments

The Recurring Payments category includes the latest amount of recurring compensation, such as car allowances and
education assistance. In the summary table, click the payment name to view effective date, amount, currency, and grand
total information for an individual award or compensation amounts.

Related Topics
» How You Set Up the Other Compensation and Recurring Payments Summary Data for Compensation History

How You Set Up the Other Compensation and Recurring
Payments Summary Data for Compensation History

You set up the summary table data that shows in the Other Compensation and Recurring Payments compensation
history categories. Go to My Client Groups > Compensation > Compensation History.

The Other Compensation category groups one-time payments, such as bonuses. The Recurring Payments category
groups nonbase pay distributions, such as allowances or tuition reimbursements. To include compensation in these
history categories, on the Compensation History page, select the appropriate payroll elements and corresponding input
values. The payroll element definition automatically supplies the remaining data and identifies the history category
based on the recurrence of the payroll element.

Compensation history automatically gets the applicable Salary and Stock summary data, you don't need to do any
setup.

Related Topics
» Compensation History Categories

198
ORACLE



Oracle Fusion Cloud Human Resources Chapter 36
Implementing Compensation Stock Grants

56 Stock Grants

Manage Stock Grants in the Integrated Workbook

You can add and edit stock grant data and upload it into the application using an integrated Microsoft Excel workbook.

1. In the Compensation work area, click Manage Stock Grants.
2. Onthe Manage Stock Grants page, click Prepare Import Spreadsheet.

3. Copy the stock grant data provided by your supplier. Make sure that each row contains a unique grant date, grant ID,
and grant number. The workbook adds a symbol in the Changed field to mark the rows that you added.

CAUTION: Don't delete or reorder template columns. The upload process might fail.

4. When you're done, click Upload. The application uploads only those rows that are marked as Changed and ignores
any changes in cells that don't have a white background.

CAUTION: Don't select the Upload and then immediately download option when prompted during an upload.
The data that you uploaded immediately downloads back into the workbook, hiding any errors that occurred
during the upload.

5. Validate the changes.
a. Open the Manage Stock Grants page and search for and view the imported stock grant data.
6. Resolve errors. The upload process automatically updates the Status field in each workbook row.

If there are errors that require review, the process:

a. Rolls back the change in the application.
b. Setsthe workbook row status to Upload Failed
c. Continues to the next workbook row

To view and resolve an error:

a. Inthe Status field, double-click Update Failed.
b. Fix any data issues in the workbook.
c. Upload the latest changes.

Related Topics
« How can | import stock data sent to me by my supplier?

« Set Up Desktop Integration for Excel
 Guidelines for Using Desktop Integrated Excel Workbooks
» Troubleshoot Desktop Integration for Excel
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FAQ

How can | import stock data sent to me by my supplier?

On the Manage Stock Grants page, use the Prepare Import Spreadsheet button to generate the stock table spreadsheet.
Enter your supplier's data, ensuring that each row contains a unique Grant Date, Grant ID, and Grant Number. Upload
the information into the stock table.
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57 External Data

External Compensation Data

You can add compensation-related information from third-party and legacy applications, such as pension, annuity,
royalty, and assignment segments. You can include this external data as default values in worksheet columns for
workforce compensation plans.

You can also include it as compensation items in total compensation statements.

Person by Person or Many People at a Time

You can manually enter data for one person at a time using the External Data task in the Compensation work area. On
the same page, you can use the Prepare Import Spreadsheet button to import external data for many people at a time.

Data to Add

Here's the data you add, regardless of method:

Record type
- Start Date

End Date
- Sequence Number
- Currency

- Columns, such as Column 01 and Column 02

To avoid difficulties when adding other data in the future, be sure to provide all relevant data, such as end date,
sequence, and currency. For example, if you're external data includes amounts, you might need the currency to ensure
calculations handle the amounts correctly.

Person-Level Data to Assignment-Level Data

You can add external data at the person or assignment level. Adding it at the assignment level lets you use assignment-
level security. You can update personal-level external data to assignment-level using the Update Assignments process.
The process updates the data to the primary assignment as of the start date for the external data record.

Related Topics
+ Record Type Lookups for External Compensation Data

- Import External Compensation Data in the Integrated Workbook
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Record Type Lookups for External Compensation Data

When you import data from third-party or legacy applications, you need to select the record type. The record types in
the choice list come from the CMP_EXTERNAL_DATA_RECORD_TYPE lookup type.

You can change delivered values, such as data from a third-party supplier application, at any time. And you can add new
values. For example, you add a lookup code to identify data from the third-party partner that manages your pension,
annuity, royalty, or 401k.

Use the Lookups task in the Compensation work area.

Related Topics
« Overview of Lookups

Import External Compensation Data in the Integrated
Workbook

You can enter and edit external compensation data, such as third-party or legacy data, using an integrated Microsoft
Excel workbook. Then, upload the data into the application.

Before you start

You might optionally want to create your own lookup codes if you find the two delivered codes too
broad. For example, you might want to create lookup codes for pension or sales incentive data. Add a
CMP_EXTERNAL_DATA_RECORD_TYPE lookup code using the Manage Lookups task in the compensation work area.

To use the imported data, you need to complete one or both of these tasks, either before or after the import:

- To use the external data in workforce compensation, configure one or more user-defined worksheet columns.

- To show external data in total compensation statements, create one or more compensation items with a source
type of External Data.

Here's what to do

1. In the Compensation work area, Common Configuration section, click Manage External Data.
2. Onthe Manage External Data page, click Prepare Import Spreadsheet to create the workbook.
3. Enter the external data.

Add enough rows to accommodate your supplier's data. Copy the external compensation data and paste them into
cells with a white background. The workbook adds a symbol in the Changed field to mark the rows that you added.
Reordering or removing columns in the import file causes the upload process to fail.
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4. When you finish, click Upload. The application uploads only those rows marked as Changed. It ignores any changes
in cells without a white background.

CAUTION: Don't select the Upload and then immediately download option when prompted during an upload.
The data that you uploaded immediately download back into the workbook, hiding any errors that occurred during
the upload.

5. Validate the changes.

a. Onthe Manage External Data page search for and select the start date and record type, or other search
criteria.

6. Resolve the errors.

The upload process automatically updates the Status cell in each workbook row. If there are errors that require
review, the process:

a. Rolls back the change in the application.
b. Sets the workbook row status to Upload Failed
c. Continues to the next workbook row

To view and resolve an error:

a. Inthe Status field, double-click Update Failed.
b. Fix any data issues in the workbook.
c. Upload the latest changes.
New uploads to existing data make date-effective changes to the data.

Related Topics
» Record Type Lookups for External Compensation Data

« Set Up Desktop Integration for Excel
« Guidelines for Using Desktop Integrated Excel Workbooks
» Troubleshoot Desktop Integration for Excel

How can | add external compensation data for multiple
assignments?

Enter a unique assignment ID for each row of data on the Manage External Data page of the Compensation work area.

Delete External Data in Compensation

On the External Data page, Actions menu select either Purge Entire Table or Delete Records Matching Criteria.

Or you can use the HCM Data Loader (HDL) to delete selected rows (My Client Groups, Data Exchange).
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58 Workforce Compensation Overview,
Lookups, and Security

Overview of Workforce Compensation

Let managers and specialists allocate compensation, such as merit increases or stock grants, to groups of people on a
focal, anniversary, or periodic basis. This includes letting them promote people and rate performances while allocating
compensation, as well as communicating compensation changes.

Also set up managers so they can automatically calculate and allocate compensation using models and analyze
proposed changes to ensure outcomes like these:

Equity among peer groups and by manager
- Alignment with the market and with organizational compensation strategies for performance

You do all of this when you set up your workforce compensation plans. The setup involves configuring the foundation,
budgets, worksheets, models, and reports aspects of each plan. Managers and specialists use the worksheets to
propose compensation, performance ratings, and promotions. They also use them to approve proposed changes and
communicate the changes. You can also optionally extend certain lookups that people in various job roles use in the
workforce compensation cycle. And you can use a fast formula to retrieve data or run calculations on data.

Deep Links in Workforce Compensation

You can let people access workforce compensation from external sites or include workforce compensation in a
journey checklist. To use deep links in compensation, go to Navigator > Tools > Deep Links > search for workforce
compensation.

The deep link takes people to the workforce compensation landing page. People still need to navigate to the desired
plan. This prevents people from accessing plans where plan cycles are closed or are outside of the plan cycle dates.

Related Topics
- Deep Links

- Deep Links in Journeys

Reason Lookups

When you adjust a budget, you include a reason. The budget audit history shows this reason, along with the adjustment
and other budget changes. The CMP_BUDGET_AUDIT_REASONSIlookup type already has the following reasons set up.
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The CMP_BUDGET_AUDIT_REASONS lookup type already has the following reasons set up. You can't change or delete
them, but you can add reasons that support your adjustment policies. The codes that start with CMP appear in audit
history.

- Worker eligibility change
Eligible salary change

- Worker budget change
Budget automatically issued
Budget distributed by manager
Manager budget change

- Worksheet budget change

- Worker reassignment
Initial budget
Miscellaneous adjustment

- Supplemental funding

You configure lookups in the Compensation work area using the Lookups task.

Related Topics
« Overview of Lookups

Nonmonetary Unit of Measure Lookups

You use nonmonetary units of measure throughout workforce compensation, for example, to set up a compensation
worksheet for stock grants. The CMP_NONMONETARY_UOMIookup type already has these units of measure set up,
which you can change and add to, to support your compensation policies.

Days
Hours
[tems
-« Shares
« Units

You configure lookups in the Compensation work area using the Lookups task.

Related Topics
« Overview of Lookups

User-Defined Column Lookups

To let managers select from relevant choice lists on task worksheets, you can enable a column and configure the
associated user-defined lookup type.
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For example, you create a user-defined column called Up For Promotion. Then you configure the related user-defined
lookup type with these meanings: Yes and No. Managers can use the user-defined column to indicate if people are up
for promotion.

These are the bundled user-defined column lookup types.

- CMP_CWB_CUST_COL_46_LIST
« CMP_CWB_CUST_COL_47_LIST
- CMP_CWB_CUST_COL_48_LIST
« CMP_CWB_CUST_COL_49_LIST
« CMP_CWB_CUST_COL_50_LIST

While the bundled lookup code Meaning is DEFAULT, any lookup codes you add need to be only numeric. The
meanings can be characters, numbers, or a combination of both. You configure lookups in the Compensation work area
using the Lookups task.

Related Topics
« Overview of Lookups

Workforce Compensation Security

The workforce compensation tasks, plans, and task worksheets that people can use and access depend on plans, user
roles, and security profiles setup.

Person Security Profile

To determine the managers a higher-level manager or specialist can switch to on the Workforce Compensation
page, you set up security profiles. The profiles also determine individuals that people can handle changes for on the
Administer Workers page in the Compensation work area. And, the profiles determine the people included in the full
administration download. The profiles don't affect the people managers see in the task worksheets of a workforce
compensation plan.

User Roles

Bundled job roles and duty roles determine the people who can use workforce compensation tasks and work with
workforce compensation plans. You can also create your own roles to grant or remove access to specific compensation
tasks.

Plan Configuration

At a more granular level than the profiles and roles, you can specify the managers who can access the plan tasks.

You can also specify the people they can see on each task worksheet using the plan hierarchy. To further limit plan
access, you can use plan access overrides and plan status controls. For example, you can make plans available to only
compensation administrators using the plan status controls.
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Reference

For more information about workforce compensation security, see Security and Workforce Compensation (document ID
1556468.1) on My Oracle Support at https://support.oracle.com.

Considerations for Securing Access to Workforce
Compensation Plans and Task Worksheets

Do you want to secure access to your workforce compensation plans and if so, how? Keep these key considerations in
mind when setting up various configurations:

- Do you want to let managers and HR specialists only view plans and let only compensation administrators
make changes? You can do this when you configure plan access as part of the foundation plan setup.

- Do you want to let managers change plan access for their subordinate managers? You can do this when you
configure approvals and notifications as part of the worksheets plan setup.

- Do you want to let managers change worksheet access for their subordinate managers? You can do this when
you configure actions as part of the worksheets display plan setup.

Here are some scenarios and example access configurations.

Scenario Example Configuration Workforce Compensation Plan Task
Limit compensation manager access usingthe = When you configure plan access, add roles Configure Plan Access
Act as Proxy task according to roles. in the Roles with the Plan Access from the

Compensation Work Area section.

Limit when managers access their plan To start, when you configure plan hierarchies, Configure Plan Hierarchies
worksheets. set a default access level to determine who

has immediate access, such as compensation

administrators. Or you can use a fast formula.

During the workforce compensation cycle,
when managers can access their plan
worksheets, compensation administrators
can change manager access using the plan
approvals task. Or plan administrators can
change the worksheet display configuration
to enable the approvals task to let managers
change the access of their subordinate
managers.

Related Topics
» Workforce Compensation Plan Hierarchies

« Workforce Compensation Plan Access
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59 Workforce Compensation Plans Overview

Overview of Workforce Compensation Plan
Configuration

People use workforce compensation plans to allocate budgets to managers and compensation to groups of people
during a compensation cycle. The plans are highly configurable, so you can determine the specific tasks and
information that a plan provides to administrators, managers, and specialists. The setup page displays pertinent plan
details and existing budget, component, and worksheet configurations.

To set up a plan, use the Workforce Compensation Plans task in the My Client Groups > Compensation work area to
configure these aspects:

- Configure Foundation: Set up details, such as the employment records the Start Workforce Compensation
Cycle process evaluates for the plan. Also specify if the plan is active or inactive, configure eligibility, and
identify cycle dates that determine plan access and eligibility. Set hierarchies that determine whether people
have primary responsibility for the plan, can provide suggestions, or can only review the plan. And enable
currency switching and configure currency properties, set up plan access, and configure a feedback survey and
plan information.

- Configure Budgets: Specify how to distribute budgets, set up budget groups, and identify storage methods for
budget pools. Also track on-cycle and off-cycle compensation against the budget.

- Configure Worksheets: Determine which worksheets to include in a plan as well as display properties, dynamic
calculations, alerts, and assignment segments. Managers and specialists use these worksheets to propose
compensation, performance ratings, and promotions. They also use them to approve proposed changes and
communicate the changes.

- Configure Models and Reports: Let managers and specialists build compensation models that help them
align their budgets and compensation allocations with organizational pay practices and guidelines. Let them
automatically allocate modeled amounts according to each person's country, job, grade, and quartile. And
create Oracle Transactional Business Intelligence reports to give managers and specialists relevant contextual
information so that they can make informed compensation changes. Also configure plan filters and analytics.

Performance Considerations for Workforce
Compensation Plans

® Watch video

You need to consider how responsive workforce compensation plans are when determining how many plans to create.
Plans can include a few or many simple dynamic calculations and few or many complex calculations. The more dynamic
calculations and the more complex the calculations, the slower the plans respond when people change different values.

To optimize plan performance, you want to create plans tailored to specific audiences. For example, compensation
administrators want to optimize compensation budgets and allocations across their client groups. They typically
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need more information to test different allocation scenarios beyond what the modeling functionality can handle. Line
managers though want the absolute minimum information that they need to make appropriate allocations across their
teams. And they want any contextual or background information about their people in reports or a detailed worksheet
that they can look at separately, as needed.

You create separate plans for each audience. The plans for compensation administrators include the dynamic
calculations and fast formulas that can slow plan performance. The plans for line managers include cross-references to
key calculations in the administrator plans, so the managers can see critical calculation results. And manager plans can
include fewer dynamic calculations with simpler conditions, as appropriate. Or you might let managers use models to
explore allocation scenarios instead of configuring dynamic calculations for their plans.

To further optimize plan performance, you want to validate each plan. Validation lets you check that the evaluation
order for dynamic columns is correct and generates the results expected by the plan audience. It also helps you
determine the optimal number of dynamic calculations and alerts to include so the plan responds as each audience
considers acceptable.

Related Topics
« Considerations for Securing Access to Workforce Compensation Plans and Task Worksheets
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40 Foundation: Plan Details in Workforce
Compensation

Employment Records to Use in the Compensation Cycle

You can specify the employment records used by the Start Workforce Compensation Cycle and Refresh Workforce
Compensation Data processes when you configure plan details.

Primary Assignments

The processes include people and set their eligibility status according to only their primary assignments. Anyone
who has multiple assignments and a plan that uses a manager hierarchy appears only on their primary assignment
manager's worksheet.

All Assignments

The processes include people and set their eligibility status according to all of their assignments. Anyone who has
multiple assignments might appear on their manager's worksheet more than once. And they might have different
eligibility statuses. For example, they might have an Eligible status according to the primary assignment and an
Ineligible status according to another assignment. If the manager for each assignment is different, the individual might
appear on worksheets for multiple managers.

Employment Terms

The processes include people and set their eligibility status according to the employment terms of legal employers
using the three-tier employment model. If the plan uses a manager hierarchy, people appear on the primary assignment
manager's worksheet.

The processes exclude people whose legal employers have employment terms that use the two-tier employment model.

Any Assignment or Employment Term with a Salary

The processes include people and set their eligibility status for all of their assignments and employment terms that
have a linked salary record. If the plan uses a manager hierarchy, people appear on the primary assignment manager's
worksheet. Anyone who has multiple assignments with a salary record might appear on their manager's worksheet
more than once. They could have a different base salary for each assignment. And they might have different eligibility
statuses. For example, they might have an Eligible status according to the primary assignment and an Ineligible status
according to another assignment. If the manager for each assignment is different, the individual might appear on
worksheets for multiple managers, with different salaries for each.

The processes exclude people whose assignments and employment terms don't have a linked salary record.
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Active and Inactive Workforce Compensation Plans

When you configure plan details, you need to specify whether the plan status is Active or Inactive.

Compensation cycles include active plans. At any time during specified cycle dates, line managers can access their
active plans using the Workforce Compensation task for their team. Even after approved changes transfer to HR,
compensation managers can view plans using the Compensation task for their client groups.

Subsequent workforce compensation processes exclude inactive plans. Line and compensation managers can't view
or update the plans. Typically, you use this status to create and test plans, or for obsolete plans. You can purge only
inactive cycles.

Compensation administrators can change the status back to Active at any time.

Actions and Reasons in Workforce Compensation

To provide context, all salary and assignment changes include an action and optional action reason. You need to select
the action when you configure plan details. The bundled action that you can set in plan details is Allocate Workforce
Compensation.

If the plan includes different task worksheets for different allocation types, such as merit increases, bonuses, and stock
shares, you don't select an action reason. If the plan focuses on a single action, you can select the appropriate action
reason. For example, you create a plan where managers change compensation according to performance evaluations,
so you select the Performance action reason.

The action and reason are stored with all salary and assignment changes that transfer to HR after the compensation
cycle is complete. Changes from the performance evaluation plan would show in people's salary history as Allocate
Workforce Compensation and Performance.

Here's a comprehensive list of the bundled compensation action reasons.

- Anniversary

- Career Progression

- Cost of Living Adjustment
- Market Adjustment

- Mass Adjustment

» Merit

« Performance

- Periodic Review

- Promotion

You can extend the available actions and action reasons using the Configure Actions and Action Reasons quick actions
under My Client Groups > Workforce Structures.
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Related Topics
« Reason Lookups

« Action Framework

213
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30237009

Oracle Fusion Cloud Human Resources Chapter 40
Implementing Compensation Foundation: Plan Details in Workforce Compensation

214
ORACLE



Oracle Fusion Cloud Human Resources Chapter 41
Implementing Compensation Foundation: Plan Eligibility and Cycles in Workforce
Compensation

41 Foundation: Plan Eligibility and Cycles in
Workforce Compensation

Workforce Compensation Plan Eligibility

You determine the people who are eligible and ineligible for allocations from workforce compensation plans with
eligibility profiles. Here are examples of available criteria:

Personal, such as gender and home location
Employment, such as assignment status, hourly or salaried, grade, job, and performance rating
Derived factors, such as age, length of service, or a combination of both
- Other, such as formula and user-defined criteria
Labor relations, such as bargaining unit, union, and collective agreement

Add the relevant profiles when you configure plan eligibility. You can also create additional profiles to add, as needed.

Tip: Make sure that on your eligibility profiles, you set Assignment to Use to Specific assignment.

The profile configuration determines what it means to meet criteria. The Start Workforce Compensation Cycle and
Refresh Workforce Compensation Data processes set the status of people who meet inclusion criteria to Eligible. The
processes set the status of people who don't meet inclusion criteria, or who do meet exclusion criteria, to Ineligible. For
managers determined ineligible with subordinates determined eligible, the processes set the manager eligibility status
to Limited.

Related Topics
- How Plan Access, Eligibility, and Default Access Level for Plan Hierarchies Work Together

- How Eligibility Works With Other Objects
- Eligibility Profiles

How Required and Optional Profiles Determine
Compensation Eligibility

If you add only one eligibility profile, people have to meet the profile criteria before the processes can set their eligibility
statuses. This requirement is true, even if you don't select Required. Here's what the processes require when you add
multiple eligibility profiles:

- If all profiles are optional, people have to meet the criteria of at least one profile before the processes can set
their eligibility statuses.

If all profiles are required, people have to meet the criteria of all profiles before the processes can set their
eligibility statuses.
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If some profiles are required, people have to meet the criteria of all required profiles and at least one optional
profile. Then the processes can set their eligibility statuses.

Related Topics
- How Eligibility Works With Other Objects

- Eligibility Profiles

Option to Track People Ineligible for a Workforce
Compensation Plan

You can track ineligible people when you configure plan eligibility. The Start Workforce Compensation Cycle and Refresh
Workforce Compensation Data processes include these people on the plan worksheets.

These people also appear on the Compensation work area, Administer Workers page. Each person has an eligibility
status of Ineligible and none of their fields are editable. Because these people are visible, plan managers and
administrators can change statuses to Eligible, as they deem appropriate. The approving manager reviews the status
and proposed compensation changes when determining whether to approve or reject the submitted plan.

Tip: You can include ineligible people on worksheets and let managers hide them when they want by enabling the
Hide Ineligible Workers action for plan worksheets.

When you don't track ineligible people, administrators must manually process the people to include them in the plan.

Related Topics
« Actions Configuration for Communication, Compensation, Detail Table Only, Performance, and Promotion
Worksheets

How the Options to Track and Hide Ineligible People
Affect Plan Worksheets

You determine which people the Start Workforce Compensation Cycle and Refresh Workforce Compensation Data
processes include on the plan worksheets.

Track Ineligible Workers Hide Ineligible Workers Worksheet Effects of Start Worksheet Effects of Refresh
Process Process

Selected Selected Doesn't add newly evaluated People found ineligible midcycle
people it found ineligible to the drop off the worksheet.
worksheet.

Selected Cleared Adds newly evaluated people it People found ineligible midcycle

found ineligible to the worksheet. = remain on the worksheet.
This includes people whose
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Track Ineligible Workers Hide Ineligible Workers Worksheet Effects of Start Worksheet Effects of Refresh
Process Process

termination date is between the
cycle evaluation start date and the
HR data extraction date.

Cleared Selected Doesn't add newly evaluated People found ineligible midcycle
people it found ineligible to the drop off the worksheet.
worksheet.

Cleared Cleared Doesn't add newly evaluated People found ineligible midcycle
people it found ineligible to the remain on the worksheet. This
worksheet. includes people who meet the

eligibility criteria and whose
termination date is between the
cycle evaluation start date and the
HR data extraction date.

Eligibility Profile Testing for a Workforce Compensation
Plan

You can test the eligibility profiles you add when configuring plan eligibility. The test lets you select a cycle, a sample
person, and an active assignment for your test.

Data security applies, so the person and assignment you can see for the cycle depend on your privileges. If profile
criteria includes fast formula, you can see if it worked correctly by reviewing the formula logs. Data security applies, so
the person and assignment you can see for the cycle depend on your privileges.

Workforce Compensation Plan Cycle Dates

You determine various aspects of workforce compensation cycles, such as plan access and eligibility, when you
configure plan cycle dates. You can reuse workforce compensation plans across multiple cycles, with a unique set of
dates for each cycle.

Here's a comprehensive list of the dates you can set.

Date Description

Evaluation Period Start and End Dates Period in which, such as a calendar or fiscal year, a quarter, or a month, when you can evaluate
groups of people for compensation allocations. Typically, fast formulas use these evaluation periods.
Informational only.

Plan Access Start and End Dates Read-only period when managers can see their active plans. For example, they can review their people
and contextual information to prepare for upcoming allocations.

Worksheet Update Period Start and End Active period when managers and administrators can make changes to their active plans.
Dates
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HR Data Extraction Date

Eligibility Determination Date

Currency Conversion Date

Performance Rating Date

Default Promotion Effective Date

Default Due Date

Market Composites Effective Date
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Compensation

Description

When the Start Workforce Compensation Cycle process initially extracts person and assignment data
from HR employment records, and places it in the compensation tables. Also the date that the Refresh
Workforce Compensation Data process uses to update the data already in the compensation tables.

When the Start Workforce Compensation Cycle and Refresh Workforce Compensation Data
processes evaluate the specified employment records to determine people's eligibility status.

When the Start Workforce Compensation Cycle and Refresh Workforce Compensation Data
processes obtain conversion rates from the general ledger daily rates table. Plans use the rates to
convert monetary amounts for different currencies.

Date that identifies which workforce compensation plans share changes to compensation performance
rating. Plans with the same date share any rating changes.

To include performance rating information in compensation change statements, you need to select a
date. But, the date doesn't affect the sharing of development and performance ratings between Oracle
Fusion Performance Management Cloud Service and the workforce compensation plan.

When the Transfer Workforce Compensation Data to HR process sets everyone's job, grade,

and position changes to take effect. Date the Start Workforce Compensation Cycle and Refresh
Workforce Compensation Data processes use to get the new salary range, compa-ratio, and salary
metrics for people whose grade changed.

To make proposed promotions available in multiple plans when managers promote people, use

the same date across the plans. Also, you can let managers override this date when you configure
worksheet column properties. Or you can set an override date when you run the Transfer Workforce
Compensation Data to HR process.

When managers need to submit their plan changes.
You can configure different due dates by hierarchy level. Optionally, you can notify managers when a

date changes.

When the Start Workforce Compensation Cycle process extracts market composite information.
It places the information in the compensation tables according to job or position, and location or
segment.
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42 Foundation: Hierarchies in Workforce
Compensation Plans

Workforce Compensation Plan Hierarchies

You can give multiple managers different levels of access to people's allocation during a compensation cycle when you
configure hierarchies for workforce compensation plans.

These hierarchies determine the primary and secondary plan managers and the people they see in their worksheets.
It also determines the plan reviewers and the people they see. The primary hierarchy also determines how budgets roll
down to subordinate managers and approvals route to higher-level managers.

Examples

Here are some scenarios and examples of how you can configure hierarchies.

Scenario Example Hierarchies

Country leaders need to manage the Set the source of the primary hierarchy to Other Manager Hierarchy and then select the appropriate
budget and line managers need to allocate manager type for the country leader.
compensation for their organization.

Set the source of the secondary hierarchy to Primary Manager Hierarchy.

Dotted-line managers need access to Set the source of the primary hierarchy to Primary Manager Hierarchy.
people's compensation, for example,
if they completed projects for these Set the source of the secondary hierarchy to Other Manager Hierarchy and select the appropriate

managers during the compensation cycle.  manager type for the dotted-line managers, such as Project Manager. Or you can use a fast formula
to determine the dotted-line relationship.

Country-specific HR specialists need Set the source of the primary hierarchy to Primary Manager Hierarchy.

access to everyone in their country,

regardless of who people's primary plan Set the source of the reviewers hierarchy to a fast formula that determines the country-specific HR
managers are. specialist.

Related Topics
» How Plan Access, Eligibility, and Default Access Level for Plan Hierarchies Work Together

» Configure Approvals for Workforce Compensation Plan Worksheets
- Considerations for Securing Access to Workforce Compensation Plans and Task Worksheets
 Primary, Secondary, and Other Workforce Compensation Plans
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Options to Configure Workforce Compensation Plan
Hierarchies

To give multiple managers different levels of access to the same people, you can configure up to three hierarchies for a
single workforce compensation plan.

Source

To build the management and optional reviewers hierarchies for each plan worksheet, you select a source. You need to
select a source for the primary hierarchy, even if you don't configure secondary or reviewers hierarchies.

Source Option How It Determines the Management Hierarchy

Primary Manager Hierarchy Uses the primary manager associated with each person's assignment

To use the new HCM position management structure instead of primary managers, sync the position
managers with people's assignments. Then select this source. As position managers change, you need
to sync the managers and assignments again. Then run the Refresh Workforce Compensation Data
process.

Other Manager Hierarchy Uses the specified manager type associated with each person's assignment, such as project, resource,
or regional manager

To use this hierarchy instead of primary managers, make sure that the manager type you select is on
people's assignments. If the managers with that manager type change during an open cycle, you need
to update the assignments. Then run the Refresh Workforce Compensation Data process.

Formula Uses the specified hierarchy determination fast formula
Position Tree Uses the structure of the specified position tree
For this source to determine the correct hierarchy, you need to sync position managers to people's

assignments. Then use the primary line manager hierarchy.

Department Tree Uses the manager defined for the specified department tree

Missing Managers

You can specify how to handle people who don't have a manager. The available options vary depending on the selected
source.

Missing Relationships

You can record missing relationships in the log files for the Start Workforce Compensation Cycle and Refresh
Workforce Compensation Data processes. When you select this option, the processes include hierarchy breaks in the
log files, for example, when a plan manager doesn't have a manager. Or when an individual doesn't have a primary
manager on their assignment. You want to correct hierarchy breaks so workforce compensation plans roll up properly
and include all eligible individuals.
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Default Access Level

You decide the update and access levels for managers by selecting a default access level or by using a formula. You
might use a formula when you want to set up different access to different sets of managers. For example, you select a
formula that lets only managers at or above Grade M4 make updates. It also specifies that all other managers in the
source hierarchy get no access.

Changing the access level doesn't change the hierarchy.

CAUTION: If you select Refresh default access level when you run the refresh data process and access changes,
the next time the refresh process runs, it resets access to the default.

Related Topics
« Workforce Compensation Plan Hierarchies

» Formula Type Is Compensation Hierarchy Determination

» Overview of Using Formulas

« HCM Trees

« How Line Managers Are Synchronized Using Position Hierarchy

Formula Type Is Compensation Hierarchy Determination

To build your own management or reviewer hierarchy for use in a workforce compensation plan, you can create
formulas using the Compensation Hierarchy Determination formula type. You select the formula when you configure
hierarchies for the workforce compensation plan.

Here's a comprehensive list of the contexts available to this type of formula:

DATE_EARNED
EFFECTIVE_DATE
HR_ASSIGNMENT_ID
END_DATE
- START_DATE
HR_TERM_ID
- JOB_ID
LEGISLATIVE_DATA_GROUP_ID
- COMPENSATION_RECORD_TYPE
- ORGANIZATION_ID
PAYROLL_ASSIGNMENT_ID
PAYROLL_RELATIONSHIP_ID
PAYROLL_TERM_ID
PERSONL_ID
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The database items available for this type of formula are related to Person, Assignment, Salary, Element